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Discontinuations

Discontinuation of Windows® 7 and Windows® 8
Microsoft® has discontinued support for the Windows® 7 operating system in January 2020. For com-
patibility reasons, HiCAD 2020 SP2 and HELiOS 2020 SP2 were the last versions of our CAD or PDM sys-
tem to support Windows© 7. HiCAD 2021 and HELiOS 2021 no longer run under Windows© 7,
Windows© 8 and the corresponding server operating systems (Windows Server 2008 R2, Windows
Server 2012 and older) are also no longer supported. If an attempt is made to install HiCAD 2021 or
HELiOS 2021 on a computer with Windows© 7 or Windows© 8, a message appears.

Discontinuation of "old" HiCAD itemization
As of HiCAD 2019 the “old” itemisation, i.e. the itemisation that was used up to HiCAD 2017, will only be
available for model drawings that were already itemized with these functions. From HiCAD 2021 onwards,
only the “new” itemization will be supported. Please also read the information given in the Conversion of
Old Itemisations topic.

Discontinuation of "old" OpenGL versions
From HiCAD 2021 on, only OpenGL version 4.3 is used in all HiCAD modules. Until now this was only the
case with the module HiCAD Point Cloud. This means that HiCAD 2022 can no longer be run on com-
puters without a separate graphics card. To avoid possible problems with onboard graphics cards, we
recommend using a stand-alone graphics card.

Discontinuation of old figure format (FIG)
The following notes regarding FIG-FGA conversion are unnecessary if HELiOS is used in conjunction
with the HELiOS Vault Server.

Since HiCAD 2017 we support FGA as figure format (before that FIG). From HiCAD/HELiOS 2021 or
HELiOS 2021 as an update for HiCAD 2019/2020 onwards, we require that all figures stored with HELiOS
have been converted to the new FGA format beforehand. To convert existing 2-D FIG files, the tool Con-
verter_FIG_To_FGA.exe is available in the exe directory of the HiCAD installation.

If there are still unconverted FIG files in the HELiOS document database at the time of the database
update, you will be informed of the outstanding conversion of these files before the database update. In
this case, the conversion must be carried out before or at the latest directly after the update using Con-
verter_FIG_To_FGA.exe.

Discontinuation of the "old" Create detail drawing function
With the release of HiCAD 2012, the previously valid workshop drawing functionality in Steel Engineering
had been extended to a function for general drawing derivation. The previous functions for detail drawings
in Steel Engineering were still available in the Detail drawing section of the Drawing menu. As of HiCAD
2022 (Version 2700.0) these functions are no longer supported.
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Discontinuation of HELiOS 32 Bit, HiCAD Viewer 32 Bit and Office Interface 32 Bit
Since HELiOS 2022 (Version 2700.0) there is no 32 Bit version available for HELiOS and the HiCAD
Viewer. The HELiOS interface for a 32 Bit Office was one of the few components that was still 32 Bit on
these versions. Since Microsoft has also offered a 64 Bit installation of Office since Office 2010 and many
add-ins for Office are now also available as 64 Bit versions, with HELiOS 2024 we will support an Office
interface only for a 64 Bit Office. If you are still using the Office interface in conjunction with a 32 Bit Office,
you must uninstall your Office version and reinstall it as a 64 Bit version as soon as you update to HELiOS
2024.

Discontinuation of CADENAS PARTdataManager
As of HiCAD 2022 SP2, the CADENAS PARTdataManager will no longer be supported. Thus, the func-
tions Insert main part, PARTsolutions (CADENAS program) and Import PARTsolutions part will no
longer be available from SP2 onwards.

Discontinuation of 3-D projection grid
As of HiCAD 2023, the 3-D projection grid function is no longer available.

Discontinuation of the Zuken E3 interface
As of HELiOS 2024 (Version 2900.0) we will no longer support the Zuken E3 interface.

Discontinuation of the "old" Report Manager
From HELiOS 2024 onwards, the "old" Report Manager, i.e. the Report Manager up to 2022, will no longer
be delivered with a standalone installation of the HELiOS Desktop. In a HiCAD/HELiOS installation or a
HELiOS update of HiCAD, however, the "old" Report Manager is still included. From HiCAD 2025
onwards, only the "new" Report Manager as of 2023 will be supported.

Discontinuation of Part insertion v26 (PE)
The old Part insertion function in Plant Engineering has now been completely replaced by the new Part
insertion function. Therefore, the function Part insertion v26 in Plant Engineering is no longer available
as of HiCAD 2024 SP1.
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Basics

Service Pack 2 2024 (V 2902)

Start Centre

Redesign
The HiCAD Start Centre has been redesigned, although the functions have remained largely unchanged.
Under New drawing you will now find the four functions for creating a new drawing. Under Open drawing you
will find all the functions for opening and importing drawings and designs. The icons for New drawing and
Open drawing can be executed with a double-click. These functions of New drawing and Open drawing can
also be found in the Drawing > New/Open tab. Under Options for new drawing, you will find the setting
options for a new drawing as usual. Last used documents has been added as a new function. Here you can
see the last 16 open drawings as a preview and open them directly by clicking on them. The size of the pre-
view images cannot be adjusted.
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Improved workflow
The Start Centre has been given its own function in the New/Open function group. For this reason, the Do not
show Start Centre checkbox has been removed from the Start Centre. The Start Centre is now only displayed
automatically when HiCAD is started. After that, it is only displayed if you use the Start Centre function.
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Memory utilisation message
While working in HiCAD, you will receive a message if the memory is fully utilised. In this way, you can determ-
ine for yourself whether you need more memory to work efficiently.

In particular, the message is also displayed if the conversion of point clouds leads to high memory utilisation.

If the message should no longer be displayed during the current HiCAD session or the warning mechanism
should be completely deactivated, activate the corresponding checkbox. To reactivate the warning mech-
anism or to display the message again in the current session, use the Process info function under Help Top-

ics and Information .
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If the window should not always be displayed in the foreground, deactivate the Always display dialogue in the
foreground checkbox.
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Parameter configuration - Changed dialogue texts
With the ParKonfigComp.exe tool, you can choose whether you want to use the ISD standard configurations
or your own configurations when working with HiCAD. In particular, you can specify here in which or for which
region - North America or Europe - you are working. The choice of region affects the units of measurement for
the drawing, scales and drawing frames.

The texts in the dialogue window have been changed to make it easier to understand the meaning of switch-
ing.
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ICN: Item text without item number
In the ICN settings, you can specify whether you only want to display the item number, the item text or both.
Invalid item texts - like invalid item numbers - are crossed out.

If only the item texts are displayed, the display can also be sorted alphabetically by clicking on the column
header.

Progress display when saving with preview for HELiOS and Viewer

If the Complete option is selected for the Save as under Scope of Preview for HELiOS and Viewer, all
sheets of the drawing can also be displayed in HELiOS. Depending on the drawing, this can make the saving
process more time-consuming.

As of SP2, the HiCAD status bar next to the progress bar will explicitly indicate when the preview calculation is
running.

This also applies to saving in SZX format (viewer) and the Save with preview, All sheets function.

22 / 370 What's new?

Basics

../Grundlagen/icn/Teilestruktur/icnstrukt1.htm
../Konstruktion/Konstruktionspeichern/konspeichern3.htm
../Konstruktion/Konstruktionspeichern/konspeichern_view.htm
../Konstruktion/Konstruktionspeichern/konspeichern_view.htm


Autopilot - Identification of 2-D points
If a 2-D point is captured in a 3-D selection, for example when working with a sketch, and converted into a 3-D
point, the Autopilot displays an additional 2-D symbol at the cursor from SP2 onwards.

Default setting of the context menu
The default settings of the context menu were changed the first time HiCAD was started. The sliders for the
maximum size of the icons and the maximum number of icons per row have been set to the maximum. The
slider for the minimum size of the icons is determined automatically based on the screen resolution and its scal-
ing.
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Customise quick access toolbar - Search field
HiCAD offers a very extensive range of functions. If you are looking for a specific function when customising
the quick access toolbar or creating new ribbon bars, but no longer know exactly on which ribbon the function
can be found, the search field can help from SP2 onwards. If you enter a search term here, HiCAD lists all func-
tions whose name contains the specified search term. The search is carried out in all ribbon bars and in the
transparent toolbar.
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Itemisation

Automatic itemisation by part group with prefix
Since SP1, an item prefix can be defined for each part group in the parameter settings for itemisation, provided
that the generation of item texts is activated on the General tab. A part is then only uniquely identified by item
prefix + item number. In this case, the parts are not only differentiated according to the item number as a num-
ber, but the item prefix is also taken into account during itemisation. This means, for example, that an
assembly and a profile can have the same item numbers but different prefixes.

Until now, automatic itemisation by part group with prefix was not supported by the drawing management. This
is now possible as of SP2.

Consideration of the processing direction
Previously, the processing direction was only taken into account as a criterion for identical part search for
sheet metal plates and sheet steel. As of SP2, this now also applies to all other part types. Please note the fol-
lowing:

n The direction symbols here only ever describe the processing direction for one facet. This means that,
unlike with edge plates, the processing direction is not continued across facet boundaries.

n For plane facets, only the direction, but not the position of the symbol plays a role. For non-plane facets,
the position and direction of the symbol are compared.

n A distinction is always made between one-sided and two-sided direction symbols.

Decimal places in the drawing
The number of decimal places displayed now depends on the settings you make with the Decimal places

function or on the value set for decimal places (::NKS="") in the HDX files of the attribute masks.

The default setting for new drawings is made in the Configuration Editor (ISDconfigeditor.exe) under ... > Sys-
tem settings > Miscellaneous with the parameter Decimal places, Coordinates or Decimal places, Angles.
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Part variables in the ICN
If the part type or the part type and the item number are displayed in the 3D-Part structure docking window of
the ICN, a corresponding display is also shown in the docking window of the Variables from HiCAD SP2.

Activate SpaceMouse®
When editing 3-D models, you can also use a SpaceMouse®. As of SP2, this no longer needs to be activated
in HiCAD under Settings .
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Service Pack 1 2024 (V 2901)

Licensing
The Mechanical Engineering Package is a new HiCAD basic module. The range of functions corresponds to
that of the Mechanical Engineering Suite Premium, but the number of parts is limited to 750.

Changing the size of the transparent toolbar
The size of the transparent toolbar can now be adjusted directly in HiCAD.

If you click on the symbol with the right mouse button, a corresponding slider is displayed.

Part attribute masks modernised (SP1)
The attribute masks for parts and assemblies have been modernised. In addition, their size now adapts to the
screen resolution.

The HDX files on which the masks are based have not changed as a result.
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Automatic itemisation - numbering according to part groups with prefix

As of SP1, an item prefix can be defined for each part group in the parameter settings for Itemisation ,
provided that the generation of item texts is activated on the General tab. A part is then only uniquely identified
by item prefix + item number. The parts are then not only differentiated according to the item number as a num-
ber, but the item prefix is also taken into account during itemisation. This means, for example, that an
assembly and a profile can have the same item numbers, but the prefixes are different.

To use item prefixes, you must load the ISD template Steel Engineering (item text with prefix) in the favour-
ites, then adapt it if necessary and save it as a new template. Prefixes for assemblies (BG) and beams (P) as
well as for sheet metal, sheets and elongated plates (B) are defined in this template:
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Item number with prefix is permanently entered in the Item text field. This configuration can be changed by

clicking on . As with "normal" item texts, you can change the order of the components or add further com-
ponents.

Please note that numbering by part group with prefix is not supported by the drawing man-
agement,

Please note:

n The item prefix is assigned to the part attribute $PPFX.

n The annotation templates included with HiCAD only contain the item number without the prefix. If you also
want to use the item prefix here, you must adapt the templates accordingly.

n In the bill of materials, the item number with prefix is displayed in the Item text column.
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Example

The drawing shown should be itemised with a prefix.

We use the ISD template Steel Engineering (prefix). On the Part groups tab, we set all start values to 1 (for
illustration purposes) and define the prefix A for the General part group.
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The following figure shows the result of the itemisation.
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Frame/scale list

The Frame/scale list function has been removed from the Drawing> Itemisation/Detailing > Derive...
menu and integrated into the automatic drawing derivation dialogue. The Frame/scale list option can now be
selected in the Drawing sheets dialogue window under Frame. If the option is selected, the corresponding dia-
logue window can be started in the View groups dialogue window with the Frame/scale list button.

In the Frame/scale list dialogue window, you can then define separately for each intended use, e.g. for assem-
blies, I-beams, sheet metal, etc., which drawing frames should be used in combination with which scales.

By integrating the frame/scale lists into the drawing derivation dialogue, these are also taken into
account when updating drawings.
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HiCADGUIReset - List of documents used
The tool HiCADGUIReset, with which the entire HiCAD user interface can be reset to the default state after the
HiCAD installation, has been extended.

New is the checkbox Save or Load without list of last used files. By activating or deactivating this checkbox,
you determine whether the list of recently used documents should also be saved or loaded when saving and
loading the GUI settings. The checkbox is activated by default, i.e. the GUI settings are saved and loaded
without the list of recently used documents.
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Design Checker with improved usability
The Design Checker has become more user-friendly with Service Pack 1:

n When selecting/deselecting tests, the usual Windows multiple selection with SHIFT and CTRL is also sup-
ported.

n
Use the symbols  or to collapse or expand all test groups in one step.

n If you enter a search term in the search field, HiCAD lists all tests whose name contains the specified
search term.

Summarising the functions for 3DFindit
The function was divided into 3DFindit (Basis) and 3DFindit. These have been merged into one function,
3DFindit, and the title bar now shows whether it is the free (basic version) or paid version (full version).
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Drawing derivation - sectional view of the beam cross-section
As is already the case for assemblies and sheet metal, a sectional view can now also be optionally generated
for beams from SP1 onwards. This displays the beam cross-section. It is displayed without dimensions.

Old workshop drawings (before HiCAD 2024 SP1) remain without a view of the profile cross-section
when updating.

SpaceMouse®
In the Configuration Editor under System settings > Miscellaneous there is the new setting End SpaceMouse
mode by moving the mouse. If this setting is activated, SpaceMouse mode must be ended by a mouse action.
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Major Release 2024 (V 2900)

Installation Notes
The PDF file with the Installation Notes can now also be opened directly via the toolbar of the online help.

Update derived drawing

The Update derived drawing function was previously used to update/add to existing drawings after
changes to the model or to close gaps in drawings by updating them, for example when deleting unnecessary
views.

As of HiCAD 2024, it is also possible with this function to update existing drawings using the current parameter
settings in the Configuration Editor. For this purpose, the Recreate with settings from configuration has been
added to the dialogue window of the function.

If the checkbox is active, then the drawings are recreated with the current parameter settings for the different
usage types. This simplifies, for example, the configuration of derived drawings.

When the checkbox is active, all setting options of the dialogue window are inactive except for the sheet selec-
tion.

1.
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Drawing derivation in external drawings
n For drawing derivation in external drawings it is now possible to set in the Configuration Editor whether these

drawings can be processed or not. For this purpose, the checkbox Allow processings in external drawings is
available under Automatic drawing derivation > Production drawing.

With the ISD default setting, this checkbox is inactive.

Access to 3Dfindit
3Dfindit by CADENAS is the visual search engine for 3-D CAD, CAE and BIM models. It enables access to
CAD catalogues of well-known component manufacturers for design and engineering.

For direct access to the search engine, two new functions are available in HiCAD at Drawing > Insert Part >
Exp.:
n 3Dfindit (Basis)

The free version offers you access to the available 3D catalogues that have a download contract with
CADENAS (as of 06/2023, there are approx. 900 manufacturers).

n 3Dfindit
The paid version gives you access to the DIN/ISO/EN standards and to the available 3-D catalogues that
have a download contract with CADENAS (as of 06/2023 there are approx. 900 manufacturers).

The previous functions
n parts4cad (Basis),
n parts4cad and
n bimcatalogs

are covered by the new functions and are therefore no longer available from HiCAD 2024.
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Sheet metal parts and multi-part profiles in the ICN
The behaviour when selecting a bend zone/flange of a sheet metal plate or a profile belonging to a profile
group in the drawing has changed. Previously, when selecting a corresponding part in the design, the structure
of the sheet metal part or profile was always automatically expanded in the ICN. As of HiCAD 2024, this beha-
vior can be defined in the ICN settings.

With the ISD default setting, the checkbox is inactive, i.e. the structure of the sheet metal part or profile is not

expanded automatically, but only up to the corresponding main part. This is indicated in the ICN by the
symbol.
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Example:

The following drawing consists of a main assembly with 2 sheets and another assembly.

If the checkbox is inactive in the ICN settings, the structure is not expanded when the tab of one sheet is selec-
ted.
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If you select a part of the assembly Fl 70x10, then the structure - as before - is always expanded - independent
of the ICN settings.

This setting applies only to sheet metal parts and to profiles of a profile group.

Display of the number of parts of a multiple selection in the ICN
If several parts are selected for processing (multiple selection), then the number of selected parts will now be
displayed below the window with the part structure.
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Sorting parts in the ICN
By clicking on a column heading, the sorting of the tabular display of the part structure can be changed in the
ICN, e.g. descending by item number or ascending by comment. Up to now, when HiCAD was closed, the
selected sorting was reset to default settings. As of HiCAD 2024, the sorting that was last active when HiCAD
was exited will be automatically set when HiCAD is restarted.

Design Checker - BOM-relevant parts without article master
In the Design Checker, a new test is available under General that searches for all parts/assemblies that are
BOM-relevant but do not have a HELiOS article master. In contrast to the previous test under Steel Engin-
eering, standard parts are also taken into account here.

Article master display via double click
Until now, double-clicking the left mouse button on a part in the drawing or in the ICN called up the Part attrib-
utes dialogue window. As of HiCAD 2024, the Article master can now be displayed as an alternative when
using HELiOS. This can be set in Configuration Management under System settings > HELiOS.

If the checkbox is active and the clicked part does not have an article master, the Part attributes dialogue win-
dow is automatically displayed.
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View groups when updating workshop drawings
When updating workshop drawings, it is now possible to choose whether only the view groups as a whole and
not the contained views should be rearranged. Therefore, when updating, a distinction is now made between
the checkboxes

n Rearrange Views and

n Rearrange view groups.

Rearrange
Views

This checkbox only controls the arrangement of the views in the view groups.
If you do not want to rearrange the views of the updated sheets, for example to
keep your own view rearrangements, then deselect the Rearrange Views check-
box.

Rearrange
view groups

If you do not want the view groups of the updated sheets to be rearranged,
uncheck the Rearrange view groups checkbox.
Note that if the checkbox is active, only the view groups as a whole will be
rearranged. The views contained in the groups will only be rearranged if the
Rearrange Views checkbox is also active.
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This change affects the Update derived drawing function and the functions under Drawing > Change
settings.

Support tool
The support tool is now also available in Italian and Polish.
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Update automatically calculated attributes when loading

In the Configuration Editor, you can specify under Modelling > Part properties when certain attributes and
dimensions are to be calculated. This applies, for example, to the weight, volume, surface area and much
more. For example, this can be done always, i.e. after each change of a part, manually or when itemising.

For the calculations that are set to always, as of HiCAD 2024 it is now also possible to specify whether these
calculations should be performed automatically when loading a drawing or not. The setting is also made under
Modelling > Part properties with the parameter Update automatically calculated attributes when loading.

If the parameter is set to Yes, then the calculations are always executed directly for all parts when loading a
drawing. In large drawings, this can lead to considerable waiting times.

If the parameter is set to No, then the calculations are done only when processing assemblies/parts, when
itemising or when updating manually with the new function

Update part attributes .

In this way, you determine yourself at which point in time the calculations should take place and avoid waiting
times.

The ISD default setting is No.
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Dimensioning rules
Position of sub-parts in sectional view

Up to now, only the position of the beam in relation to the sub-part was dimensioned during drawing derivation
with automatic dimensioning (dimensioning rules). As of HiCAD 2024, the position of all sub-parts is dimen-
sioned. The dimensioning rules
n 8: ATTACHING_PARTS,
n 10: ATTACHING_SHEETS and
n 57: ATTACHING_SHEETS_SEPARATELY

have been updated accordingly.

In the example, the Dimensioning rules shown have been used for the sectional view and the Dimensioning
Settings on the General tab.
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Usage for railing segments

In the automatic drawing derivation, the usage RAILINGSEGMENT has been used up to now for the dimen-
sioning of railing segments created by the railing configurator. However, there is often the wish to dimension
the railing segments differently for different railing types, for example, for segments with glass infill or seg-
ments with knee rail infill, etc.

From HiCAD 2024 this is now possible. For this purpose, corresponding usages must be defined and asso-
ciated configurations created whose name contains the expression RAILINGSEGMENT. For more inform-
ation, see HiCAD Steel Engineering - What's New?
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3-D

Service Pack 2 2024 (V 2902)

Cams and cam processing

The previous functions Cams and Cam processing have been into one function Cams .

Please note:
Cams and cam processings can be created in one dialogue. However, subsequent processing is only
possible separately via the respective feature.
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The function has also been extended:
n The settings can be saved as Favourites for later reuse
n The order of the cam shapes has been changed.
n The Round cam shape has been replaced by the Puzzle piece cam shape.

n If Drilled is selected as the corner processing when creating the cam, a move mode can be selected for the
cam. This is independent of the selected cam shape. The following options are available:

l No move (1)
The bore is created without moving. The centre of the bore lies at the intersection of the corresponding
edges.

l Symmetrical (2)
The bore is moved so that it lies symmetrically between the selected edge and the left/right side of the
cam.

l Tangential longitudinal direction (3)
The bore is moved in the longitudinal direction, i.e. in the direction of the selected edge, so that it is tan-
gential to the left/right side of the cam.

l Tangential transverse direction (4)
The bore is moved in the transverse direction, i.e. in the direction of the cam sides, so that it is tan-
gential to the selected edge.
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n The move mode can also be selected for the Drilled corner processing when processing cams. The pre-
vious settings Move in longitudinal direction and Move in transverse direction.

The move modes can be used, for example, to ensure that bores are not visible after assembly.
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Update automatically calculated attributes before saving
For the calculation of attributes that are set to Manual / When itemising in Configuration Editor, you can spe-
cify whether or not these calculations should be performed automatically before referenced parts and assem-
blies are saved. The setting is made under Modelling > Part properties with the parameter Update
automatically calculated attributes before saving. The Weight (§01), the Surface (§10 and §SC) and the
Volume (§20) are updated. The attributes Total quantity (%06) and Qty. in assembly (%13) are not updated.
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Weld seammarking
With the new buttons in the Weld seams function under Extended, the weld seam can be displayed in accord-
ance with the standard. In accordance with the DIN EN ISO 2553 standard, there are two display options: Sys-
tem A and System B. Previously, HiCAD only supported system A. As of SP2, weld seam marking according to
system B is now also possible. In addition, a function for mirroring the weld seam using the annotation tag has
been added.
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Move and delete inflexion points
The Move inflexion point function can be used to move any inflexion point from form and positional
tolerances, chamfer dimensions, weld seam symbols, edge markings and annotation tags. If there are multiple
inflexion points, any inflexion point except the last one can be deleted.
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Magnetic snap-in of form and positional tolerances
New form and positional tolerances can be aligned horizontally or vertically to the existing form and positional
tolerances in the same view.

If a form and positional tolerance moves at the same height as an existing one during dragging, this is indic-
ated by showing a horizontal auxiliary line in the graphic. When the form and positional tolerance is dropped, it
is aligned with this line. This also applies to vertical alignment. After the form and positional tolerance has been
itemised, the displayed auxiliary line disappears. The reference point of the tag is used for alignment. If there
are no other tags between two form and positional tolerances, parallelism is offered. Magnetic snap-in can be
switched off by pressing the ALT key.

Magnetic snap-in of annotation tags
If there are several annotations, the annotation tag to be moved can now be aligned horizontally or vertically
with other annotations.

If an annotation tag moves at the same height as an existing tag during dragging, this is indicated in the
graphic by showing a horizontal line. If you place the annotation down, it is aligned with this line. The same
applies to vertical alignment.

Please note:
This functionality is only used to simplify the alignment of the annotation. The alignment is not asso-
ciative. This means that the annotation tag is not updated if the tag to which it is aligned changes.
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View caption - information on the original view
As of SP2, the name, sheet name and sheet number of the original view can also be used in view captions for
derived views, e.g. sectional or detail views.
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Context menu extension
Two functions have been added to the context menu for general 3-D parts (3-D) under Standard Processings.
The functions are Lettering and Cams.

Exact representation of the view selection
If a view with quick representation is active or the current view selection contains a view with quick rep-
resentation, the Exact representation function is available in the transparent toolbar.

Previously, this function could only be used to restore the exact representation of the active view. As of SP2,
this applies to all views of the active view selection.

Annotation - Base point symbol
Different base point symbols can be selected for 3-D annotations. From SP2, the Circle and Circle (filled) sym-
bols are always displayed in the screen plane. The symbols therefore remain circular. Up to now, the symbols
were spatially consumed, turning them into an ellipse.
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Referencing

Updating identical parts
With SP2, the parameters

n Automatically update referenced parts after each change and

n Update identical parts of referenced parts before saving

are available again in the Configuration Editor under System settings > Referencing.

If there are several identical parts of a processed, referenced part in the drawing, the changes are also auto-
matically made to the identical parts if the ISD is set by default. This automatism can be changed with the para-
meters mentioned above.
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Referencing functions in the ribbon Drawing
The functions

Update all parts, from file and 

Break up referencing, Active assembly + sub-parts

can now be accessed directly from the Drawing ribbon via the menu of the Update function. Previously,
these functions were only available in the context menu of referenced parts.

Another new feature is that a message is displayed when the functions

Update referenced identical parts and

Save referenced part

are called if the active part is not referenced.
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Show/hide elements in view extended

The dialogue of the Show/hide elements in view function has been improved and extended:

n support for multiple selection,

n saving the settings as favourites,

n transfer of settings from a reference view and

n simplified operation.
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The selected views are listed in the upper part of the dialogue window. After calling up the function, this is ini-
tially the active view or the current view list.

To select further views, simply click on the corresponding view frame in the drawing. If the frame of an already
selected view is clicked again, the view is removed from the list. Alternatively, views can also be removed from
the list by right-clicking on the corresponding entry in the list and then selecting the Remove element(s) from
list function.

For the various elements, you can then select whether they are to be

shown,

hidden or

covered in HiddenLine mode.

The selected setting is always indicated by an orange frame.

Favourites
The current settings can be saved as favourites and used again at any time. They are saved
in the ProgramData\ISD Software und Systeme\HiCAD 2024\Fa-
vourites\VisGUI\ShowAndHideElements folder.

Select view from which properties are to be transferred

This function can be used to adopt the settings of another view. To do this, select the cor-
responding view in the drawing.

The function is also available in the context menu of views and view lists.
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Lettering: Insertion point
In the Lettering function, you can select the insertion point from nine different positions. By activating the
desired radio button, you can insert the lettering at this position.

Insertion of standard parts from a copied table
KRA files created when copying tables are not saved in the HiCAD drawing. This means that if you pass the
table copy on to a third party, you must also take the corresponding KRA file into account. If a drawing con-
taining standard parts of this table is loaded in HiCAD and the KRA file does not exist, these standard parts
cannot be edited with the functions for standard parts. For example, it is not possible to change the display. In
this case, an additional message is displayed from SP2 onwards.
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Service Pack 1 2024 (V 2901)

Cams and cam processings

The dialogue window of the Cams function has been expanded to include images of the cam shape for
better comprehensibility.

The Cam processing function now allows you to specify a move in the longitudinal and transverse dir-
ection. This is possible if the cam shape is straight and Drilled is selected as the corner processing.

The bores on the part to be processed can then be moved by a value in the longitudinal and transverse dir-
ection. The longitudinal direction is the cam direction, the transverse direction is the left/right side of the cam.

The illustration shows a cam connection. (1) is the part with cams and (2) is the part with the cam processings.

The following figure shows a section of the side view of part (2) - with and without indication of a move.
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Lettering

You can use the Lettering function to letter almost any surface. You can now use the lettering function to
sign almost any surface. Subtracted from this are cones, spheres and toruses. If the surface has a tangential
transition, the lettering continues over the fillet to the next edge. Cylinders are excluded from this. On edge
sheets, the lettering continues over the flanges. It is now also possible to create a lettering in the bending sim-
ulation.

What's new? 63 / 370

News Overview

../3DNormteile/Normbearbeitungen/signierung.htm


Replace standard parts

With the new Replace standard parts , you can replace several selected standard parts of one type
(e.g. nuts) by selecting a different variant and/or size in the catalogue. If you have created standard parts in a
grid and a standard part from the standard part group is in the multiple selection, the entire standard part group
is changed.

The function can only be applied to standard parts and standard part groups that correspond to the same type
(e.g. only screws or only nuts). However, the selection may contain different variants (e.g. hexagon nut and
cap nut). If the multiple selection contains standard parts of a standard parts group, the entire standard parts
group is changed.

The following options are rejected with an error message:
n Multiple selection with standard parts/standard parts groups that do not correspond to the same type,

n Multiple selection with parts that are neither standard part nor standard parts group,

n Standard parts/standard parts groups from design variants and configurators (e.g. in steel engineering),

n Standard parts/standard parts groups that belong to a bolting,

n standard parts/standard parts groups with feature log and

n blocked standard parts/standard parts groups.

Please note:

n Processing operations such as bores are not adapted. The Replace standard parts function only allows
you to change the standard. Other properties such as the representation of the thread cannot be changed.

n For standard parts with a free value (e.g. the effective length for rivets), this value can be entered. It is then
used for all replaced standard parts.
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Referencing

Updating identical parts
When externally or internally referenced parts are changed, all identical parts in the current drawing are auto-
matically updated from SP1. The parameters

n Automatically update referenced parts after each change and

n Update identical parts of referenced parts before saving

have therefore been removed from the Configuration Editor under System settings > Referencing.

Referenced assemblies with referenced parts
Referenced parts with changed geometry are always offered for saving when the drawing is saved. This may
mean that the KRA file of the part is updated, but that of the assembly is not. When reloading the drawing or
inserting the KRA file of the higher-level assembly, HiCAD then detects that the part it contains has a newer
KRA version, which is then reloaded.

In practice, there is sometimes a desire for the KRA of the higher-level assembly to always contain the current
status of its subordinate parts, e.g. so that the HELiOS document structure always matches the KRA file. As of
SP1, it is therefore possible to define how externally referenced assemblies are to be handled when saving
drawings and when changing drawings if they contain externally referenced parts.
Various options are now available in the Save referenced parts dialogue window under Parts to be saved.
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Only structurally changed assemblies

Referenced parts with changed geometry are offered for saving. However, the referenced assemblies to which
the parts belong are only taken into account if they have been structurally changed. This is the previous pro-
cedure before HiCAD 2024 SP1.

Also assemblies with new indices included

If this option is selected, the assemblies whose directly referenced parts have a new document master index
are also offered for saving in addition to the structurally changed assemblies. This option only has an effect if
the parts and assemblies are managed in HELiOS.

All assemblies with changed sub-parts

If this option is selected, the assemblies that contain changed referenced parts in their entire structure are also
saved, regardless of the level. If this option is preset in the Configuration Editor, the corresponding assemblies
are marked with the symbol in the ICN.

Which setting is active here when saving is determined by the setting in the Configuration Editor under
System settings > Referencing > Saving changed assemblies. The ISD default setting isOnly
structurally changed assemblies. Even if you select a different setting when saving a drawing during
the current HiCAD session, the setting from the Configuration Editor will take effect again the next time it
is called up.

Example

In the Configuration Editor, the parameter Saving changed assemblies has been preset to All assemblies
with changed sub-parts under System settings > Referencing.
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The following figure shows a drawing managed in HELiOS with three assemblies BG1, BG2 and BG3.
Assembly BG2 is subordinate to assembly BG1 and contains assembly BG3. All assemblies contain different
solid primitives. In the first step, both the parts and the assemblies have been referenced externally with the
part and document master.

The chamfer length of the right prism has then been changed in assembly BG3 and an index has been created
in the document master of the left prism.

Parts whose geometry has changed - in the example, the right-hand prism - are marked with the symbol
in the ICN. Due to the default setting in configuration management, all assemblies with changed sub-parts are

additionally marked with the symbol. If the drawing is now saved, all marked assemblies and the prism
with the changed geometry are listed in the Save referenced parts dialogue window.
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If you change the selection under Parts to be saved,the list of parts changes.
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Dimensioning and annotations

Adopt tolerance

The Adopt tolerance can be used to transfer dimensional tolerances from one dimension to another.
To do this, you can click on the reference dimension, i.e. the dimension whose tolerance you want to adopt, to
select the tolerance you want to copy. Then click on all the dimensions into which you want to insert the tol-
erance. To end the function, press the middle mouse button once.

Please note:

Brackets or symbols that were assigned to the reference dimension using other functions such as Edit dimen-
sion figure or Set symbol are not taken into account during the transfer.

3-D annotation with HELiOS data
As of HiCAD 2024 SP1, HELiOS data is saved in annotations with the drawing. This data is then used when
working without HELiOS. This also applies if a different sheet is printed via the plot manager (from HiCAD
2024 SP1) than the sheet active when saving the drawing. Previously, the HELiOS data was missing in the
annotation tags in this case.

Please note that this change does not affect existing drawings. These must first be saved again.

Form and positional tolerances (3-D) - Preview window
The background of the active sheet/model area is automatically displayed in the preview window of the form
and positional tolerances (3-D). This only changes when the background of the sheet/model area is changed.

Edge state - preview window
The preview window for the edge state (3-D) automatically displays the background of the active sheet/model
area and only changes when the background of the active sheet/model area is changed. The font and line col-
our is also displayed in the preview window.
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Clean up intersections - Bore out inner corners

The Clean up intersections function has been extended.
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In certain situations, clean-up can result in concave corners. These can now be bored out if required by activ-
ating the Bore out inner corners checkbox and specifying a bore diameter. For example, this can be useful for
parts with cams that were not created with the Cam function. Another use case is "jumbled" parts, such as the
profiles in the following illustration.
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Views

Create sectional view - Extensions

The dialogue window of the Sectional view function has been expanded in the Ident area on the Para-
meters tab with the Annotation selection box to include images for better comprehensibility.

Change section path

New in the menu under Views > Edit > Section is the function Change section path .

The function can be used to edit the sketch for the section path directly. After calling up the function, the fol-
lowing window is displayed:

Then edit the sketch using the functions of the Sketch ribbon and finally click Apply sketch. The sectional view
is then adjusted directly.
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The section path can also be extended later by simply dragging it without having to call up the Change section
path function.

Change section limit

The new Change section limit allows you to directly change the sketch for the sectional view limit.
After calling up the function, you can adjust the sketch as desired. Click on Apply sketch to apply the change.

You can find the function in the Views ribbon under Edit > Section and in the context menu for views.

Fixed view point when changing scale
Previously, if the view scale was changed, a fixed point had to be set again. From SP1, the fixed point is
retained.
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Align views horizontally/vertically, via points
The following functions are new in the context menu of views:

Align views horizontally, via points

Align views vertically, via points

These functions can be used to align individual views horizontally or vertically to a specific point.

1. After calling up the function, first select a point for the alignment. Depending on the function selected, a
horizontal or vertical alignment guideline is then shown through this point.

2. Then select a point in a view. This view is then moved orthogonally to the alignment guideline so that the
point selected in the view lies on the alignment guideline.
Please note that the selected point must belong to a view, otherwise a corresponding error message will
be displayed.

The function does not end automatically after it has been executed, i.e. you can align further views to the dis-
played line by selecting further viewpoints. You end the function with the middle mouse button or with ESC.

Align and distribute views flush/centred
As of SP1, HiCAD 2024 also offers the option of aligning several views flush (right, left, top, bottom) or centred
(horizontal, vertical). In addition, views can be evenly distributed horizontally or vertically. The corresponding
functions are available in the context menu for views if a view list (multiple selection) is active.
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Align Distribute
Align views left Distribute views horizontally

Centre views horizontally Distribute views vertically

Align views right

Align views at top

Centre views vertically

Align views at bottom
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Align

With the flush alignment functions, only the displayed geometry is aligned; dimensioning, annotations etc. are
not taken into account. This means that the smallest enveloping rectangle is used, which only completely
encloses the geometry. The alignment line is determined by the "extremum" of the views. For example, in the
right-aligned alignment, the view whose geometry extends furthest to the right remains in place. With the top
alignment, the view with the highest geometry point remains in place.

The illustration shows three views, with view 3 projecting furthest to the left. On the right of the image you can
see the result with left-aligned alignment. The position of view 3 is retained.
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If you want to centre vertically, the alignment line is halfway between the top and bottom geometry points of
the selected views. The views are then moved so that their centre lines lie on the alignment line. For horizontal
centring, the alignment line is determined accordingly by the points furthest to the left and right of the selected
views.

The illustration shows three views, with view 3 projecting furthest to the left and view 2 furthest to the right. A is
then the alignment guideline. On the right of the image you can see the result with horizontally centred align-
ment.
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Distribute

In contrast to alignment, dimensioning, annotations etc. are also taken into account when distributing in addi-
tion to the geometry. This means that the smallest enveloping rectangle that completely encloses all objects in
a view is processed here.

Horizontal distribution moves the views to the right or left so that they are distributed laterally with the same lat-
eral distance to the next view. The two views that protrude furthest to the left and right determine the overall
width for the distribution and are not moved themselves.

The illustration shows four views that are to be distributed horizontally. Views (1) and (4) remain in place as
they project furthest to the left and right respectively. Views (2) and (3) are moved horizontally so that the dis-
tance a between all views is the same.
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Time threshold for AutoQuickView (s)
A threshold value in seconds can now be specified for the AutoQuickView in the Configuration Editor.

If a threshold value > 0 is specified, the HiddenLine or glass model calculation is aborted if it takes longer than
this threshold value. The view is then switched to QuickView. Subsequent calculations of the view no longer
start a HiddenLine or glass model calculation, as the view is already in QuickView. The threshold value applies
at the respective workstation for all drawings in which the AutoQuickView is switched on.

For example, in workshop drawings, a value of 0.1 to 0.5 seconds could mean that the views of the individual
items remain in exact representation and only "large" views of the entire drawing are switched to QuickView.

The ISD default setting is 0, i.e. the QuickView takes effect for every HiddenLine and glass model calculation.
This corresponds to the previous behaviour before HiCAD 2024 SP1.

Part and dimension orientation
The Part and dimension orientation can only be defined in drawings that are itemised source models. If this is
not the case, a corresponding message is now displayed, e.g.
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Transform and clone - Move+rotate via planes
The previous function

Move+Rotate part, via fitting points has been replaced in SP1

by the function

Move+Rotate part, via 2 planes.

Use the new function to move+rotate the active object, i.e. it is moved and rotated at the same time. The object
can now be either a single part or a part list.

After calling the function, first select a plane on the object and then a plane in the drawing. The parts are trans-
formed so that the coordinate systems of the two planes are aligned.

As soon as the plane in the drawing has been completely defined with the next click, a preview of the trans-
formed part or part list is displayed.

To determine the planes, you can also use the functions of the context menu - just like when drawing sketches.

Similarly, the previous function

Clone+Move part

has been replaced by the function

Clone part, via 2 planes.
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Major Release 2024 (V 2900)

Dimensioning and annotations

3-D annotations - background cut-out
In 3-D annotations, the background cut-out can now be activated either for the entire annotation or for the indi-
vidual text blocks.

The checkbox for text blocks is only visible if the corresponding checkbox under Total is inactive.
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Background cut-out - Left: Annotation, Right: Text blocks 1 and 3

New symbols in the context menus
The symbols in the context menus for annotations and annotation tags have been changed, e.g.
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Form and positional tolerances
The new function for form/positional tolerances introduced with HiCAD 2023 has now been extended once
again.

New inflexion point

When setting form and positional tolerances, it was previously only possible to insert new inflexion points of
the leader line by calling up the context menu (right mouse button) and then selecting the New inflexion point

function. As of HiCAD 2024, this function can now also be called simply by pressing the CTRL key.

Other new features

n The list of available symbols has been extended.

n The wrap-around symbol is now placed at the last inflexion point. If a reference line does not have an inflex-
ion point, the wrap-around symbol is placed between the reference line (1) and the tying line (2).
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n Flags with a reference symbol can also be set at form/positional tolerances. The reference flag can then
only be set at the top and bottom. If the form/positional tolerance is moved, the reference flag is also
moved.

n The additional text of a line in form/positional tolerances changes the side when the side (right/left) of the
form/positional tolerance changes.

n Form/positional tolerances can be set at projection lines. If the dimension is moved, then the tolerance is
also moved.

n If a tolerance is set to the dimension line of a distance or diameter dimension, then flag is no longer rigidly
attached to the dimension line. By dragging the arrow, the reference point can also be set to the other side
of the dimension.

n The context menu for form/positional tolerances has been adjusted to that of annotations.
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Simplified orientation of the dimension figure
Previously, the dimension number could only be defined by the distance to the dimension line. As of HiCAD
2024, it is now also possible to arrange the dimension number in a simplified way by selecting the desired
option
n below or above the dimension line or
n centred on the dimension line.

For this purpose, the Dimension figure tab has been extended in the dimension parameter settings for inter-
active dimensions as well as for HCM and parameter dimensions.

3-D part annotation - Insert base point

With the Insert base point function, which you can find in the context menu of a 3-D part annotation, you
can now directly add several base points to the selected annotation. You end the base point input with the
middle mouse button.
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Coating of general parts
Up to now, the coating of general parts (without structure) was not displayed in sectional and detail views. In
addition, coating was not possible if these parts were part of a sectional or detail view.

As of HiCAD 2024, the coating of general parts (without structure) is also displayed in sectional and detail
views.

What's new? 87 / 370

News Overview

../../../hicadbl/Content/bearbeitenbl/beschichtungbl.htm


Feature in part creation
In the part creation function dialogues, the Feature checkbox is no longer available as of HiCAD 2024. This
means that a corresponding feature is now always generated during part generation.

This affects the following functions:

3-D Standard > New > Extruded solids

3-D Standard > New > Primitive

3-D Standard > New > From Skt

3-D Standard > Process > Wall > Envelope

3-D Standard > Clone > Param.

3-D Standard > New > Revolved

3-D Standard > New > C-edge sweep

Simplify > Envelope
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Sketches

Simplified rotation of 3-D sketch elements
To simplify the determination of the rotation axis when rotating elements of a 3-D sketch, after selecting the
sketch elements to be processed and determining the first point for defining the rotation axis, the active
coordinate system is displayed, e.g.

(1) Selected sketch element, (2) 1st point for rotation axis, (3) Display of the coordinate system.

This affects the following functions:

Sketch > Transform > Move > Move+Rotate

Sketch > Transform > Rotate

Sketch > Clone > Move > Move+Rotate

Sketch > Clone > Rotate
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Marking of sketches with deactivated HCM
If a sketch is active for which the automatic assignment of HCM constraints has been deactivated, this is now
indicated in the HCM window of the ICN with a corresponding message.

With a click on the HCM can be activated again, i.e. HCM constraints are automatically assigned to sub-
sequently created elements of the sketch - if possible.

Weld seam and weld symbols

Extended weld symbols
Additional weld symbols are available for symbolic representation on both the reference and opposite sides:

Weld pool fuse (not specified)

Fusible inlay
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Reference line boundary arrow for 3-D weld seam symbols
When processing a 3-D weld seam symbol, the current settings from the Configuration Editor under Drawing >
Annotations > Weld symbols were previously always used for the boundary of the reference line.

This could result in the display of the boundary changing, for example, when moving or copying. As of HiCAD
2024, the settings for the boundary of the reference line are saved directly to the weld seam symbol. This
means that the limitation of existing weld seam symbols is not changed when the corresponding parameters
are changed in Configuration Editor.
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Show/hide weld seams by view
The functions

Hide part list in view selection

Show part list in view selection, hide all other parts and

Show part list in view selection

are now also available in the context menu for weld seams. This allows single or multiple seams to be
shown/hidden in certain views.

New symbols in the context menus
The symbols in the context menus of welds have been changed.
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Views

Magnetic snap-in when moving
Magnetic snap-in of views is now supported when moving views. This procedure allows easy alignment with
other views or with the optional additional elements of the drawing sheet (drawing frame, title block and
BOMs).

1. The view edges can be aligned to be flush with each other or with the additional elements of the drawing
sheet. If, for example, during dragging a view moves to the same height as an existing view or one of the
additional elements, this is indicated in the graphic, e.g. by fading in the horizontal line. If you put the view
down, it is aligned with this line. The same applies to vertical alignment.

2. Equal spacing does not refer to the geometry but to the view rectangle, i.e. the "envelope rectangle" that
completely encloses the view including the annotations etc.

a-c: alignment lines left, centre, right, d: distance line

As soon as a corresponding constellation is created when dynamically moving a view/view list, graphical help
elements such as distance arrows or orientation lines are displayed. Equal distances are numbered. By means
of these lines the view can be aligned and the desired position can be taken over by lowering the cursor. While
moving, the selected view is only displayed as an envelope rectangle.

Magnetic snap-in is automatically active when moving with the Move view function and when moving using
drag&drop.
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Magnetic snap-in can be switched off in the Configuration Editor. To do this, under System settings > Visu-
alisation > Views > Magnetic snap-in, deactivate the Allow alignment based on equal distance checkbox.
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New dialogue for sectional views
The dialogue for creating and processing sectional views has been completely revised.

In addition, the course of a sectional view can now also be changed subsequently without having to call up the
sectional view dialogue again. The

Process sketch

function is available for this purpose. You will find the function in the context menu of the annotation (right
mouse button) in the original view.
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Multiple selection of views
Until now, it was only possible to select multiple views in the ICN. This can be useful, for example, if you want
to change the display of several views in one step. As of HiCAD 2024, this is now also possible in the graphics
area of the drawing. To do this, hold down the CTRL key and select the desired views. All selected views are
marked by a dashed view frame. If a view that has already been selected is selected again, then it is removed
from the view list.

Rotating views
When rotating views with the mouse, the rotation point is displayed as of HiCAD 2024. If the rotation point is
determined automatically with the middle mouse button, it is also displayed.

3-D rotation point

Deleting dimensions in shortened views
If dimension base points are present in the shortening area when shortening views, then from HiCAD 2024 you
can select whether the corresponding dimensions should only be hidden or deleted.

If such dimension base points are present, HiCAD will first display a corresponding message.
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This message can be switched off for the current HiCAD session by activating the Suppress message check-
box. Click OK to continue the function.

Clicking Yes deletes the dimensions with base points in the shortening area. If you click No, the dimensions
are only hidden. If the shortening is deleted, then these dimensions are visible again.

If the Suppress message checkbox is active, the selection of Yes or No applies to the current HiCAD session.
The query will then only be displayed again after a restart.

Left: Initial view with shortening axis (1) and division points (2), (3), Right: Result
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Temporarily deactivate view shortening
View shortening can now be temporarily deactivated. This can be useful, for example, to view or edit dimen-
sions that are in the shortening area. You can find the functions under Views > Edit > Shorten as well as in the
context menu for views.

Temporarily deactivate view shortening
The shortening of the active view is temporarily deactivated, i.e. the view is displayed
unshortened until the deactivation is removed. The deactivation is saved with the drawing,
i.e. if the view shortening is deactivated when saving, it will also be deactivated when the
drawing is reopened.

Cancel temporarily activation of view shortening

This function cancels the temporary deactivation of the active view. The view is displayed
shortened again.

Consideration of intrusions in Hidden Line representations
Up to now, only intrusions/collisions found between straight lines and planes or those involving circles and cyl-
inders were taken into account in Hidden Line calculations.

As of HiCAD 2024, all collisions with analytical curves/surfaces or with NURBS curves/surfaces are now also
taken into account.

What exactly is taken into account can be defined in Configuration Management under System settings >
Visualisation > Views > Hidden Line > Collision check.

Fast

Only collisions between straight edges and plane facets are considered.

Thorough

With this setting, all collisions between any edges and facets on non-freeform surfaces are taken into account.
This is the ISD default setting.
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Cams and cam processings
The controls and dialogues for cams and cam edits have been slightly changed.

n When creating cams, multiple edges can now be selected in the selection list of the Cams dialogue win-
dow so that you can provide them with the same cams. This means you no longer need to make the set-
tings for each individual edge. Alternatively, you can set the parameters for shape and distribution first and
then select the edges.

n In the Cam processing dialogue window, the dialogue texts have been adapted.

n Processings that are not perpendicular also go all the way through.

n Both dialogue windows can be resized.
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Update automatically calculated attributes when loading
In the Configuration Editor you can now define whether the dimensions/attributes for which the automatic cal-
culation is activated there should be updated automatically or not when loading a drawing. Read the inform-
ation on this under Basics - What's New?.

Extensions in lettering
The extensions in lettering allow you to insert attributes, save favourites and control the display in the view.
n Attributes

Attributes can be easily copied from the list box. Select the attribute and click OK. There are some restric-
tions. Attributes of superordinate parts may not be used. The lettering text must not depend on the position
in the part structure. If the part is referenced, only attributes that are transferred via referencing may be
used. This can be set in the Configuration Editor under System settings > Referencing > Area: Updating.
Examples of non-permitted attributes: The attribute Benennung 2 is configurable, i.e. non-permitted attrib-
utes can be used. The attribute Positionsindex is not permitted because parts with the same position num-
ber can have different item indices.

n Multi-line signatures
You can now enter multi-line texts in the text editor of the lettering.

n Save settings as favourites
Letterings can be saved as favourites. The file format is *.FTD. In the HiCAD SYS directory you will find
various FTD files with predefined lettering.

n Showing and hiding letterings
The lettering can be shown or hidden in the view. To do this, right-click on the view frame and select the
function Show/hide elements in view.
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Catalogue Editor

Service Pack 2 2024 (V 2902)

Units and unit categories
Since HiCAD 2023, the Catalogue Editor has supported unit categories (e.g. Length, Surface area, Volume,
Weight) and units (e.g. mm, m, in, ft, kg) as column properties - initially only for fasteners. With SP2, the units
have now been set in almost all catalogues, so that when installing in HiCAD it is clear in which unit the stand-
ard parts are available in the catalogue.

You can also use this option in your own tables. To do this, right-click on the column heading and assign the
unit category and unit to the column.

Profile installation - new system attributes
New attributes for the sheet thicknesses of the sandwich inner and outer shells, the core thickness and the
core material are available in the System attributes table in the System settings catalogue. When installing
profiles from the catalogues at Factory standards > Series > Roof Wall Facade > Room-closing profiles, the
content of the corresponding column is assigned to the respective system attribute.

Attribute name Designation Column

DWF_CORE_MAT Core material CORE_MATERIAL

DWF_T_CORE Core thickness CORE_THICKNESS

DWF_T_IN Thickness of inner shell THICKNESS_INSIDE

DWF_T_OUT Thickness of outer shell THICKNESS_OUTSIDE
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ROMA profiles
As of SP2, panels from the company Romakowski GmbH & Co. KG are now also available for profile install-
ation at Factory standards > Series > Roof Wall Facade > Room-closing profiles > Romakowski.
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US Standard boltings
As of SP2, the HiCAD Bolting dialogue supports US standard bolting according to the ASME B18.2.1 stand-
ard. For this purpose, the following tables in the Fasteners catalogue have been replaced by new tables with
the same name.

Hexagon head bolt n ASTM_A193_HEAVY_HEX
n ASTM_A307_HEAVY_HEX
n ASTM_A325_HEAVY_HEX
n ASTM_A354_HEAVY_HEX
n ASTM_A354_HEX
n ASTM_A449_HEAVY_HEX

Hexagon head nut n ASTM_A194_HEAVY_HEX_
FLAT

n ASTM_A194_HEAVY_HEX_
JAM

n ASTM_A194_HEAVY_HEX
n ASTM_A563_HEAVY_HEX

Washer n ASME_B18_21_1_PW

Example of such a standard bolting:
n Bolt

Hexagon head bolt according to ASME B18.2.1, size 1/2"-13 UNC. This refers to a screw with an outside
diameter of 1/2 inch and 13 threads per inch, which represents a coarse thread (UNC - Unified Coarse
Thread). The length of the screw depends on the specific application.

n Nut
Hexagon nut according to ASME B18.2.2, matching the 1/2"-13 UNC size bolt. This nut is specifically
designed to mate with the above bolt and provide a secure connection.

n Washer
Flat washer according to ASME B18.22.1, suitable for 1/2" diameter bolts. The washer is used to distribute
the load of the nut evenly on the material to be screwed, which reduces the risk of indentation or damage to
the material.

Flow drilling - NCX output and itemisation
Since HiCAD 2024 SP1, flow drillings with inch thread and metric thread from the suppliers
n Centerdrill GmbH,
n Ontool GmbH (THERMDRILL®) and
n GLOWDRILL GmbH

have been available in the catalogue Factory standards > User-defined processings. As of SP2, these are
now taken into account for NCX output and itemisation.
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Semi-finished products/profiles with imperial dimensions
In the Semi-finished products > Beams+Profiles catalogue, the previous tables according to the AISC stand-
ard have been replaced by tables of the same name with imperial dimensions.

This affects the following tables:

Catalogue Table File name

I-Beams AISC HP (imperial) AISC_HP-SHAPES.IPT

AISC M (imperial) AISC_M-SHAPES.IPT

AISC S (imperial) AISC_S-SHAPES.IPT

AISCW (imperial) AISC_W-SHAPES.IPT

L-Beams AISC L-isosceles (imperial) AISC_LE-SHAPES.IPT

AISC L-non.isosceles(imperial) AISC_LU-SHAPES.IPT

T-Beam AISC MT (imperial) AISC_MT-SHAPES.IPT

AISC ST (imperial) AISC_ST-SHAPES.IPT

AISCWT (imperial) AISC_WT-SHAPES.IPT

U-Beams AISC C (imperial) AISC_C-SHAPES.IPT

AISC MC (imperial) AISC_MC-SHAPES.IPT

Hollow profiles AISC HSS RE (imperial) AISC_HSS_RE_INCH.IPT

AISC HSS SQ (imperial) AISC_HSS_SQ_INCH.IPT

Steel pipes AISC HSS RO (imperial) AISC_HSS_RO_INCH.IPT

AISC PIPE (imperial) AISC_PIPES_INCH.IPT

In addition, the Factory standards/User-defined semi-finished products catalogue has been expanded to
include the following tables according to ASTM standard:

Catalogue Table File name

User-defined profiles > Flat steels FL (imperial) ASTM_FLAT_STEEL.IPT

User-defined plates Plates (imperial) ASTM_STEEL_PLATES.IPT
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Project and Folder selection
Projects and Folders can now be activated via the HELiOS menu in the menu bar. The menu has been exten-
ded accordingly.

If a project or folder is active, the menu can be used to deactivate the project/folder, display the project/folder
content and activate another project/folder.

The title bar of the Catalogue Editor shows which projects and which folders are currently active:

Threaded rods - Change of category
The tables with the category GEWINDEBOLZEN (Threaded rods) have been replaced in SP2 by tables of the
same name with the category GEWINDEBOLZEN_BEARB_ (Threaded rods, processed). This affects the fol-
lowing tables:

n Fasteners > Bolts+Screws > Screw bolts > DIN 976-1 A

n Fasteners > Bolts+Screws > Screw bolts > DIN 976-1 B

n Factory standards > User-defined fasteners > User-defined bolts+screws > Fastenal > Rods and
studs > Threaded rods

The change means that these threaded rods can be edited in HiCAD. This means that threaded rods with the
same table entry can have different item numbers. This is the case, for example, if two identical threaded rods
are inserted and then one of the parts is shortened.
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Further ALUCOBOND® colours
As of SP2, the ALUCOBOND® Colour 539 C2 Light Gold is also available in the HiCAD catalogues. This
affects the tables:

n ALUCOBOND Anodized Look
in the catalogue Factory standards\Sheets\ALUCOBOND

n Coating ALUCOBOND Anodized Look
in the catalogue Factory standards\Surface treatment\Profile and Element Installation

New tables are also available:

n in the catalogue Factory standards/Sheets/ALUCOBOND:

l ALUCOBOND legno PREMIUMWOOD
l ALUCOBOND PREMIUM ANODISED
l ALUCOBOND ROCCA
l ALUCOBOND VINTAGE

n in the catalogue Factory standards/Surface treatment/Profile and Element Installation/ALUCOBOND:

l Coating ALUCOBOND legno PREMIUMWOOD
l Coating ALUCOBOND PREMIUM ANODISED
l Coating ALUCOBOND Rocca
l Coating ALUCOBOND Vintage
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CatalogueMaker- Factory standards
Tables from factory standards catalogues were not previously taken into account by the Catalogue Maker. As
of SP2, this is now supported, i.e. your individual standard selection can now also contain standard parts from
the Factory standards catalogue.
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Service Pack 1 2024 (V 2901)

Flow drillings
New in the Factory standards > User-defined processings catalogue are User-defined flow drillings with
inch thread and metric thread from the suppliers
n Centerdrill GmbH,
n Ontool GmbH (THERMDRILL®) and
n GLOWDRILL GmbH.

Flow drill holes can be inserted in HiCAD with the function 3-D Standard > Standard Processings > Bore/Thr

. The bores are displayed in HiCAD like normal drilled holes.
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Tool numbers in sheet metal processing
In sheet metal processing, machines are also used which use different tools for top and bottom processing, for
example punch- laser combination machines. Until now, different representations (TOPSYMBOL /
BOTTOMSYMBOL) could be used in the development, but different tool numbers for these processings could
not be assigned. As of HiCAD 2024, this is now possible. For this purpose, the catalogs for molding, emboss-
ing and punching tools have been extended by the WZNR_BOTTOM column, which can be individually
assigned values.

In the sheet development, the side of the processing is read out and the appropriate symbol is used -
TOPSYMBOL or BOTTOMSYMBOL. At the same time, the values of the columns WZNR or WZNR_BOTTOM
(depending on the processing page) are read out and written to the development. If WZNR_BOTTOM is
empty, then WZNR is used instead. (see also Sheet Metal - What's new?)

User-defined columns in catalogue tables
Until now, the creation of user-defined columns was only possible for tables in the Factory standards cata-
logue. From HiCAD 2024 this is supported for tables in all catalogues. The table function New column has
been extended for this purpose. It can now be used to create user-defined columns of any type and - if desired
- to name them meaningfully. In addition to the name, which was previously also used as the column heading,
a Displayed name can now be specified, for example for translations. If no displayed name is specified, the
designation as column header is still used.

With this extension, the columns CUSTOM1 to CUSTOM9, which were previously predefined for this purpose
(before HiCAD 2024), are no longer needed and have been removed from the tables.

During a catalogue update, however, only empty CUSTOM columns are removed from the tables.
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Displayed names of table columns adapted
In various ISD catalogues, more informative displayed names have now been assigned to the table columns,
so that it is easier to recognise which data the table columns contain.

The following displayed names have been assigned:

Column designation Displayed name

BZ Designation

GEW Thread

GEW Weight

KILO Weigth

SIZE Size

HGEW Commercial weight

BZ_2004 Designation as of 2004

RHO Density

Furthermore, these displayed names are language- dependent and adapt to an English installation, for
example.

Fastenal - Threaded Rods
The catalogue Factory standards > Custom fasteners > Custom bolts + screws > Fastenal has been exten-
ded by Threaded Rods. You can find them at Rods and Studs/Threaded Rods.
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Henkel Teroson foils
Der Katalog Werksnormen/Anwender Baustoffe/Folien/Henkel/TEROSON ist um eine Tabelle mit damp-
foffenen Fassadenfolien erweitert worden: TEROSON FO2 SK1/SK2.

The table TEROSON FO2 SK1/SK2 with vapour permeable facade foils has been added to the catalogue
Factory standards/User-defined building materials/Foils/Henkel/TEROSON.

What's new? 111 / 370

News Overview



112 / 370 What's new?

Catalogue Editor



User-defined tables with Steel Engineering plates
At Factory standards > User-defined semi-finished products > User-defined plates you now have the pos-
sibility to create tables with your own steel plates. These tables are then also offered for selection via the func-

tion Steel Engineering > Plate, new > Rectangular plate .

Simply copy a suitable table from the catalogue Semi-finished products > Plates into the catalogue Factory
standards > User-defined semi-finished products > User-defined plates and edit it.
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Point clouds

Service Pack 2 2024 (V 2902)

Clipping Box Manager
With the revised Clipping Box Manager function, it is possible to transfer a multiple selection of views from the
drawing to the dialogue window after starting.

The dialogue window then shows in the Views area how many views are selected. The selection of views can
also be removed by clicking on the cross symbol. To activate a view, click on it with the left mouse button or,

after clicking on the icon, activate it in the drawing. If the view is already active, it is then deleted from the
selection. The activated views are marked with an orange border in the drawing. As before, the functions and
all clipping boxes in the drawing are listed under Clippings. The checkbox in front of the different rep-
resentations of the point cloud indicates which clippings are used in the views. You can change this assign-
ment here.

(1) Area for selecting and removing views

(2) (2) Clippings: Icons for creating, deleting and copying views of the point cloud

(3) List of differently clipped point clouds

(4) Active clipping Front view, Back wall in the 3-D model view
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Message in case of high memory utilisation
Process information has been added to the Point Cloud Converter. This allows you to monitor the conversion
process and a warning is issued if, for example, the memory utilisation is too high.
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Clipping Box Manager

The new Clipping Box Manager makes it easier to work with different views or clipping boxes of the
point cloud.

n You can switch between different clippings in the 3-D model view to see the appropriate geometry for mod-
elling.

n You can create clippings of the point cloud for the different views of a Sheet view to select the appropriate
representation for the detail views.

(1) Icons for creating and deleting clippings of the point cloud

(2) List of the different views with differently clipped point cloud

(3) Active clipping Front view, Back wall in the 3-D model view

Use the functions in the Clipping Box Manager to create, copy and delete views from the point cloud. The func-

tion New derives a new view of the complete point cloud without clipping box. If you select Copy , the
active view of the point cloud with clipping box and recess is duplicated. The new view is automatically active.

If you then exit the manager with OK, all edits, e.g. Edit clipping box or Subtract , refer to the
active view. It is indicated by an activated checkbox .
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The Clipping Box Manager for Sheet views

If you create a sheet with several views, you can also use the Clipping Box Manager to assign the different
representations of the point cloud to the views. First activate a sheet view, e.g. Top view, and then call up the
Clipping Box Manager. Now you can create a new view or select an existing view of the clipped point cloud.
The sheet views of the point cloud are only displayed in shaded mode.

Sheet with 4 different views in which the point cloud has a different clipping box and subtraction each time.
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Service Pack 2 2024 (V 2902)

New Feature functions
The feature formulas have been expanded in HiCAD 2024 SP2. You can find a list of the current functions
here.

New functions
Name Description
part_of (o: Object): Part - Returns the part to which the given geometry belongs (edge / sur-

face / beam).

edge_start (e: Edge): Point - Returns the starting point of an edge.

edge_end e: Edge): Point - Returns the end point of an edge.

face_area (f: Face): Real - Returns the surface of the facet.

part_volume (p: Part): Real - Returns the volume of the part/assembly.

part_mass (p: Part): Real - Returns the mass ("weight") of the part/assembly.

part_center_of_
volume

(p: Part): Point - Returns the centre of gravity of the part.

part_center_of_
mass

(p: Part): Point - Returns the centre of mass of the part.

New mathematical functions
Name Description
pi (): Real - Returns the circle number PI.

tau (): Real - Returns the full revolution in radians (2x PI).

e (): Real - Returns the base of the natural logarithm.

min (x1: Real; x2: Real): Real - Returns the smaller of two numbers.

max (x1: Real; x2: Real): Real - Returns the larger of two numbers.

clamp (x: Real; min: Real; max: Real): Real - Returns a number bound in the range between min
and max.

atan2 (y: Real; x: Real): Real - Returns the directed angle based on the full circle (four quad-
rants).
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Service Pack 1 2024 (V 2901)

Naming of feature functions
The function names of the feature formulas have been revised and standardized. A list of the current functions
can be found here.

Functions in existing drawings that were replaced with HiCAD 2024 SP1 will continue to be evaluated.

For a miter cut between adjacent beams/profiles, a separate feature is created for each part. In this case, the
two features are linked. This means that if changes are made to one of the features, the other feature is auto-
matically changed or deleted accordingly.

Major Release 2024 (V 2900)

Feature for part and sheet creation
From HiCAD 2024 onwards, the checkbox Feature is no longer available in the function dialogues for the cre-
ation of parts and sheets. This means that a corresponding feature is now always created during generation.

Create feature variant
When creating a Feature variant (as a VAA file), the assigned units are now taken into account and displayed

for information when saving the variant with the Create feature variant function. You can then use the
Variant Editor to change the units in the VAA file.
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HCM

Service Pack 2 2024 (V 2902)

Groups with isolated points

You can now use the Group function to group together not only line elements but also isolated points.
Line elements and isolated points that are contained in a group are only moved+rotated together by the HCM.

(1) The D and the isolated point form a group.
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If you deactivate the HCM constraint for a sketch, this is indicated in the HCM window of the ICN. Click on the

symbol to activate the HCM. If possible, HCM constraints are automatically assigned for the following
sketches.

HCM update when variables are changed
If the automatic recalculation (in the Variables window of the ICN) is deactivated when variables are changed,
the HCM model is not updated either. Previously, the HCM was always calculated. The automatic refers only
to actions within the variable window. The rest of HiCAD remains unaffected. For a HiCAD-wide, automatic
recalculation of the HCM, the option AutoUpdate HCM model (Ribbon: 3-D Standard > Function group: HCM
> Tools > Settings) must still be activated.

This allows several variables to be changed, which can then be updated together later.

The variables of an assembly

Settings for the 3-D Part HCM.
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Service Pack 2 2024 (V 2902)

Referencing - Updating identical parts
In the Configuration Editor at System settings > Referencing, the parameters:

n Automatically update referenced parts after each change and

n Update identical parts of referenced parts before saving

have been added again in SP2. This allows you to choose whether all identical parts in the current drawing
should be updated automatically when changing externally or internally referenced parts.

Update automatically calculated attributes before saving
For the calculation of attributes that are set to Manual / When itemising in the Configuration Editor, you can
specify whether or not these calculations should be performed automatically before saving referenced parts
and assemblies. The parameter Update automatically calculated attributes before saving is available in the
Configuration Editor at Modelling > Part properties. Weight (§01), Surface area (§10 and §SC) and Volume
(§20) are updated. The attributes Total quantity. (%06) and Qty. in assembly (%13) are not updated.
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Time threshold for AutoQuickView
In the Configuration Editor, it is now possible to set a time threshold for the AutoQuickView display of hidden
line or glass model calculations. If the threshold value is exceeded, the calculation is cancelled and the view is
displayed in QuickView. Subsequent calculations then no longer start a HiddenLine or Glass model cal-
culation, as the view is already in QuickView.

The setting is made at System settings > Visualisation > Views > Time threshold for AutoQuickView . The
default setting for the time threshold is 0 seconds. This means that the AutoQuickView behaves in the same
way as before and is applied to every Hidden line and Glass model calculation. In workshop drawings, a value
of 0.1 to 0.5 seconds can cause the views of the individual items to be displayed "Exact" and only "large" views
of the entire drawing to appear in the QuickView.

SpaceMouse®
There is a new setting in Configuration Management under System settings > Miscellaneous: Exit
SpaceMouse mode by moving the mouse. If this setting is activated, SpaceMouse mode must be ended by a
mouse action.

Referencing

Update identical parts
The parameters Automatically update referenced parts after each change and Update identical parts of ref-
erenced parts before saving have been removed in Configuration Editor at System settings > Referencing,
as from SP1 all identical parts in the current drawing are automatically updated when externally or internally
referenced parts are changed.

Referenced assemblies with referenced parts
When saving drawings with changed referenced parts, you can determine the procedure for the referenced
assembly that contains the referenced part. In the Configuration Editor at System settings > Referencing >
Saving changed assemblies, set the default setting for saving referenced assemblies. The default setting is
Only structurally changed assemblies. If you select a different setting during a current HiCAD session, the
setting from the Configuration Editor will be used again in the next session.

Additional column in the Packaging dialogue

When choosing Profile installation > New/Change > Packaging , there is now an additional column for
a user-specific attribute for the Packaging dialogue window. This attribute must be set in the Configuration
Editor at Profile Installation > Packaging > User-specific attribute.
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Development attributes for Steel Engineering plates
If the settings

n Surface area calculated from development contour (§SOC)

n Rectangular surface area of development (§S2D)

are activated in the Configuration Editor at Modelling > Part properties > Sheet Metal, then not only Sheet
Metal parts will be calculated, but also Steel Engineering plates from HiCAD 2024 SP1 onwards.

Drawing Management

Documents for general documents
There are two new settings in Configuration Editor at PDM > Drawing Management > External production
documents:

n Creation of external documents
This parameter determines whether external documents should only be created for the active sheet or for
all sheets. This is possible as of HiCAD SP1. The default setting is Active sheet.

n HELiOS attribute for HiCAD sheet names
Here you specify which HELiOS attribute the HiCAD sheet name should be assigned to. The HELiOS
attribute BENENNUNG (Designation) is preset.

Managing general 3-D parts via part filter
In the Configuration Editor at PDM > Drawing Management, you can set whether general 3-D parts should
also be taken into account when managing drawings.

As of SP1, the new Via filter option is available for the Manage general 3-D parts parameter. With this setting,
only the general 3-D parts that meet the part filters defined in the Favourites file Steel Engineering > Drawing
Management > General parts (BIM-3DPartFilter.xml) are taken into account.

Plant Engineering

Pipe length check no longer as macro
In HiCAD 2024 SP1 the pipe length check can be carried out together with the nominal width check and the
structure check in a check routine during loading and saving. For this purpose, the setting Checks the entire
drawing (Plant Engineering > Plant Engineering drawing check) must be activated in configuration man-
agement. By default, the check is switched off.

Insert plane flange
In the Configuration Editor at Plant Engineering > Layout plan you can define a distance between a straight
pipe and the plane flange. Use the parameter Insert plane flange, with projection.
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Settings for down-grade symbols
The settings for the Down-grade symbols have been changed. You can now select the unit for displaying the
down-grade symbol in the Configuration Editor. You can also set the number of decimal places and the dis-
tance between the down-grade symbol and text.

Interfaces
It is now possible to specify in the configuration editor that when opening foreign formats (e.g. STEP) via Drag
& Drop or double-click (in Windows Explorer), a dialogue window is no longer displayed to make changes. To
do this, use the parameter Import files directly during Drag & Drop at Interfaces > Import.
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Part properties

Automatically calculated attributes
In the Configuration Editor, at Modelling > Part properties, you can now determine the time of the calculation
for attributes that are set to Always, with the setting Automatically update calculated attributes when
loading. With the default setting No, the attributes are not updated during loading. The attributes are recal-
culated in HiCAD if you change the part, itemise it or recalculate it with the function Update part attributes.

If you include an attribute that has not yet been calculated, e.g. the weight, in the calculation and have
changed the default setting, the calculation is carried out for all parts when the drawing is loaded. This can
lead to waiting times.

Parameter configuration
The default settings of the standard template for Steel / Metal Engineering have changed with HiCAD 2024.
This affects the settings at Modelling > Part properties in the Configuration Editor.

The default setting of the parameters indicated in the image below was previously Always.

The parameter configuration Steel Engineering can be selected either during installation or subsequently with
the tool ParKonfigComp.exe (or ParKonfigUser.exe).
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CFGDBTool.exe
If you want to transfer your individual settings from the HICAD.CFGDB file of an older version into the Con-
figuration Editor of the new version, the CfgDbTool.exe program is available in the HiCAD EXE directory. This
tool is now available in all languages supported by HiCAD.

Intersections in the Hidden Line representation
Up to now, only intersections (or collisions) found between straight lines and planes or those involving circles
and cylinders were taken into account in the HiddenLine calculation. From HiCAD 2024, all collisions with ana-
lytical curves/surfaces or with Nurbs curves/surfaces are now also taken into account.

What exactly is taken into account can be defined in Configuration Management under System settings >
Visualisation > Views > Hidden Line > Collision check.

Part master display by double click
Until now, double-clicking the left mouse button on a part in the drawing or in the ICN called up the Part attrib-
utes dialogue window. In the Configuration Editor at System settings > HELiOS you can now set whether the
part's article master should be displayed alternatively. To do this, activate the setting When double-clicking
on a part, display article master instead of part attribute mask. If the clicked part does not have an article
master, the Part attributes dialogue window will be automatically displayed.

Magnetic snap-in when moving views
The alignment of views to each other or to other elements (e.g. drawing frames, title block frames and bills of
materials) of a drawing sheet has been facilitated by "magnetic" snap-in. As soon as a constellation is created
during dynamic shifting of a view that facilitates alignment, graphic auxiliary elements (e.g. distance arrows,
alignment lines) are displayed.

If no auxiliary elements are to be displayed, deactivate the setting Allow alignment based on equal distance
at System settings > Visualisation > Views > Magnetic snap-in.

Negative and positive position in identical part search
The negative and positive position of the profiles is a distinguishing criterion for the identical part search in the
dispatch itemisation. For this purpose, the new attribute DWF_NEG_INSTALL has been created as a dis-
tinguishing criterion. In configuration management, it is entered as a distinguishing criterion for the dispatch
itemisation at Profile installation > Dispatch itemisation > Integer attributes and is evaluated if the setting
Carry out dispatch itemisation is also activated here.

Processing external drawings
As the processing of external drawings can lead to problems with the automatic drawing derivation, a pro-
cessing lock has been built into HiCAD. If you still want to allow manual changes in external drawings, activate
the parameter Allow processings in external drawings. You will find the parameter under Automatic drawing
derivation and then Production drawing.
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Processing sheet metal developments in production drawings
In drawing management, processing (e.g. applying fillets to edges) of developments in the production drawing
was previously prevented. As of HiCAD 2024, the new parameter Allow processing of sheet metal devel-
opments is available in the Configuration Editor at PDM > Drawing derivation > Production drawing. The ISD
default setting is No. With Yes, it is possible to process and save the development in already created drawings
without marking the Sheet Metal part as changed.

If you allow processing of developments in the production drawing, no more automatic STEP, DXF data can be
created for Sheet Metal parts, because the CAM data is generated directly from the Sheet Metal part.

Generate pipe spool drawing from sheet view
If pipe spool drawings are created in a sheet area of the active design and then a new pipe spool drawing is
created from this sheet view, then as of HiCAD 2024 exactly those parts are taken into account in the new/up-
dated pipe spool drawing that were also visible in the original sheet view. This means that in this case you will
no longer be prompted to select the parts for the pipe spool drawing.

If, on the other hand, the pipe spool drawing is generated from the model view, then the behavior does not
change and you are prompted to select the parts as before. Unless you have deactivated the checkbox Part
selection before displaying pipe spool drawing dialogue in the configuration management under Plant
Engineering > Isometry and Pipe Spool Drawing.

Automatic BOMs for itemised source models
Excel BOMs can now be created and managed automatically for model drawings that are itemised source
models. For this purpose, the settings in the Configuration Editor at PDM > Drawing Management > External
production documents have been extended by:

n Create BOMs: With this setting you determine when Excel BOMs are to be created for selected drawings.

n List of model drawings with external BOM: With this setting you determine for which drawings external
BOMs are to be created and managed.
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Text file with separator
When exporting text files as a bill of materials, you can now also end each line with a separator. To do this,

select a separator in the Settings for the text file and then activate the option Separator at the end of
each line

The separator at the end of the line is active
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Text file with separator between the records and at the end of the line

ERPlus interface - Excel export
When exporting the ERPlus BOM, the Report Manager is now executed in the background. The output is then
based on the Excel template with the relevant files ERPlus.XLSX, ERPlus.CS and ERPlus.RM_SETTINGS
from the HiCAD installation directory under SYS. These are specifically only for ERPlus and cannot be selec-
ted via the normal BOM configuration.
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Set default configuration
For RM3 files that are transferred from HiCAD or HELiOS to the Report Manager without a configuration file,

you can choose Set default configuration (Menu bar > Settings > ...).

After calling up the function, activate the settings to be saved. All settings are active on the ISD side. Then spe-
cify HiCAD or HELiOS as the data source for the RM3 file. For HiCAD, the configuration is saved under
Default-HiCAD.RM_SETTINGS and for HELiOS under Default-HELiOS.RM_SETTINGS. For example, you
can deactivate column settings for HELiOS so that the order and visibility of the columns is adopted from the
transfer file (RM3).

Creating an RM3 file with the HELiOS API
The HELiOS API now supports the output of an RM3 file for the Report Manager from any node of the product
structure. The function is IApiArticle::SaveProductStructureToRm3[Legacy].
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General adjustments

Empty rows in the structure list
With the new function Extended settings (Structure list)... (under Settings) you insert empty rows in the
structure list. You can determine the level up to which empty rows are to be inserted. In the output, the empty
rows are taken into account in all selected formats.

Empty row after each 1st and 2nd level of structure list
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Auto-completion

The auto-completion of formulas in the Filter settings and in the User-definable columns i s dis-
played after entering a point. The complete list appears when pressing the key combination ALT + space bar.

Placeholder and dot for displaying conditions
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Dot for selection for formula creation

Round decimal places
In the settings for the output of XML, text and HTML BOMs, the option Round numerical values to the spe-
cified number of decimal places is now available. This means that if you have specified a number of decimal
places for the Column in the Column settings, the value is rounded to this number when creating the BOM.

Settings for exporting the text BOM
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Header and Footer Editor
In the Header and Footer Editor, placeholders for date, time, user name and computer name are now sup-
ported for printer output.

Input:

n Date: %Ss(Date)

n Time: %Ss(Time)

n User name: %Ss(User)

n Computer name: %Ss(Computer)

Simply drag the Text block (in the area: Basic elements) into the Workspace and enter the placeholder for
accessing the system information in the Text formatting field on the right.

New in the Excel BOM templates for Steel Engineering (HiCAD_Stahlbau.DE2900.0.XLSX) is the Profile
structure list. With this list, parts/profiles of the same type are grouped together and output in a structure list.
The profile structure list is a mixture of structure list and total profiles list and is suitable for the combination of
Steel Engineering and Profile Installation, e.g. in hall construction.

With the Excel BOM template for Steel Engineering (HiCAD_Stahlbau.DE2900.0.XLSX) you can output
images for steel plates on the Steel plates and metal sheets with image worksheet from HiCAD 2024.

BOMs for HiCAD

Cancelling the insertion of the BOM
In the export settings of BOMs for HiCAD, you can specify the number of lines to be output per table page. The
table pages must then be placed individually in the drawing. In HiCAD 2024 you can cancel this process with a
right click.
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Adjust text lengths
In the settings for exporting BOMs to HiCAD, you now have the option of adjusting texts to the column width.

Activate the checkbox if texts that are too long for the specified column width are to be shortened.
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Transfer visible structure list

In the Options , the new setting Export visible structure is now available. By activating this option, the
structure list will be handled as with the export in the old Report Manager. This means that the collapsed rows
are not taken into account for the export or for the column totals. The option is deactivated in the ISD default
setting.

Use in the HDE reports
Within the HDE reports you can specify which RMS file (old Report Manager) should be used. From HELiOS
2024 you can also use the new RM_SETTINGS files and thereby start the new Report Manager (from 2023).
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Variant Editor
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Files managed by HELiOS
HiCAD cannot determine where the data originates when accessing files for which a document master exists.
This can lead to problems when dealing with variants.

For example, a variant could be loaded from the hard disk in the Variant Editor, modified and transferred to the
corresponding items in HELiOS with the part data synchronization. In fact, this variant file can be managed by
HELiOS e.g. in the Vault Server. So one has not changed the file to which the document master actually
points.

This means that when the variant is installed, potentially a different geometry is calculated than expected,
because the selected item no longer matches the expression in the VAA file to which the document master
points.

Therefore, when a file is opened via the file system, it is checked whether this file is managed by HELiOS. If
this is the case, the following message appears:

If you click on Yes, the file will be loaded via the document master. This ensures that the file matches the one
in the document master.

This query also appears when opening takes place via the file system
n in the PAA Editor (AnPaaEdit.exe),
n during part data synchronization (PartDataAutoSync.exe), and
n during the configuration of the HELiOS database (DBPlantDataImport.exe).
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Category and Unit
The Variant Editor (VariantenEditor.exe) now also supports working with imperial units.

When opening a variant, the Unit column displays whether a variable is assigned and - if so - which unit. The
display (mm) means that no unit is assigned.

To assign a unit to a variable or attribute or to change the assignment, click on for constant attributes or

on for variables and attributes.

Constant attributes

Clicking this button lists the constant attributes specified for the current part type.

As of HiCAD 2024, it is possible to define or change the category and unit here for corresponding attributes.
The attributes that expect a unitless number are all nominal width attributes and the Pressure attribute. The cat-
egory Unitless number is already assigned to these attributes, a change is not possible here.

To change the assignment of category and unit of an attribute, select the desired entry in the selection box of
the corresponding line. Since the category specifies the available units, the category should therefore be selec-
ted first.

Some attributes are automatically preassigned when the attribute assignment is called up, e.g.:

This means that when you exit the window with OK, the variant has been changed, even if you do not
make any changes.
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Variables + Attribute

Clicking the button lists all variables defined in the variant with their associated data
type (Integer, Floating point or String) and HELiOS attribute. .As of HiCAD 2024, the assigned category and
unit are also displayed here.

To assign a category and unit to a variable or to change the assignment, click in the Category and Unit column
in the corresponding row. Since the category specifies the available units, the category should be selected first
and then the unit.

There are some attributes that are nominal values without a unit and are defined as a Unitless number. Here
the assignment is done automatically.
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If you are editing variants and assign a unit to a previously unitless variable, then when you exit the Vari-
ables+Attributes window you will be asked whether the previously used unit matches the newly assigned one.

If you choose Yes, the category and unit will be assigned to the variable, but without conversion. If you choose
No, you must select the original unit. Only then will the variable be assigned the category and unit and and the
value of the variable be converted to the new unit.

Example:
The variable D in the figure has neither a category nor a unit assigned to it, therefore Undefined and (mm).

Now change the assignment as shown below:
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When you exit the dialogue window with OK, the following query appears:

If you choose Yes, the category and unit are assigned to variable D, but no conversion takes place.

If you choose No, you will be prompted to select the original unit, e.g. mm.

If you confirm the unit with OK, the Category and Unit are assigned to variable D here as well, but the previous
values are now converted from mm to inch.
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Automation

Discontinuation

Discontinuation of the ISD.PDM.API
Before carrying out a HELiOS update for an older HiCAD version, please note that from HELiOS 2022
omwards, the previous ISD.PDM.API will be discontinued and replaced by the new API from Helios.In-
terface. If you use customisations that use functionalities from the previous ISD.PDM.API, you must
update the customisations to the new API before carrying out the HELiOS update. If you use cus-
tomisations that use functionalities from the HiCAD API, you should ensure that the HiCAD version used
is at least version 2502.5 or 2601.1 or newer. If you are unsure whether you are using corresponding
adaptations, please talk to your administrator or contact the ISD in case of doubt.

Service Pack 2 2024 (V 2902)

API extension in 3-D
The HiCAD API now also supports the following 3-D functions:

n
Dependent part : ISD.CAD.Creators.DependentNodeCreator

n
Deform : ISD.CAD.Modifiers.Deform

Develop beam

To develop curved steel engineering beams, the HiCAD API now supports the Develop beam function
(Steel Engineering > Pull-down menu: Tools) with the following command:

n ISD.CAD.Steel.DevelopBeam

API for various View functions
HiCAD now offers various functions for creating views via the API:

n

Detail view, Cuboid/Sphere : ViewCreator.CreateDetailView mit DetailViewSphereParams bzw.
DetailViewCuboidParams

n
Create new cut-out : View.CreateCutout

n
Activate exploded view : View.EnableExplosion, View.Explosion
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Order of drawing sheets
To change the order of drawing sheets, the HiCAD API provides the command

n DrawingSheet.MoveTo

Free milling for sheet development

The HiCAD API now supports the processing of sheet developments with the Free milling function ( 
Sheet Metal> PullDown-Menü: Extras). For this there is the class:

n ISD.CAD.SheetMetal.FreeMilling
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Cam joints
The HiCAD API now also supports the Cam joint (3-D Standard > Standard Processings > Bore > Cams

). For this there is the new class:

n ISD.CAD.Modifiers.Cam/CamProcessing)

Annotation tags

The HiCAD API provides the following command for the optimised arrangement of Annotation tags (3-D
Dimensioning + Text > Text > LLine > Optimise arrangement):

n LabelCreation.OptimizeArrangement

Executing UI tasks
The HiCAD API provides the ExecuteTask command for executing user interface tasks.

n Example: Context.ExecuteTask("Core.SolidPrimitivesDialog")

Event after drawing derivation
With the HiCAD API you can trigger an event (a function to which you log on) when a drawing sheet is created
during drawing derivation. The following command is available for this purpose:

n ISD.CAD.Steel.Drawings.WorkshopDrawings.SheetCreated

Form and positional tolerances
To create the new form and positional tolerances via the API, there is a Create function with which you can
load favourites.

n ISD.CAD.Dimensioning.FormPosTolerance.Create()

Accessing fixed view points
In the API, there is now a property (true or false) set or not set for the fixed point of a view. If the fixed point is
set, you can access it. This allows you to move views back to their origin that do not have a fixed point.

n View.FixPoint
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Interfaces

Service Pack 2 2024 (V 2902)

FlexiCAD XML
With the update to Version 2024 Service Pack 2, HiCAD supports the import of the XML interface by Flexi Jet.
Files from Version 1.3 can be imported. All existing spatial element types are imported and assigned to the
various levels in the part structure. The HiCAD part structure is based on the structure in the XML file. The

import into HiCAD is carried out via Drawing > Insert part > Exp... > 3-D Import .
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The FlexiCAD XML interface will be available with Patch 2902.1 of HiCAD 2024.

IFC

IFC default settings for import
The default settings for importing an IFC file have been changed: When importing, features are no longer cre-
ated automatically by default. This also increases performance.

If you want to create features, you must activate the Create feature checkbox.

Select IFC version when exporting
The dialogue window for the 3-D export of an IFC file has been adapted. Before saving, you can now choose
between two IFC versions from the Schema version drop-down menu: IFC2X3 and IFC4.

The Model view definition has also been added. With IFC4, you can choose between Reference View and
Design Transfer View, while Coordination View is set for IFC2X3.

NCX

Compensation mode
Under General in the NCX export dialogue, you can set a Compensation mode for milling tool paths:
n On contour

n With offset
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Blind hole processing
Blind holes can be executed as a hole with one depth (From one side) or as a through hole (From both sides).

Thread description
Similar to the DSTV-NC export, you can also specify for the NCX interface whether threads should be written
to the file as such or completely suppressed, or alternatively output as core drills.

Calculate cutting length of notched beams
In order to calculate the cutting length of notched beams and output it in the NCX file, the new option The-
oretically extend even with only one cutting plane + straight saw cut (output cutting length) has been
added in the export dialogue under Cutting planes.

Flow drillings

Flow drillings can be inserted in HiCAD via 3-D Standard > Standard Processings > Bore/Thr. .

These are also output accordingly by the NCX export.
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2-D DXF/DWG: .dat file transfer confirmation
When importing and exporting2-D DXF/DWG files, you have the option of loading an older configuration file
via the Compatibility tab of the Settings dialogue, for example to adopt settings from earlier HiCAD versions.

You will receive a confirmation message after successfully importing a corresponding file.

KISSsoft 2024
HiCAD supports the new version of the KISSsoft plugin.

What's new? 149 / 370

News Overview

../2D-Schnittstellen/dxfschnittstelle/Importkonfiguration.htm
../2D-Schnittstellen/dxfschnittstelle/exporteinstellungen.htm
../2D-Schnittstellen/dxfschnittstelle/2DDXF.htm
../WeitereSchnittstellen/kisssoft.htm


Punch marks in ToPs-GEO export
With the update to Service Pack 2, you can optionally write punch marks to the file when exporting ToPs-GEO.

Punch marks are entered as a circle with a configurable diameter.

The setting is made in the file: \sys\CAMint_HiCAD_GEO.ini.

CAMint_HiCAD_GEO.ini: (excerpt)

The file is not overwritten by update installations in the \sys\ directory, but is stored in the \tem-
plates\Default\sys\ directory.

To use the new setting, you must adjust the file in the \sys\ directory using the current one under \tem-
plates\Default\sys\. Of course, you can also overwrite the file in the \sys\ directory with the file from the \tem-
plates\Default\sys\ directory, but you should note that any adjustments in the file at \sys\CAMint_HiCAD_
GEO.ini that differ from the default settings will be overwritten and may have to be made again.

If there is an older version of the file in the \sys\ directory, no punch marks are output.

ERPlus interface - Excel export
When exporting the ERPlus BOMs, the Report Manager is now executed in the background. The output is
then based on the Excel template with the relevant files sys\ERPlus.xlsx, sys\ERPlus.cs, sys\ERPlus.rm_set-
tings. These are specifically for ERPlus only and cannot be selected via the normal BOM configuration.

Version number for CATIA interface omitted
The name for the import and export of CATIA files has been adapted. The version number has been removed
as the format versions for the interface have been changed and therefore not only V5 files can be imported and
exported.
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Update to CADfix 13
With the update to CADfix 13, the following format versions are now available:

n ACIS R1 - 2023 1.0.0 (R33)

n CATIA - V5-6 R2023

n JT - JTOpen 6.4 - 11.3

n PLM XML - JTOpen 6.4 - 11.3

n Parasolid - 9, 13 – 35

n NX - 1 - 2212 Series

n SOLIDWORKS- 98 – 2023

n SolidEdge - V18 (2006) - 2023

Please note:

In the topic Interfaces Overview you will find extensive information on the import and export of the data formats
supported by HiCAD.

Opening foreign formats without dialogue
Foreign formats (e.g. STEP) can now also be opened directly via Drag & Drop or double-click in the Windows
Explorer without any further dialogue. To do this, the new checkbox Import files directly during Drag & Drop
must be activated in the Configuration Editor at Interfaces > Import.

The default option will then be used.
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Combining the function for 3DFindit
Previously, two functions were available for accessing 3DFindit. In SP1, these functions have been combined.
The title bar of the dialogue window now shows whether it is the free basic version or the paid full version.
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3-D Import: Move to origin
When importing external data, the problem occasionally arose in the past that data was defined in coordinate
systems in which the geometry was far away from the origin. In HiCAD, this led to calculation inaccuracies and
inaccurately shaded models.

As of HiCAD 2024 SP1, a new Move to origin checkbox is now available for many file formats when importing
with the Open > 3-D Import function. This applies, for example, to STEP (only if the Repair Tool is activated),
VDAFS, IGES, 3D DXF/DWG, JT/PLM XML and other CAD formats.

If you activate the checkbox when inserting, the model is automatically positioned near the origin of the
coordinates. This also increases the accuracy of the model.
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DSTV-NC
The display of bores for the DSTV-NC export has been extended as follows:

You can specify a maximum diameter for both slots and round holes.

Slots or round holes smaller than or equal to the diameter defined at this point are then written to the BO block
(bore), larger holes are automatically written to the IK block (inner contour).
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Access to 3Dfindit
3Dfindit by CADENAS is the visual search engine for 3-D CAD, CAE and BIM models. It enables access to
CAD catalogues of well-known component manufacturers for design and engineering.

For direct access to the search engine, two new functions are available in HiCAD at Drawing > Insert Part >
Exp >...:

n 3Dfindit (Basis)
The free version offers you access to the available 3D catalogues that have a download contract with
CADENAS (as of 06/2023, there are approx. 900 manufacturers).

n 3Dfindit
The paid version gives you access to the DIN/ISO/EN standards and to the available 3-D catalogues that
have a download contract with CADENAS (as of 06/2023 there are approx. 900 manufacturers).
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Registration is required for access.

The previous functions
n parts4cad (Basis),
n parts4cad und
n bimcatalogs

are covered by the new functions and are therefore no longer available from HiCAD 2024.
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New import formats: MicroStation and Solid Edge
In HiCAD 2024, the following file formats are newly available for import:

n MicroStation:
Parts and assemblies in the (3-D) geometry format .dgn.
DGN Versions 7 to 8 are supported.

n Solid Edge:
Parts and assemblies in the (3-D) geometry formats .par, asm and .psm
Solid Edge versions V18 (2006) to 2022 are supported.

IFC interface: Basic settings
The IFC export option Output identical parts as referenced parts is activated by default from HiCAD Version
2900..

Please note:

Please note that this change applies to new installations of HiCAD. Update installations do not overwrite exist-
ing configurations.
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2D-DXF/DWG: Improved Import and Export options
The settings dialogues for both import and export of 2-D DXF/DWG files have been further improved in HiCAD
2024.

In the menu window of the Import settings you will find the new tab subsections Line types, Fonts and DXF
layer assignment. The latter replaces the former "Layers" area with an extended range of options.

On the Others tab you will find a new option for importing Splines, which can be imported from the 2-D DXF
file to HiCAD as 3-D polyline, B-spline or B-spline with approximation.
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On the Colours tab an optional assignment table for lines with fixed DXF line thickness has been added.
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In the dialogue window of the Export settings the tab Fonts has been added, in which HiCAD fonts and DXF
styles can be assigned to each other.
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On the General tab you will find the new checkbox option Do not export single part as block. If only one part
is exported during an export, this checkbox controls that no "BLOCK" is created in the DXF file for a single part.

Manual editing of keywords in corresponding configuration files, as was the case in older HiCAD versions, is
thus no longer necessary.

The configuration file keywords that are thus omitted include:

n For import: LAYER, LTYPE, COLAR, STYLE, SPLIN, COLWE

n For export: FIGB1, STYLE

Please note:

Options available in earlier HiCAD versions via the configuration files hcadacad or acadhcad, which were not
taken over into the settings dialogues in the context of the conversion to the new menu structure, can still be
set for compatibility reasons on the Compatibility tab in the respective import or export dialogue, in order to
continue to guarantee possible behaviour beyond the settings dialogues.

For reasons of clarity, however, these options are only displayed if they differ from the default settings.
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Sheet Metal
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Cross-breaks in developments
In sheet developments, cross-break edges previously used the same setting as forming edges.

As of HiCAD SP2, you can set the line colour, line type and layer in the Extended settings on the Edges
and lines tab for

n Cross-breaks with positive bend angle and

n Cross-breaks with negative bend angle.
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Manual changes to developments
Previously, automatically generated dimensions and annotations of a development that were changed manu-

ally were reset with the Update development function. As of HiCAD SP2, all changes to the position and
the properties (e.g. bracketing of the dimension figure) will beretained after synchronisation. This change

affects all texts generated by the Develop sheet function via the options Dimensioning and Annotation
> Bend line texts.

(1) Dimensions and annotation of the bend lines are generated automatically,

(2) Chain dimension and bend angle are moved manually,

(3) After processing the sheet and updating the development, the changes are retained.
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Semi-finished product parameters
If you deactivated the semi-finished product in the sheet metal creation feature before HiCAD SP2, an error
message was displayed for the parameters (bend radius) that were loaded from the semi-finished product. As
of HiCAD SP2, the parameters are also deactivated if the semi-finished product is set to No. This behaviour
affects the following functions::

n
New sheet along sketch ,

n

Create connecting sheet ,

n
New sheet from surface ,

n
New sheet from solid and

n

Pipes + Vessels .

(1) Deactivating the semi-finished product before HiCAD SP2, (2) Deactivating the semi-finished product with
HiCAD SP2
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Avoid double dimensions
If you activate Outer contour, the complete contour is dimensioned. If the measurement for the Outer contour
matches the measurement for the Dimension during development, only the measurement for the Dimension
will now be displayed.

(1) Evaluation of the dimension and outer contour parameters before SP2, (2) Evaluation from SP2 onwards

Deleting flanges and bend zones
Flanges and bend zones cannot be deleted from sheet metal parts with a feature log. After activating the
flange or bend zone, the entire sheet metal part is deleted. From HiCAD SP2 without confirmation prompt.
Deleting flanges and bend zones is only possible in the feature log.

Free milling for sheet developments

The HiCAD API now supports the processing of sheet developments with the Free milling function.
For this purpose, there is the class

n ISD.CAD.SheetMetal.FreeMilling
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Service Pack 1 2024 (V 2901)

Revised Pipes + Vessels function

The Pipes + Vessels function has been revised and made more user-friendly. As a result, you can
now create parts as hollow and solid bodies in different variants and insert them as main or sub-parts.

There are six different types to choose from. You then decide whether the part should be created as a Sheet
Metal part or as a Solid. The Parameters can be used to customize the parts as required.

The Sheet parameters are only active if you have selected Sheet Metal in the dialogue. You can either select
a material and a thickness from the catalogue, or you can determine the Thickness in the input field without
selecting a material. You also have the option of selecting a Bend radius and one of ten different Allowance
methods. The Offset direction defines the direction in which the sheet is to be created. In the Bend zone run-
out field, you can choose from three options for how the bend zones on the edges should look. Under Accur-
acy criterion, you can define the Chord condition via the Angle, the Distance or the Length. You also need to
enter a value that determines the accuracy of the part.

Finally, you can save the part Referenced as usual and assign an Article number. If you have selected a
semi-finished product, an article number will be suggested.
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Length change by selecting front edge
By default, as of HiCAD 2024 SP1, the Front edge is requested for identification in the functions for length
changes of sheets. This affects the functions:

n

Corner/Mitre ,

n

Trim ,

n

Change length

If the selection of the front edge is not suitable for the desired purpose, you can switch to the longitudinal edge
with the right mouse button. In the Configuration Editor, go to Sheet Metal > Default setting and use the para-
meter Start mode when identifying front surfaces to change the ISD default setting from Front edge to Lon-
gitudinal edge.

(1) Front edge, (2) Longitudinal edge

168 / 370 What's new?

Sheet Metal

../eckeschliessenbl/eckeschliessenbl.htm
../trimmenbl/trimmenbl.htm
../verlaengernbl/verlaengernbl.htm


Major Release 2024 (V 2900)

Feature for Sheet Metal part creation
In the function dialogues of the sheet creation, the checkbox Feature is no longer available from HiCAD 2024.
This means that a corresponding feature is now always created when sheets are created.

This affects the following functions in Sheet Metal:

Sheet Metal > New > Create base sheet

Sheet Metal > New > New sheet from sketch

Sheet Metal > New > New sheet from 2-D development

Sheet Metal > New > New sheet along sketch

Sheet Metal > New > Create connecting sheet

Sheet Metal > New > New sheet from solid

Sheet Metal > New > New sheet from surface
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Free milling

With the new Free milling function, you can provide the edges of composite panels with a milling tool
path. The tool path is defined by a sketch and the milling tool is loaded from the catalogue.

After selecting the function, first identify the sheet metal part. For the sketch, you can either select an existing

sketch and process it if necessary or draw a new sketch in the plane.

You determine the shape of the tool path by selecting the tool in the catalogue Factory Standards > Com-
posite panels, groove form > Standard groove forms.

Tools for the tool path
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(1) Sketch, (2) Groove form: V 135°, (3) Groove form: Rectangle15
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Sheet development

Exclude annotations in sheet developments
For bend line texts in sheet developments, you now have the choice of whether the text background should be
left out. For this purpose, there is now the option Exclude background in the Annotation Editor.

(1) Positive angle without background exclusion, (2) Negative angle with background exclusion
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Display of the catalogue symbols
The development of a sheet is always a 3-D part. To exclude catalogue symbols (bore patterns, moulding tools
and punching tools) from the 3-D display and to display them as symbols, activate the respective checkbox

for the sheet development in the Extended settings > Tab: Extended setting.

The parameters (line colour, line type, ...) of the catalogue symbols are taken from the Edges and lines tab by
default. To keep the parameters from the catalogue you can now activate the new option Keep line properties
for catalogue symbols.

(1) Parameters of the standard processing edges changed in the Extended settings of the development.

(2) Line properties taken from the catalogue.
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You can also change the display of the catalogue symbols in the feature.

Tool numbers in sheet metal processing
In sheet metal processing, there are machines that use different tools for processing the front and back of
sheets, e.g. punch-laser combination machines. Until now you could only load different representations from
the catalogue columns TOPSYMBOL and BOTTOMSYMBOL for processing the front and back side in the
sheet metal development. Now it is also possible to read out different tool numbers (WZNR and WZNR_
BOTTOM) from the catalogue. The catalogues for moulding, embossing and punching tools have been exten-
ded by the columnWZNR_BOTTOM. If the columnWZNR_BOTTOM is empty, WZNR is used instead.

(1) Table in the catalogue with WZNR and TOPSYMBOL for the front side of the development

(2) (2) WZNR_BOTTOM and BOTTOMSYMBOL for the rear side of the development
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(1) Sheet with beading

(2) Development of the front side with plane representation of the moulding tool (TOPSYMBOL) and tool number (WZNR)

(3) Development of the back side with plane representation of the moulding tool (BOTTOMSYMBOL) and tool number

(WZNR_BOTTOM)
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Mitre with neighbouring sheets

With the Corner/Mitre function you can now add a milling edge in the Mitre, with neighbours mode. To

do this, you must activate the Sheet edge as milling edge option in the dialogue.

(1) First sheet, (2) Second sheet connected with milling edge zone

Apply length value

To change the length of various sheets by the same value, the function Change length has been lex-
tended. When lengthening sheets and bend zones, you can now fix the value for the Length specification
options By value and Total length .

With this switch position, the value (active option By value ) for the extension is set to 0 again after
the first length change is accepted and the next edge is selected. This means that the last entry is not saved. If

the Total length option is active, the total length is displayed here after the new selection.

If this setting is active, the value or the total length is also available for the next edge after choosing Apply.
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Extension of the coating function
HiCAD now also allows you to coat bulb plates and checker plates. You can assign different parameters (col-
our and description) for the front and back side.

Until now, the coating of general parts (without structure) was not displayed in section and detail views. From
HiCAD 2024, the coating of general parts (without structure) is also displayed in sectional and detail views.

Settings for 2-D DXF export
The settings for exporting developments as 2-D DXF files have been revised. Important settings are now
moved from the Compatibility tab to the front tabs in a user-friendly, revised version. The remaining settings
are now only displayed on the Compatibility tab if they do not correspond to the default settings (values of the
former acadhcad/hcadacad.dat).

The settings for DXF can be customised when exporting developments using the Edit settings function
and then saved as Favourites.

Improved handling of crosshairs during bending simulations
Crosshairs in bend zones of sheets are now moved to the appropriate position during a bending simulation,
provided you have activated the bend zone and not the entire sheet during the process.

Bores forming a circular pattern in a bend zone
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Transform + Clone in context menu
The context menu of flanges and bend zones has been extended by the functions for transforming and cloning
parts. If the feature protocol is active, the entire Sheet Metal part is always transformed or cloned.

Attach flange function in context menu
In the context menu, accessible by right-clicking on a flange and then under Attach, the functions Flange from
sketch and Flanges to surface can now be found:
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Design variant SZ-20

User-defined Steel Engineering plates in catalogue
For steel plates you can create your own tables in the Catalogue Editor at Factory standards > User-defined
semi-finished products > User-defined plates. These tables are then also offered for selection in the function
Steel Engineering > Plate, new > Rectangular plate.
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Steel Engineering

Service Pack 2024 SP2 (V 2902)

Civil Engineering - Part type catalogues
Due to many customer requests, the Part type catalogue, 3-D function is once again available in the Civil
Engineering functions docking window under Civil Engineering, General > Civil Engineering - Part type
catalogue.

Insert new beam - modified and extended dialogue

The dialogue window of the Insert new beam function has been slightly changed and extended.

n The Source are has been renamed to Cross-section and has been moved been moved to the top of the
dialogue window, above the Fitting area.

n The option Adopt cross-section from reference profile has been moved to the Cross-section area and
the symbol for Open/close configuration window for prototype beams has been changed for prototype
beams.
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n Previously, only the Centroid of the beam cross-section and the corresponding beam axis points could be
selected as the reference point.

As of SP2, the Middle (=surface cross-section) of the bounding box, i.e. the smallest cuboid that com-
pletely encloses the beam, can also be used instead of the centroid. However, this only has an effect on
asymmetrical beams and profiles, for example L-beams.
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n The functions Beam from sketch and Multi-part beam from sketch have been integrated into the dia-
logue.

The previous functions

Beam from sketch,

Beam from sketch, as sub-part, and

Multi-part beam from sketch
have therefore been removed from the Steel Engineering Ribbon and moved to the Steel Engineering >
New > Beam > ... pull-down menu, under Up to HiCAD 2022.

182 / 370 What's new?

Steel Engineering



Copying connections on API basis
Previously, only connections based on a design variant could be copied using the Copy connection/design

variant function. As of HiCAD 2024 SP2, this is also possible for connections that are realised as API
variants. This affects the following connections:

n Cross-bracing (2601)

n Cross-bracing (2602)

n Cross-bracing (2603)

n Frame Corner (2203)

n Gusset Plate (2510)

n Stabilizing Pipe (2701)

n Stabilizing Pipe (2702)

n Purlin Joint (3204)

n Purlin Joint (3206)

n Bar Configurator (4001)
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Railing Configurator

Post made of round steels
As of HiCAD 2024 SP2, profiles from the catalogue Semi-finished products > Beams+Profiles > Round steel
can also be used as posts.

Straight cut on handrail
On the Post - Handrail tab, the At lower edge of handrail checkbox is also available for the Trim pipes vari-
ant. If the post is to be cut straight at the lower edge of the handrail, activate this checkbox.

(1) Trim pipe, (2) Trim pipe, at lower edge of handrail
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Post - Sub-structure: Lateral connection with flat steels
On the Post - Sub-structure tab, there is another connection variant called Lateral connection with flat steels
available. Here, the posts are attached to the side of the beam using connecting plates (sheet metal parts or
flat steels)
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Post - Handrail - Console (round bar)
A further variant called Console (round bar) is available for connecting the handrail to the post. Here, the hand-
rail is positioned in front of the wall console connection (own production).
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Continuous infills
As of SP2, infills can be configured for an entire segment independently of the posts. There is then one infill
per segment. The components of the infill are summarised in an assembly called Continuous infill.

Two variants are available for continuous infills:

Segment infill through posts

Here, the knee rails run through the posts. The knee rails can be evenly distributed or have a certain distance
to the handrail and finished floor.
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Segment infill with spacers

In this variant, spacers are placed on the posts. The knee rails then pass through the spacers. They can be
evenly distributed or have a certain distance to the handrail and finished floor.
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Staircase Configurator - Start/end platform as a step
From SP2, a new type of stair start and stair end is available on the Calculation tab of the Staircase Con-
figurator, which can be used to install steps at a stair start/end instead of platforms.

If these options are selected, step variants can be selected for the stair start/end instead of a platform on the
Platforms tab.
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Redesigned Frame corner dialogue (2203)
The dialogue for the Frame corner (2203) connection has been redesigned in SP2.

n The selection of the two I-beams to be connected now takes place directly in the dialogue window. The
selection can also be corrected in the dialogue window. Previously, the beams had to be selected before
the dialogue window was displayed.

n The semi-finished products of the individual components of the frame corner can be selected centrally on
the new Semi-finished products tab. This also applies to the bolting on the front plate and the tension
plate. The previous Bolting tab is therefore no longer available from SP2.
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n As of SP2, a separate tab called Reinforcement plates is now available for this type of plates. The corner
processing can be selected here if desired. The chamfers can either be chamfered (45°) or filleted. In addi-
tion, the reinforcement plates can be connected both horizontally or vertically. The vertical connection can
also be made row by row.
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By activating the corresponding checkboxes, you can individually define which rows/columns are to be
linked, e.g.

Some examples are shown below:
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End plate (2102) - Base position
When connecting End plates (2102) to a beam, the position of the base can now be influenced. The Shorten
beam checkbox has been added to the Base tab for this purpose. If the checkbox is active, the beam will be
shortened by the height of the base when the plate is inserted.

(1) Shortening of the beam by the plate thickness including filler plates, (2) Beam additionally shortened by
base height
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Strap joint (2310) - Chamfers of straps
With the Strap joint (2310) , it was previously only possible to fillet the corners of the strap. As of SP2, cham-
fering is also supported.
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Service Pack 2024 SP1 (V 2901)

Development attributes for Steel Engineering plates
As with Sheet Metal parts, the attributes Rectangular surface area of development (§S2D) and Surface area
from development contour (§SOC) are also now calculated for Steel Engineering plates if the settings in the
Configuration Editor at Modelling > Part properties in the Sheet Metal area are set accordingly.

Railing Configurator

Faster start
The start of the Railing Configurator has been significantly accelerated with Service Pack 1.

Distance between skirting board and post
The Skirting board tab has been expanded. The distance between the skirting board and the post can now be
specified here.
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Distance between handrail and cross-member
On the Infill tab, the additional checkbox Perpendicular to handrail is available for infills with cross-members
and infills with bottom cross-members, e.g.

If the checkbox is activated, the distance at the top/bottom is interpreted as a vertical distance between the
handrail and cross-member, or cross-member and beam. This only has an effect on sloping railings.

The following illustration shows the difference.
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Feature for mitre cuts
For mitre cuts, a feature with the name Mitre cut is created for both processed beams. From SP1, the two fea-
tures are linked. This means that if changes are made to one of the features, the other feature is automatically
changed accordingly. If, for example, the mitre cut feature is deleted from one of the two beams, then - unlike
previous HiCAD versions - the feature of the other beam is also deleted.

Linking the two features improves the use of the function for variable-controlled assemblies, e.g. for user-
defined infills in the Railing Configurator. Previously, the feature recalculation, which is carried out in particular
when variables are changed, could lead to undesirable results. The image below shows such a case:

(1) shows the initial state, (2) the result as of HiCAD 2024 SP1, (3) an undesired result that could occur before
HiCAD 2024 SP1.

This new behaviour does not apply if the mitre is created via the HiCAD API.
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Civil Engineering - Part type catalogue, 3-D
The Civil Engineering - Part type catalogue > 3-D function in the Civil Engineering functions > Civil Engin-
eering, general docking window contained functions that have since been replaced by new developments and
are therefore no longer required. The function is therefore no longer available as of SP1.

Galvanization holes on beams
In the settings for the galvanisation holes on the beam, the Y-distance of the bores now refers to the fillet on
the beam and not to the flange as before. This applies to the following connections:
n Front Plate Connection to Web/Flange (2320) ,
n Front Plate Connection to Web, Double-sided (2322),
n Front Plate Connection to Flange (2330),
n Column Connection, Frame Corner (2203) and
n Column Connection, Frame Corner (2204).
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Clearance for stiffeners
When inserting stiffeners, the height of the full stiffener is rounded down to whole millimetres. The clearance is
automatically adjusted.

This applies to the following design variants:

n Stiffener (2401)

n Purlin Joint - 1 Girder/1 Purlin (3206),

n Front Plate Connection to Flange (2330),

n Strap Joint (2310),

n Beam to Web with 2 Plates and Stiffener (1211),

n Column Connection, Frame Corner (2203) and

n Column Connection, Frame Corner (2204).

This is indicated by an info symbol in the dialogues for these variants.
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Major Release 2024 (V 2900)

Insert new beam

The function Insert new beam has been extended:

n When inserting beams along a guideline, it is now also possible to process the sketch in the dialogue win-
dow.

n Two sources for inserting beams or profiles are distinguished :

Via catalogue...
With this option you insert beams from the allowed catalogues mentioned above at Semi-finished
products or Factory standards.
Prototype beam...
With this option you can insert configurable prototype beams.

n Beam and profiles from the catalogues Factory standards > Series and Factory standards > Factory
beams can now also be inserted.
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Connections

New connection - Gusset plate (2510)
In the Civil Engineering functions docking window the new design variant Gusset plate (2510) is available at
Steel Engineering > Connections > Web/flange to web/flange.

With this new design variant, any beam/profile can be connected with one to three beams/profiles by means of
a gusset plate connection - as it often occurs in hall construction.
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The beams/profiles to be connected must fulfil the following criteria:

n The beams/profiles must be of the type steel pipe, hollow profile, L-beam, round or flat steel.

n In the case of hollow sections, steel pipes and round steels, the X-axes of the beams/profiles must lie in
one plane. This plane must intersect the connecting beam/profile at a planar facet and be parallel to the X-
axis of the connecting beam/profile.

n Flat steels and L-beams must have at least one common plane in which the gusset plate can lie.

n If more than one beam/profile is connected, all beams/profiles to be connected must be of the same type.
This means that the beams/profiles must be

l all flat steels or
l all L-beams or
l a mix of steel pipes, hollow profiles and round steels.
The connection of an L-beam and a steel pipe, for example, is not possible.

The connection consists of a gusset plate, the connection plates between gusset plate and the beam/profile to
be connected and - optionally - the bolting between gusset plate and connection plate. Gusset plates are steel
plates, the connecting plates can be of the flat steel or steel plate type.

Gusset plate connection with three steel pipes
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Gusset plate connection with two steel pipes and one hollow profile

If the beam/profile to be connected is of the flat steel or L-beam type, then no connecting plates will be
created.
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Connection of a flat steel profile
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Frame corners - placement points for stiffeners
The Frame corner 2203 connection has been extended with placement points for the stiffeners on the 2nd
beam. The stiffeners are installed relative to the selected placement point. Possible placement points are:
n Web of the connecting beam (1)
n Flange of the connecting beam (2).

The Stiffeners tab has been extended accordingly.
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This extension also applies to Frame corner 2204.
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Beam to web, with 2 plates + stiffener - Filler plates
The Design variant Girder connction beam to web, with 2 plates + stiffener (1211) now supports the install-
ation of filler plates between the face plate and the 2nd plate, i.e. the plate on the beam to be connected. For
this purpose, the dialogue window has been extended by the Filler plates tab.

Girder connection, filler plate not pre-planned
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Cross-bracing (2601) with turnbuckle and blade screws
With this Design variant, the cross-bracing can now also be installed with a turnbuckle according to DIN 1480
SP.
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For this purpose, the Fixing tab has been extended accordingly.
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You define the mounting of the turnbuckle to the bracing members on the Semi-finished products tab.
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Cross-bracing without gusset plates and connecting plates
If for the connections Cross-bracing (2601) and Cross-bracing (2602) on the tab Connecting points for the
connection point the option

Point (as intersection point of axes)

is selected for the connecting point on the tab Connecting points, the insertion at the corresponding end can
now also be carried out without gusset plates and connecting plates. To do this, activate the checkbox Con-
necting point without plates. For example, you can subsequently generate a Gusset plate (2510) connection
at these free ends or install a connection manually.
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(1) Cross-bracing without plates at connection A, (2) subsequently inserted gusset plate

Base plate + Anchor plate (2101)
For fastening the anchor plate with screw bolts, it is now also possible to select screw bolts according to DIN
976-1A and 1B.
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Connections- Galvanization holes on beam
In the settings for the galvanisation holes on the beam, the Y-distance of the holes now refers to the fillet on
the beam and not to the flange as before. This affects the following connections:
n Base plate + Anchor plate (2101),
n End plate (2102),
n Purlin joint, 2 plates with m itre cut acc. to DAST IH (2201) and
n Beam to web, with 2 plates + stiffener (1211).
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Civil Engineering - Part type catalogue 3-D
The function Civil Engineering - Part type catalogue > 3-D in the Civil Engineering functions docking win-
dow at Steel Engineering > Civil Engineering, general contains functions that have been replaced by new
developments in the meantime and are therefore no longer needed.

In a first step, the entries under

n Sheet Metal Processing,

n Mechanical constructions,

n Metal Engineering / Facade Engineering and

n Steel Engineering

have been removed. However, the structure of the part type catalogue will be retained for the time being so
that customer-specific catalogue entries in the above-mentioned areas can continue to be used after a HiCAD
update.
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Unbending multi-part standard beams

The function Unbend beam has been changed for multi-part beams. Previously, when a sub-beam was
selected, only this beam was processed. As of HiCAD 2024, the entire multi-part beam is processed.

An example:

In the image below, the series beam ISD Handrail has been moved along a sketch (1). This has created a
multi-part beam. Subsequently, the Unbend beam function was called and the upper sub-beam (2) was selec-
ted. (3) shows the result before HiCAD 2024, (4) the current result.
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Parameter configuration
The default settings of the standard template for Steel / Metal Engineering have changed with HiCAD 2024.
This affects the settings at Modelling > Part properties in the Configuration Editor.

The default setting of the parameters indicated in the image below was previously Always.

The default template can be selected either during installation or subsequently with the tool ParKon-
figComp.exe (or ParKonfigUser.exe).

Feature when inserting Rectangular plates

In the dialogue window of the Rectangular plate function, the Feature checkbox is no longer available
as of HiCAD 2024. This means that a corresponding feature is now always generated when plates are created.
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Railing Configurator

Post connection top, with galvanising hole

If the Post connection, top variant is selected for fastening the railing posts to the beam, then as of HiCAD
2024 the base plate can be provided with a galvanising hole. The Post - Sub-structure tab has been extended
for this purpose.
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(1) without, (2) with galvanising hole
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Infill with bottom cross-member - Insert filling rods
For infills with bottom cross-members it is now also possible to insert the filling rods in handrail or cross-mem-
ber. Two new variants are available for this purpose:

n Insert in handrail and

n Insert in cross-member.
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Filling rod, inserted in handrail
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Post-Handrail - Wall console (prefabricated part)
The variant Wall console (prefabricated part) has been replaced by a new variant in which the screws and
threads for mounting to the handrail can now also be installed.

The following has been preset for the bores on the prefabricated element:
n Bores for handrail mounting: Countersink DIN 66, size 5
n Bores for wall mounting: Countersink DIN 74-1 F, size 6

If you want to preset other drillings, you can do this by changing the table Factory standards >
Purchased/Factory standard parts > Railing > Wall consoles > Prefabricated brackets (RAILING_
BRACKET_29_ISD.IPT). There you have to change the columns
n CS_CAT_ITEM (Bore for handrail mounting) and
n W_CAT_ITEM (Bore for wall mounting)

accordingly.
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The first value in each case is the table ID, the second value is the ID of the corresponding data record. The
two values are separated by a colon. For example, 2724:7 stands for the table DIN 66 at Processings, gen-
eral > Processing> Countersink and the data record with the ID 7. If you double-click with the cursor in one of
the columns, you can directly select the desired table and data record.
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Usage for railing segments
In the automatic drawing derivation, the usage RAILINGSEGMENT has been used up to now for the dimen-
sioning of railing segments created by the railing configurator. However, there is often the wish to dimension
the railing segments differently for different railing types, for example, for segments with glass infill or seg-
ments with knee rail infill, etc.

From HiCAD 2024 this is now possible. For this purpose, corresponding usages must be defined and asso-
ciated configurations created whose name contains the expression RAILINGSEGMENT, e.g. GLASS_
RAILINGSEGMENT or KNEEL_RAILINGSEGMENT.

Proceed as follows:

1. You define the desired usages with the Catalogue Editor at Factory standards > Usage > Civil Engin-
eering > Steel Engineering > Railing, e.g.

2. In the Configuration Manager, you derive the new usages GLAS_RAILINGSEGMENT and KNIE_
RAILINGSEGMENT from the usage RAILINGSEGMENT, for example, at Automatic drawing derivation >
Production drawing > Usage-dependent. (The names must correspond to the entry in the CONFIGKEY
column of the above table in the Catalogue Editor). To derive, right-click on Template and select Derive
structure. Instead of _MASTER_, enter the name of the new usage, e.g. GLAS_RAILINGSEGMENT, activ-
ate the checkbox Copy values and select RAILINGSEGMENT as the template.

3. With OK, the new usage is created.
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4. The new usages must now be assigned. To do this, open the entry Usage assignment, activate a row in
the Railing area and click on New. A new rowis created. In the column, select the name of the usage in the
selection list, e.g. Railing segment Glass, in the second column the part type and in the third column the
name of the template, e.g. GLAS_RAILINGSEGMENT.Now you can define the dimensioning rules for the
new types of use in HiCAD with the dimensioning rule editor. To do this, open the corresponding tem-
plates, e.g. GLAS_RAILINGSEGMENT, adjust the dimensioning rules accordingly and save the tem-
plate..
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During automatic drawing derivation, these templates are then taken into account for the railing segments
to which you have assigned the corresponding usage, e.g.

A simple example:

Based on the above procedure, two new usages Railing segment Glass and Railing segment Knee as well
as the corresponding templates GLAS_RAILINGSEGMENT and KNIE_RAILINGSSEGMENT have been
defined. The dimensioning rule sets of these templates were changed and differed.

The example construction contains two railing segments - one with knee rails and one with a glass infill. The
corresponding new usages were assigned to these segments.
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Example of an automatic drawing derivation

.
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Extension of the BOM template for Steel Engineering
The Excel BOM template for Steel Engineering, HiCAD_Stahlbau.DE.2900.0.xlsx, has been extended. An
additional sheet Profile structure list is now available. On this sheet, the parts/beams/profiles of the same
type are combined and output in a structure list. The profile structure list is a mixture of structure and total pro-
files list and is ideal for combining steel engineering and profile installation, e.g. for hall construction and indus-
trial facades.

Also new is the Excel sheet Steel plates and metal sheets with image:
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User-defined tables with Steel Engineering plates
At Factory standards > User-defined semi-finished products > User-defined plates you now have the pos-
sibility to create tables with your own steel plates. These tables are then also offered for selection via the func-

tion Steel Engineering > Plate, new > Rectangular plate .

Simply copy a suitable table from the catalogue Semi-finished products > Plates into the catalogue Factory
standards > User-defined semi-finished products > User-defined plates and edit it.
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Drawing Management

Service Pack 2 2024 (V 2902)

Automatic itemisation by part groups with prefix

Since SP1, an item prefix can be defined for each part group in the parameter settings for Itemisation ,
provided that the generation of item texts is activated on the General tab. A part is then only uniquely identified
by item prefix + item number. In this case, the parts are not only differentiated according to the item number as
a number, but the item prefix is also taken into account during itemisation. This means, for example, that an
assembly and a beam can have the same item numbers but different prefixes.

Previously, automatic itemisation by part group with prefix was not supported by the drawing management. As
of SP2, this is now possible.

Attribute DOKUART (Document type) and HicadBIMConfig.exe
To ensure that the database with Drawing Management works error-free, all attributes and links required for
drawing management must be available there. This is ensured by the HiCADBIMConfig.exe programme in the
HiCAD exe directory.

Previously, the manual user definitions of the HELiOS attribute DOKUART were overwritten when
HicadBIMConfig.exe was executed. As of SP2, this attribute is defined as an attribute of type Suggestion list
when HicadBIMConfig.exe is executed, so that the manual definitions are retained when the programme is
executed again.
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Service Pack 1 2024 (V 2901)

Documents for general files
Previously, only the active sheet was taken into account when creating external documents, such as PDF files.
From SP1, this can also be done for all sheets. For this purpose, the Configuration Editor at PDM > Drawing
Management > External production documents has been expanded to include the following settings:

n Creation of external documents
This parameter determines whether external documents are to be created for the active sheet only or for
all sheets. The default setting is Active sheet.

n HELiOS attribute for HiCAD sheet names
Here you specify which HELiOS attribute the HiCAD sheet name should be assigned to. The HELiOS
attribute BENENNUNG (Designation) is preset.

Two new document attributes are also available in this context:

n HICADDOKUART
When creating external documents, e.g. PDF files, the identification of the document, e.g. as a PDF file, is
assigned to the HELiOS attribute DOKUART. The DOKUART attribute of the drawing from which the
external documents are derived is assigned to the HICADDOKUART attribute of the external documents,
e.g.:

n HICADPROJNUMMER
This attribute is assigned the project of the HiCAD document..

If the new attributes are to be displayed in title blocks or in the HELiOS results lists, you must adjust them
manually.
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Managing general 3-D parts via part filter
In the Configuration Editor at PDM > Drawing Management, you can set whether general 3-D parts should
also be taken into account when managing drawings. With SP1, the new option Via filter is available here.

With this setting, only the general 3-D parts that meet the part filters defined in the Favourites file Steel Engin-
eering > Drawing Management > General parts (BIM-3DPartFilter.xml) are taken into account.

The preset part filters can be customized using the Find function (in the transparent toolbar).

ISD default setting for general parts in the Drawing Management

What's new? 233 / 370

News Overview

../Konfiguration/bim_config.htm
../../../hicadbasics/Content/Grundlagen/Bedienung/Bedienung7_tb.htm


If, for example, you also want individual standard parts and standard part groups to be taken into account,
open the Favourites file Steel Engineering > Drawing Management > General parts as shown above and
change the file accordingly.

Then save the modified Favourites file under the same name.

Simplified handling when referencing in project structures
When working with referenced detail drawings, project structures are often used, i.e. main projects and sub-
projects. This has been simplified with SP1. The project of the article master is now automatically entered as
the project of the documents.

This affects the functions under Reference part, Save, Detail drawing in the context menu of assem-
blies.
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Major Release 2024 (V 2900)

Remove parts from production drawings
Instead of detailed drawings, overview drawings are often created in practice, which contain, for example, all
the beams or plates used in the model. If the initial model is changed, then existing overview drawings can be
updated, but the subsequent creation of a detail drawing for a beam or plate shown in the overview is not dir-
ectly possible. Sometimes, however, it is desired to remove certain parts from the overview drawing and cre-
ate a detail drawing afterwards. In this case the function Remove active part list from production drawing
provides a remedy.

Proceed as follows:

n Load the overview drawing and select the parts to be removed from the overview in the model view of this
drawing.

n Call up the function Remove active part list from production drawing. The parts are removed from the
overview.

n Save and close the drawing.

n

If you then call the Drawing or Manual settings function in the original drawing, the parts
deleted from the overview have the link class Without drawing.

The function Remove - Active part list can only be called up if a corresponding overview draw-
ing is open.
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Processing sheet metal developments in production drawings
When working with sheets without using the Drawing Management, the sheet development can be processed
without changing the original sheet. This was previously not possible in the Drawing Management, i.e. devel-
opments in the production drawing were blocked for editing. From HiCAD 2024 this is now supported. For this
purpose, the new parameter Allow processing of sheet developments is available in the Configuration Editor
at PDM > Drawing derivation > Production drawings. The default setting is No.

If the setting is set to Yes, then you have the option of subsequently processing the development in the pro-
duction drawing, for example, filleting or chamfering sheet edges etc. or inserting holes. The original model in
the model drawing remains unchanged.

If the parameter is set to Yes, external part data in DXF format for sheet metal parts cannot be created
automatically. This means: If the configuration parameter Create DXF data under External part data
(PDM > Drawing Management > External production documents...) is set to Yes, it is not evaluated. In
this case, the message shown appears when HiCAD is started.
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Releasing assemblies with already released parts
If an assembly contains sub-parts whose drawings have already been released, then as of HiCAD 2024 the
drawings of these parts are no longer loaded in the background when the assembly is released. This leads to a
performance increase.

Automatic BOMs for itemised source models
Excel BOMs can now be created and managed automatically for model drawings that are itemised source
models. For this purpose, the settings in the Configuration Editor at PDM > Drawing Management > External
production documents have been extended.

Create
BOMs

This setting determines whether or not Excel BOMs should be automatically generated
for certain model drawings.

The following settings are possible:

n None
Excel BOMs are not generated automatically. This is the default setting.

n Upon Checkup and Release
The Excel BOMs are created automatically when checking and releasing drawings.

n Upon creation and update
The Excel BOMs are created automatically when creating and updating drawings.

n Automatically upon Release
The Excel BOMs are created automatically upon release of drawings.

List of model
drawings
with external
BOM

Here you define for which drawings external BOMs are to be created and managed. At
present, this is only possible for itemised source models, i.e. for the model drawings in
which the parts are itemised (see document attribute ITEMISATIONMODEL).

In HELiOS, the generated BOMs (Document type Others) are stored in the Bills of Materials subfolder of the
respective project, e.g.
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When saving the itemised source model, these BOMs are automatically updated.

Please note:

n The templates HiCAD-DB_Stahlbau_BIM.DE.2900.0.xlsx and HiCAD-DB_Stahlbau_BIM.rm_settings are
used for BOM creation.

n For parts managed with the Drawing Management, the HiCAD attribute Item text $INTXT is assigned the
HELiOS attribute COMPONENT_ITEMNR_TEXT. For external parts / standard parts, the HiCAD attribute
$INXT is assigned the item number of the part..

Updating manually created production drawings
Production drawings that are created manually with the function Drawing Management > Workshop > Draw-

ing > Manual settings can now also be updated with this function when changes are made in the

model drawing. Previously, the Drawing Management > Workshop > Drawing function had to be used
for this.
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Metal Engineering
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Multiple selection of items when importing from LogiKal to HiCAD

When importing several LogiKal items to HiCAD via Import > Several facades+inserts , a new selec-
tion dialogue appears.

Please note:

In earlier HiCAD versions the function call was called All facades+inserts. This imported all positions of a
selected LogiKal project without de-/selection options.

Replacing individual profiles

Previously the function Process > Exchange via LogiKal, with facade profile only applied to multi-part

facade engineering profiles that were installed via the function New > Insert facade profile .
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With HiCAD 2024 this has been extended to single profiles whose installation was done via New > Individual

beam/profile or New > Window/door profile .

Extended transfer of LogiKal attributes
The attribute mapping between HiCAD and LogiKal, which you can specify via the Configuration Editor, has
been extended by the Text attributes [Profile] Colour and [Glass] Name and by the Integer attributes [Pos-
ition] Quantity and [Insertion] escape door function.

Note on Integer attributes:

As with Double number attributes, integer number attributes are not transmitted if the value coming from
LogiKal cannot be converted into a number. I.e.: If the value of the piece count item attribute should not be
transferred as an integer from LogiKal for some reason (e.g. "0.5"), then no attribute value will be transferred to
HiCAD in this case.

Note on "[Insertion] Escape door function":

Three LogiKal escape door attributes are checked for determination. If one of the three LogiKal attributes says
"Escape door = yes", the configured HiCAD (Integer) attribute is set to "1". If all three LogiKal attributes state
"Escape door=No", then the HiCAD attribute is set to "0".

Facade/insert with sketch: Sketch on upper glass edge
A behavioural optimisation of the HiCAD/ LogiKal interaction concerns the function Metal Engineering > New

> Sketch (Facade/insert with sketch) :

When using with sketch, the sketch is transformed to the position of the upper glass edge.
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Civil Engineering - Part type catalogue, 3-D
The function Civil Engineering - Part Type Catalogue > 3-D in the Civil Engineering functionsdocking win-
dow under Civil Engineering, general contains functions that have been replaced by new developments in the
meantime and are therefore no longer needed.

In the first step, therefore, the entries under

n Sheet Metal construction,

n Mechanical construction,

n Metal Engineering/Facade Engineering and

n Steel Engineering

have been removed. However, the structure of the part type catalogue is retained for the time being so that cus-
tomer-specific catalogue entries in the above-mentioned areas can continue to be used after a HiCAD update.

242 / 370 What's new?

Metal Engineering



Layout Planning

Service Pack 2 2024 (V 2902)

New connection for ALUCOBOND SZ 20
There is a new option in the Connection, top list box for the ALUCOBOND Tray panel SZ 20. You can now cre-
ate a Z-profile as a folded sheet for the window connection.

Top connection: Window with profile

What's new? 243 / 370

News Overview

../elementverlegung/el_verleg_alucobond_sz20.htm


Fastening for ALUCOBOND Tray panel SZ 20
The bores in the Z-profiles of ALUCOBOND Tray panel SZ 20 for fastening to the substructure are now option-
ally adjustable. This is useful, for example, if the bore is carried out on site. In the Extended settings for the Z-
profiles of the ALUCOBOND Tray panel SZ 20 (with accessories), the option Create bores for sub-structure
can now be deactivated.

(1) Without bores for the sub-structure, (2) With bores for the sub-structure
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Service Pack 1 2024 (V 2901)

Wall bracket usage for parts without a steel engineering axis
The Wall bracket usage function is now also available for parts that do not have a steel engineering axis. For
these parts, the axis must be explicitly defined in the dialogue window using two points.

The dialogue windows for beams and sheets or other parts without a steel engineering axis are therefore dif-
ferent.

Creating your own sheets is essentially the same as creating your own beams and profiles. However, there is
a difference when using wall brackets. Here, for parts that do not have a steel engineering axis, an axis must
be defined via two points, which is then used in the Wall bracket function in the same way as the steel engin-
eering axis.
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In the image below, a sheet has been created along a parameterised sketch. The variable i_ l has been
assigned to the sheet.

The Fitting coordinate system has then been defined using points (1), (2) and (3).
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The wall bracket utilisation was then defined as shown using points (1) to (4).

The sheet was then saved in the Factory standards > Installation planning - Parts and Processings > Sub-
structure > Installation elements > ISD Example catalogue.

The image below shows a sub-structure with the sheet created above and wall brackets.
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Change of the structure in the docking window
In the Civil Engineering functions docking window, the functions for the Element installation, the Sub-struc-
ture and the Wall brackets have been combined and restructured under the new entry Layout planning.

The Design Variants Flange for SZ20 and SZ20 Base point with projection can now also be found here.

Annotating installation elements
New in the Civil Engineering functions docking window at Layout planning > Annotation is the function
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Element numbering.

With this function, the installation elements of an element installation can be annotated automatically, e.g. for
overview drawings.

Numbering by levels

If this checkbox is activated, the numbering will be done per "level", always from the first element at the bottom
left to the last element. The Y-axis determines the level direction. If the checkbox is deactivated, numbering
will be done consecutively.

Automatic

With automatic numbering, the XY-plane of the active coordinate system determines the numbering sequence
(first in X-direction, then in Y-direction).

Manual

Here you simply select the elements to be numbered with a mouse click.

The content of the numbering is controlled by the following annotation templates:

n EINumbering_PerLevel.ftd (for numbering by levels)
{Level of element installation numbering (part attribute)}-{Running number of element installation num-
bering (part attribute)}

n EINumbering_Consecutive.ftd (for consecutive numbering)
{Consecutive number of element installation numbering (part attribute)}

As with the other HiCAD annotation templates, the files can be individually configured if required, e.g. with the
HiCAD Annotation Editor. The files are located in the HiCAD sys directory.
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Example:

Left: Numbering by levels, Right: Consecutive numbering.

It will not be checked whether the numbered elements are identical.
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Profile Installation

Service Pack 2 2024 (V 2902)

New attributes for sandwich panels
When installing sandwich panels from the catalogue, you can now access new system attributes. The system
attributes are assigned to the contents of the corresponding columns in the catalogue.You can find the cata-
logues for sandwich panels at Factory standards > Series > Roof Wall Facade > Room-closing profiles,

Attribute Description Catalogue column
DWF_T_OUT Thickness of outer shell THICKNESS_OUTSIDE

DWF_T_IN Thickness of inner shell THICKNESS_INSIDE

DWF_T_CORE Core thickness CORE_THICKNESS

DWF_CORE_MAT Core material CORE_MATERIAL

Profile images in the packaging list
In addition to the usual bills of materials, packaging lists can also be automatically generated in Excel from a
profile relocation. As of HiCAD SP2, these packaging lists show the cross-section of the profiles of the respect-
ive package. The designation A and B on the cross-section stands for the positive and negative position

respectively. You must create the packages beforehand using the Packaging function. A packaging list
is only generated if at least one package has been defined.

Displayed cross-sections of packaged profiles in Excel
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ROMA profiles
As of SP2, panels from the company Romakowski GmbH & Co. KG are now also available for profile install-
ation at Factory standards > Series > Roof Wall Facade > Room-closing profiles > Romakowski.
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Licensing
As of HiCAD 2024 SP1, the HiCAD Extension Module Profile installation contains the functions

n Save sub-structure and

n Variant for sub-structure.
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Additional column in Packaging dialogue
There is now an additional column for a user-specific attribute in the Packaging dialogue. This attribute must
be set in the Configuration Editor at Profile installation > Packaging > User-specific attribute.

Attribute Comment ($03) set in the Configuration Editor.If you activate the Attribute field for a package by double-clicking

on it and then enter a comment, this will be transferred to the part attributes of all parts that belong to the package.
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Rename openings

When creating or changing in the Profile installation dialogue, you can now edit the naming on the
Openings tab. By double-clicking in the field of the Opening 1, 2, ... the name can be overwritten. This name is
displayed in the preview.
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Major Release 2024 (V 2900)

Preset default values for joint width towards sketch line
The joint width towards the sketch line can also be preset in the tables at Factory standards > Installation
Planning - Parts and Processings > Profile Installation > Inserts.

To do this, add the table columns GAPMODE and GAPDEFAULT to the tables.

Column Data type

GAPDEFAULT* Floating
point value

The desired value for the joint width is entered here. If this value is
to be activated as a default, the column GAPMODEmust be set to
1. If the corresponding installation element is then selected in
HiCAD as insert element of the profile installation, the value for the
joint width is automatically set to the value entered in the column
GAPDEFAULT.

GAPMODE* Integer The value entered here can be 0, 1 or 2.

0 The default value from the GAPDEFAULT column is
deactivated. The internal HiCAD default value is used
instead.

1 The value specified in the GAPDEFAULT column is
used as the default value.

2 No default value is used, i.e. 0 is preset for the joint
width.

* only for own installation elements and installation elements predefined by the ISD

Example:
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Enhancements for Coating
When coating profiles (sandwich profiles), you can now use different colours for the outside and inside. The
negative layer no longer affects the coating, i.e. the outer sheet always receives the outer colour. Attributes are
set for both coating colours and transferred to the bill of materials.

(1) Inside, (2) Outside, (3) Settings in the Other properties tab of the Profile Installation function
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Coating of one-piece profiles

One-piece profiles (corrugated and trapezoidal profiles) can now be coated on both sides. If you select only
one colour, the profile is also coloured in the graphic. If it is coated on both sides, only the attributes are set
and transferred to the BOM.

(1) One-piece profile coated on both sides,

(2) One-piece profile coated on one side,

(3) Coating in the BOM
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Negative and positive position and identical part search
The negative and positive position of the profiles is a differentiation criterion for the same-part detection during
dispatch itemisation. If the value of the attribute DWF_NEG_INSTALL is set to 0, the profile is in a positive pos-
ition and if it is set to 1, it is in a negative position. In configuration management, it is entered as a dis-
tinguishing criterion for dispatch itemisation under Profile Installation > Dispatch itemisation > Integer
attributes and is evaluated if the setting Carry out dispatch itemisation is also activated here.

The attribute is not applied to profile installations prior to HiCAD 2024, not even when recalculating the feature.
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Plant Engineering

Service Pack 2 2024 (V 2902)

SIKLA clamps
The range of available parts has been expanded in SP2 to include additional variants for pipe clamps from
SIKLA.

The variants can be found in the list file sikla_pipe_supports.lst. It contains the following variants:

File Designation Type

LA-HV-150.VAA Loose bearing LA-HV-150 Pipe clamp

LA-HV-200.VAA Loose bearing LA-HV-200 Pipe clamp

LA-HV-90.VAA Loose bearing LA-HV-90 Pipe clamp

LC-HV-150.VAA Loose bearing LC-HV-150 Pipe clamp

LC-HV-200.VAA Loose bearing LC-HV-150 Pipe clamp

LC-HV-90.VAA Loose bearing LC-HV-90 Pipe clamp

LD-HV-150.VAA Loose bearing LD-HV-150 Pipe clamp

LD-HV-200.VAA Loose bearing LD-HV-200 Pipe clamp

LD-HV-90.VAA Loose bearing LD-HV-90 Pipe clamp

LK-HV-150.VAA Loose bearing LK-HV-150 Pipe clamp
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The fastenings of the clamps are modelled as sub-parts so that you have the option of subsequently adjusting
their position.
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Support type and support type symbols for pipe clamps
The Pipe clamp support type attribute - attribute name PIPE_SUPPORT_TYPE - can be assigned to pipe
clamps using the Part attributes function. By assigning this attribute, different pipe support types can be dis-
played in ROHR2.

Three additional support types are available in the Part attributes mask as of SP2:
n Rigid hanger,
n Spring hanger and
n Spring support.

In addition, the entries now also show the ROHR2 abbreviations so that you can assign them more easily.

Furthermore, from SP2 it is possible to define support type-dependent symbols to be used for visualisation in
an isometric drawing.
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If a support type has been assigned to a pipe clamp and a symbol has been assigned to this support type, the
original symbolic representation of the pipe clampin the isometric drawing is replaced by the symbol of the sup-
port type.

The symbols for the support types can be found in the PlantParts\Symbols\PipeSupport sub-folder.

In the same directory you will find the file support_type_symbols.txt, which makes the assignment between
the support types and the symbols. The file uses the abbreviations known from ROHR2 for the support types.
A symbol is assigned using a line of the form

Abbreviation="filename without extension"

Example:

FP="fixed_point"

This means that the symbol fixed_point.FGA is assigned to the support type FP.
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DBPlantDataImport - Attribute initialisation
The DbPlantDataImport.exe program is the central tool for updating the HELiOS database to the content
required for the current version of HiCAD in the Plant Engineering module. DBPlantDataImport can be used
to preset attribute values for articles and documents. These initializations are used when synchronising the
part data with HELiOS in order to assign the attributes of newly created articles and documents.

As of SP2, the attribute values are initialized as shown below.

Initialization, Article - defaults
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Iinitialization, Document - defaults

The initializations are saved in the DbPlantDataImportConfig.xml file in the HiCAD sys directory. The version
of this file included in the scope of delivery from SP2 contains the attribute AddDefaults with the default value
1

<AddDefaults>1</AddDefault>

This setting ensures that the above-mentioned default initializations are inserted. Each time the configuration
is saved, AddDefaults=0 is set so that once saved, the default settings are no longer changed automatically.
By setting AddDefaults=1 again, the default initializations can be added again, e.g. after deleting the ISD ini-
tialization.
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Isometry and pipe spool drawing

Angles in the rise triangles
As of SP2, the rise angles can be drawn into the rise triangles of an isometry. For this purpose, the Automatic
dimensioning tab in the isometric settings has been expanded to include the Dimension rise angles checkbox
for horizontal and vertical rise triangles.

The following image shows a vertical rise triangle with angle dimension.
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Recolour pipe part symbols
The colour of the symbolic representation in the isometry is defined when a pipe part is inserted. The cor-
responding Plant Engineering Settings on the Part insertion tab are taken into account in the process.
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Sometimes, however, it only becomes apparent later that the colour or line type of the symbolic rep-
resentations should be changed. Particularly when printing, there is often a desire to differentiate the pipework
from other drawing elements - such as dimensions - in the visualisation. Previously, the colour of the symbols
had to be laboriously adjusted by hand. As of SP2, this is now possible in a single step with the Recolour pipe

part symbols function. To do this, the 3-D edge parameters window is opened after calling up the
function. Immediately after selecting the desired parameters, they change colour in the isometry.

Please note:

n In particular, symbols such as weld seams, flow symbols or even indicated parts are not recoloured.
Dimensionings and rise triangles also retain their colour.

n The function is a post-processing step. This means that the colour is only changed for the current isometry.
In particular, the colour is reset to the original colour when the isometry is regenerated.

n As only one crosshairs and one north arrow are generated, you may need to move both figures on the
sheet using the 2-D part > Transform > Move > Move part, free (2-D) function.
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Create pipe spool drawing from pipe spool drawing
The Pipe spool drawing context menu, which you activate by right-clicking on a pipe in the pipe spool drawing,
has been expanded to include the From new part selection function. Previously, this option was only available
in the Multiple selection context menu.

It is now possible, for example, to create pipe spool drawings for individual pipes or pipe sections directly from
an overall pipe spool drawing.
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Service Pack 1 2024 (V 2901)

Length of inserted pipes
Previously, the length of inserted pipes was always calculated up to the center of the pipe into which it was
inserted. As of SP1, the length is now calculated correctly. This also applies to the isometry and the pipe spool
drawing.
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Knee - Horizontal bending direction (VEERING_RESTRICTION)
The new HELiOS attribute VEERING_ RESTRICTION complements the already existing attributes
BENDING_RESTRICTION (bending direction) and PLANE_RESTRICTION (bending plane) in that also with
VEERING_RESTRICTION the route of a guideline can influence the part search.

To make this attribute available in your HELiOS database as well, you may have to update HELiOS for Plant
Engineering before. To do this, use the DbPlantDataImport.exe tool.

The VEERING_RESTRICTION attribute knows the following values:

0 no restriction, treated like regular knee; in this case, however, the attribute should simply be left
unassigned, which has the same meaning. Not used in search conditions.

1 only allowed to the right

2 only allowed to the left

3 symmetrical; allowed to the left or right

The only part type whose insertion is affected by the attribute is the Knee.

Example - VEERING_RESTRICTION

In the following example, a simple composite edge has been automatically assigned two knees. The flow dir-
ection is from left to right.

When searching for a suitable knee for bends to the left, HiCAD adds the following condition to the HELiOS
search:

VEERING_RESTRICTION = ''\'3*'\'2*''

This means that only parts that do not have VEERING_RESTRICTION, are symmetrical or bend to the left will
be found.

In the above example, the yellow knee was found and fitted.

When searching for a suitable knee for bends to the right, the following condition was added to the HELiOS
search:

VEERING_RESTRICTION = ''\'3*'\'1*''
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This means that only parts that do not have VEERING_RESTRICTION, are symmetric or bend to the right will
be found.

In the above example, the green knee was found and installed.

For symmetrical parts, one would like to be able to additionally express that these can be used for both left
and right bends, which at the same time implies that these parts may also be installed against the flow dir-
ection (namely for left bends).

In the following example, the same composite edge has been fitted with a part whose VEERING_
RESTRICTION has the value 3:

Note that for the bend to the left the order of the connection points is switched , so the part was installed
against the flow direction running from left to right.

To use a custom variant with VEERING_RESTRICTION, this attribute must be assigned in the VAA file. The
knees follow the usual design guidelines for knees. For the above examples, the variants look as follows:

272 / 370 What's new?

Plant Engineering



Presettings for article attributes in the Configuration Editor
The MATERIAL, SURFACE AREA, WEIGHT and VOLUME attributes were previously considered fixed by
pipeline planning, although they have been separately definable in the Configuration Editor for some time. As
of Service Pack 1, these specifications are now taken into account.

However, a special feature applies to variants, which must of course work for all settings in the Configuration
Editor. Therefore, material, surface area, weight and volume will still be assigned to the MATERIAL,
SURFACE AREA, WEIGHT and VOLUME attributes in variants. During part data synchronization, however,
these four attributes are then mapped to the attributes defined in the Configuration Editor.
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Automatic checking of nominal diameters, pipe lengths and part structure
In addition to checking nominal diameters, pipe lengths and pipeline structure with the functions at Plant Engin-
eering > Pipeline Tools > Coll... HiCAD also offers the possibility to perform these checks automatically when
loading and saving layout plans or when switching from a P+ID to the layout plan. Previously, this could be
defined in the Plant Engineering settings under Actions during Load/Save. As of SP1, this tab is no longer
available. Instead, the parameter Checks the entire drawing is available in the Configuration Editor at Plant
Engineering > Plant Engineering drawing check.

If this checkbox is active, HiCAD automatically performs the following checks during load/save:

n Nominal diameter matings 
Here it is checked whether only parts with matching nominal diameters are connected with each other in
the layout plan.

n Pipe lengths
It is checked whether inadmissible pipe length changes have been made in the layout plan.

n Structure of the pipelines
The part structure of all pipelines is checked here.
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If errors occur during the check, they are displayed in a results list, e.g.

If you click on one of the errors in the list, the corresponding location in the layout plan is marked accordingly.
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Changes/enhancements for pipe part insertion

Additional part information

The tab that is displayed with the Pipe parts function after selecting a part has been extended. Addi-
tional information about the selected part is now displayed here, e.g.
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Clicking this button inserts a new row in the attribute list after the current line. Using the selec-
tion box of the row, you can then select the attribute to be displayed.

To change the attribute display of a row, simply select the desired attribute in the selection box.

A click on this button deletes the current row of the attribute list..

Clicking this button restores the default state of the attribute list..
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Undo/Redo
As of Service Pack 1, the Undo and Redo functions of the transparent toolbar or the quick access toolbar can

be used within the Pipe parts function after a part has been inserted.
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Free point selection
The context menu for defining the insertion position has been extended.

The Show part option for freely positioning the part at an individual point has been added. For this purpose, a
preview of the part is displayed where you can select any point.

After selecting the point, the part is attached to the cursor at the corresponding position and can be freely posi-
tioned in space.
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Another option is to select any point and then select an edge for positioning. Then the cursor is attached to the
selected point of the part. This is projected onto the edge, so you can align the part to the selected point on the
edge.

280 / 370 What's new?

Plant Engineering



Revised "Set all" option

In the Part insertion dialogue window, the checkbox In all similar places has been removed. Instead,
two new options are now available in the Selected part area.

Insert everywhere

This option allows you to automatically insert a part in all similar places. If you have not selec-
ted a part so far, first define the insertion position of the selected part type, e.g.

Then select the desired part after clicking on . If you have already selected and inserted a

part, clicking on will cause the part to be inserted automatically in the other corresponding
places as well.
Example
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Highlight similar places
This symbol is only active if you have already selected a part. All possible insertion positions
are then displayed for this part, so that you can explicitly trigger the insertion at the desired pos-
itions with one click.

A special feature is the insertion of flanges in all places. If no position is individually pre-
marked, counterflanges are matched only with identical flanges. However, flanging can also be
performed at free ends by preselecting a free end.
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Line blanks acc. to DIN2626
The parts inventory has been expanded to include line blanks acc. to DIN 2626. The new parts are divided into
six groups:

DIN2626 TYP A Blind Disk

Variant files:
n DIN2626-TYP_A-BD-PN10.VAA
n DIN2626-TYP_A-BD-PN100.VAA
n DIN2626-TYP_A-BD-PN16.VAA
n DIN2626-TYP_A-BD-PN160.VAA
n DIN2626-TYP_A-BD-PN25.VAA
n DIN2626-TYP_A-BD-PN40.VAA
n DIN2626-TYP_A-BD-PN6.VAA
n DIN2626-TYP_A-BD-PN63.VAA

You can find these variants summarized in the
list file DIN2626-TYP_A-BD.lst.

DIN2626 TYP A Perforated Disk

Variant files:
n DIN2626-TYP_B-PD-PN10.VAA
n DIN2626-TYP_B-PD-PN100.VAA
n DIN2626-TYP_B-PD-PN16.VAA
n DIN2626-TYP_B-PD-PN160.VAA
n DIN2626-TYP_B-PD-PN25.VAA
n DIN2626-TYP_B-PD-PN40.VAA
n DIN2626-TYP_B-PD-PN6.VAA
n DIN2626-TYP_B-PD-PN63.VAA

You can find these variants summarized in the
list file DIN2626-TYP_B-PD.lst.

DIN2626 TYP C Orifice Plate
n DIN2626-TYP_C-OP-PN10.VAA
n DIN2626-TYP_C-OP-PN100.VAA
n DIN2626-TYP_C-OP-PN16.VAA
n DIN2626-TYP_C-OP-PN160.VAA
n DIN2626-TYP_C-OP-PN25.VAA
n DIN2626-TYP_C-OP-PN40.VAA
n DIN2626-TYP_C-OP-PN6.VAA
n DIN2626-TYP_C-OP-PN63.VAA

You can find these variants summarized in the
list file DIN2626-TYP_C-OP.lst.

What's new? 283 / 370

News Overview



DIN2626 TYP D Spectacle Blind As A Figure-8 Blank

Variant files:

DIN2626-TYP_D-SB8B-PN10.VAA

DIN2626-TYP_D-SB8B-PN100.VAA

DIN2626-TYP_D-SB8B-PN16.VAA

DIN2626-TYP_D-SB8B-PN160.VAA

DIN2626-TYP_D-SB8B-PN25.VAA

DIN2626-TYP_D-SB8B-PN40.VAA

DIN2626-TYP_D-SB8B-PN6.VAA

DIN2626-TYP_D-SB8B-PN63.VAA

You can find these variants summarized in the
list file DIN2626-TYP_D-SB8B.lst.

DIN2626 TYP E1 Spectacle Blind As A Rotating Plate

The E1 subtype covers nominal sizes from DN
15 to DN 50.

Variant files:
n DIN2626-TYP_E1-SBRP-PN10.VAA
n DIN2626-TYP_E1-SBRP-PN16.VAA
n DIN2626-TYP_E1-SBRP-PN25.VAA
n DIN2626-TYP_E1-SBRP-PN40.VAA

You can find these variants summarized in the
list file DIN2626-TYP_E1-SBRP.lst.

DIN2626 TYP E2 Spectacle Blind As A Rotating Plate

The E2 subtype covers nominal sizes from DN
65 to DN 200.

Variant files:
n DIN2626-TYP_E2-SBRP-PN10.VAA
n DIN2626-TYP_E2-SBRP-PN16.VAA
n DIN2626-TYP_E2-SBRP-PN25.VAA
n DIN2626-TYP_E2-SBRP-PN40.VAA

You can find these variants summarized in the
list file DIN2626-TYP_E2-SBRP.lst.

284 / 370 What's new?

Plant Engineering



GF Piping Systems

PROGEF
The parts inventory has been extended by parts from the manufacturer standard PROGEF of the supplier
Georg Fischer.
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The parts are summarized in the list file PROGEF.lst. It contains the following variants:

File Designation Type

PROGEF_BEND_45_SDR11.VAA Segment bend 45° SDR 11 Knee

PROGEF_BEND_45_SDR17_6.VAA Segment bend 45° SDR 17.6 Knee

PROGEF_CAP_COUPLER_SDR11.VAA Socket welded end cap SDR 11 Cap

PROGEF_CAP_L_SDR11.VAA Butt welded end cap L SDR 11 Cap

PROGEF_CAP_L_SDR17_6.VAA Butt welded end cap L SDR
17.6

Cap

PROGEF_CAP_SDR11.VAA Butt welded end cap SDR 11 Cap

PROGEF_CAP_SDR17_6.VAA Butt welded end cap SDR 17.6 Cap

PROGEF_COUPLER_FUSION_SDR11.VAA Double socket SDR 11 Other pipe part

PROGEF_COUPLER_REDUCER_FUSION_
SDR11.VAA

Socket welded reducer SDR11 Reducer, con-
centric

PROGEF_DOUBLENIPPLE_FUSION_
SDR11.VAA

Socket welded double nipple
SDR11

Other pipe part

PROGEF_ELBOW_45_FUSION_SDR11.VAA Elbow 45° L SDR 11 socket wel-
ded

Knee

PROGEF_ELBOW_45_L_SDR11.VAA Elbow 45° L SDR 11 Knee

PROGEF_ELBOW_90_FUSION_SDR11.VAA Elbow 90° socket welded
SDR11

Knee

PROGEF_ELBOW_90_SHORT_SDR11.VAA Elbow 90° short SDR11 Knee

PROGEF_ELBOW_SWEEP_90_SDR11.VAA Elbow 90° SDR 11 Knee

PROGEF_PIPE_SDR7_4.VAA PE100-Pressure pipe SDR7.4 Straight pipe

PROGEF_PIPE_SDR11.VAA PE100-Pressure pipe SDR11 Straight pipe

PROGEF_PIPE_SDR17_6.VAA PE100-Pressure pipe SDR17.6 Straight pipe

PROGEF_REDUCER_BW_SDR11.VAA Butt welded reducer SDR 11 Reducer, con-
centric

PROGEF_REDUCER_BW_SDR17_6.VAA Butt-welded reducer SDR 17.6 Reducer, con-
centric

PROGEF_REDUCER_ECCENTRIC_
SDR11.VAA

Butt-welded reducer, eccentric
SDR 11

Reducer, eccent-
ric

PROGEF_REDUCER_SHORT_BW_
SDR11.VAA

Butt welded reducer, short SDR
11

Reducer, con-
centric

PROGEF_REDUCER_SHORT_BW_SDR17_
6.VAA

Butt welded reducer, short SDR
17.6

Reducer, con-
centric

PROGEF_TEE_45_RED_SDR11.VAA T 45° reduced SDR 11 Branch

PROGEF_TEE_45_SDR11.VAA T 45° equal SDR 11 Branch

PROGEF_TEE_FUSION_SDR11.VAA T 90° SDR socket welded SDR
11

T-piece

PROGEF_TEE_L_SDR11.VAA T 90° L SDR 11 T-piece

PROGEF_TEE_L_SDR17_6.VAA T 90° L SDR 17.6 T-piece

PROGEF_TEE_RED_MOLDED_SDR11.VAA T 90° reduced, molded SDR 11 T-piece
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File Designation Type

PROGEF_TEE_RED_MOLDED_SDR17_
6.VAA

T 90° reduced, molded SDR
17.6

T-piece

PROGEF_TEE_RED_REDUCER_SDR11.VAA T 90° butt welded reducer
SDR11

T-piece
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ECOFIT
The parts inventory has been extended by parts from the manufacturer standard ECOFIT of the supplier
Georg Fischer.
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The parts are summarized in the list file ECOFIT.lst It contains the following variants:

File Designation Type

ECOFIT_CAP_SDR11.VAA End cap SDR 11 Cap

ECOFIT_COUPLER_REDUCER_
SDR11.VAA

Socket welded SDR 11 Other pipe part

ECOFIT_DOUBLENIPPLE_SDR17.VAA Double nipple SDR 17 Other pipe part

ECOFIT_ELBOW_11_SDR11.VAA Elbow 11° SDR 11 Knee

ECOFIT_ELBOW_11_SDR17.VAA Elbow 11° SDR 17 Knee

ECOFIT_ELBOW_22_SDR11.VAA Elbow 22° SDR 11 Knee

ECOFIT_ELBOW_22_SDR17.VAA Elbow 22° SDR 17 Knee

ECOFIT_ELBOW_30_SDR11.VAA Elbow 30° SDR 11 Knee

ECOFIT_ELBOW_30_SDR17.VAA Elbow 30° SDR 17 Knee

ECOFIT_ELBOW_45_SDR11.VAA Elbow 45° SDR 11 Knee

ECOFIT_ELBOW_45_SDR17.VAA Elbow 45° SDR 17 Knee

ECOFIT_ELBOW_60_SDR11.VAA Elbow 60° SDR 11 Knee

ECOFIT_ELBOW_60_SDR17.VAA Elbow 60° SDR 17 Knee

ECOFIT_ELBOW_90_SDR11.VAA Elbow 90° SDR 11 Knee

ECOFIT_ELBOW_90_SDR17.VAA Elbow 90° SDR 17 Knee

ECOFIT_ELBOW_SHORT_45_SDR11.VAA Elbow 45° SDR 11, kurz Knee

ECOFIT_ELBOW_SHORT_90_SDR11.VAA Elbow 90° SDR 11, kurz Knee

ECOFIT_INSERT_COMPONENT_
SDR11.VAA

Bolting insert SDR 11 Flange

ECOFIT_INSERT_COMPONENT_
SDR17.VAA

Bolting insert SDR 11 Flange

ECOFIT_LOOSEFLANGE_SDR11.VAA Loose flange, butt welded SDR
11

Flange

ECOFIT_LOOSEFLANGE_SDR17.VAA Loose flange, butt welded SDR
17

Flange

ECOFIT_ORING.VAA O-ring gasket Seal

ECOFIT_PIPE_SDR11.VAA PE100 pressure pipe SDR 11 Straight pipe

ECOFIT_PIPE_SDR17.VAA PE100 pressure pipe SDR 17 Straight pipe

ECOFIT_PIPE_SDR17-FM.VAA PE100 pressure pipe SDR 17,
FM

Straight pipe

ECOFIT_PIPE_SDR41.VAA PE100 pressure pipe SDR 41 Straight pipe

ECOFIT_PIPE_SDR7_4.VAA PE100 pressure pipe SDR 7.4 Straight pipe

ECOFIT_REDUCER_BW_SDR11.VAA Butt welded reducer SDR 11 Reducer, concentric

ECOFIT_REDUCER_BW_SDR17.VAA Butt welded reducer SDR 17 Reducer, concentric

ECOFIT_REDUCER_SHORT_BW_
SDR11.VAA

Butt welded reducer SDR 11,
short

Reducer, concentric

ECOFIT_REDUCER_SHORT_BW_
SDR17.VAA

Butt welded reducer SDR 17,
short

Reducer, concentric
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File Designation Type

ECOFIT_SCREW_FITTING_SDR11.VAA Bolting screw-in part SDR 11 Flange

ECOFIT_SCREW_FITTING_SDR17.VAA Bolting screw-in part SDR 17 Flange

ECOFIT_STUB_FLANGE_A_SDR17.VAA Butt welded collar Type A SDR
17

Flange

ECOFIT_STUB_FLANGE_B_SDR17.VAA Butt welded collar Type B SDR
17

Flange

ECOFIT_TEE_45_SDR11.VAA T 45° equal SDR 11 Branch

ECOFIT_TEE_45_SDR17.VAA T 45° equal SDR 17 Branch

ECOFIT_TEE_RED_45_SDR11.VAA T 45° reduced SDR 11 Branch

ECOFIT_TEE_RED_REDUCER_
SDR11.VAA

T 90° butt welded reducer SDR
11

T-piece

ECOFIT_TEE_RED_REDUCER_
SDR17.VAA

T 90° butt welded reducer SDR
17

T-piece

ECOFIT_TEE_RED_SHORT_SDR11.VAA T 90° reduced SDR 11, short T-piece

ECOFIT_TEE_RED_SHORT_SDR17.VAA T 90° reduced SDR 17, short T-piece

ECOFIT_TEE_SHORT_SDR11.VAA T 90° SDR 11, short T-piece

ECOFIT_TEE_SHORT_SDR17.VAA T 90° SDR 17, short T-piece

ECOFIT_UNION_NUT.VAA Bolting - union nut Fastener, unsym-
metric
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ELGEF
The parts inventory has been extended by parts from the manufacturer standard ECOFIT of the supplier
Georg Fischer.
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The parts are summarized in the list file ELGEF.lst It contains the following variants:

File Designation Type

ELGEF_BEND_45_SDR11.VAA Segment bend 45° SDR 11 Knee

ELGEF_BEND_45_SDR17.VAA Segment bend45° SDR 17 Knee

ELGEF_BEND_60_SDR11.VAA Segment bend60° SDR 11 Knee

ELGEF_BEND_60_SDR17.VAA Segment bend60° SDR 17 Knee

ELGEF_BEND_90_SDR11.VAA Segment bend90° SDR 11 Knee

ELGEF_BEND_90_SDR17.VAA Segment bend90° SDR 17 Knee

ELGEF_CAP_L_SDR11.VAA End cap Type L SDR 11 Cap

ELGEF_CAP_L_SDR17.VAA End cap Type L SDR 17 Cap

ELGEF_CAP_SDR11.VAA End cap SDR 11 Cap

ELGEF_COUPLER_SDR11.VAA Socket SDR 11 Other pipe part

ELGEF_COUPLER_SDR17.VAA Socket SDR 17 Other pipe part

ELGEF_COUPLER_SDR26.VAA Socket SDR 26 Other pipe part

ELGEF_ELBOW_45_SDR11.VAA Elbow 45° SDR 11 Knee

ELGEF_ELBOW_90_SDR11.VAA Elbow 90° SDR 11 Knee

ELGEF_ELBOW_L_15_SDR11.VAA Elbow 15° Typ L SDR 11 Knee

ELGEF_ELBOW_L_15_SDR17.VAA Elbow 15° Typ L SDR 17 Knee

ELGEF_ELBOW_L_30_SDR11.VAA Elbow 30° Typ L SDR 11 Knee

ELGEF_ELBOW_L_30_SDR17.VAA Elbow 30° Typ L SDR 17 Knee

ELGEF_ELBOW_L_45_SDR11.VAA Elbow 45° Typ L SDR 11 Knee

ELGEF_ELBOW_L_45_SDR17.VAA Elbow 45° Typ L SDR 17 Knee

ELGEF_ELBOW_L_90_SDR11.VAA Elbow 90° Typ L SDR 11 Knee

ELGEF_ELBOW_L_90_SDR17.VAA Elbow 90° Typ L SDR 17 Knee

ELGEF_REDUCER_BW_
SDR11.VAA

Butt welded reducer SDR 11 Reducer, con-
centric

ELGEF_REDUCER_BW_
SDR17.VAA

Butt welded reducer SDR 17 Reducer, con-
centric

ELGEF_REDUCER_SDR11.VAA Reducer SDR 11 Reducer, con-
centric

ELGEF_SPIGOT_CLAMP_
SDR11.VAA

Spigot clamp SDR 11 Saddle connection

ELGEF_TEE_DRILL_SDR11.VAA T 90° tapping-T SDR 11 Corner valve

ELGEF_TEE_L_SDR11.VAA T 90° Type L SDR 11 T-piece

ELGEF_TEE_RED_SADDLE.VAA T 90° saddle connection reduced SDR
11

T-piece

ELGEF_TEE_RED_SDR11.VAA T 90° reduced SDR 11 T-piece

ELGEF_TEE_SDR11.VAA T 90° SDR 11 T-piece
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Polyethylene pipes acc. to DIN 8074
The parts inventory was extended by polyethylene pipes according to DIN 8074. The parts are summarized in
the list file N8074.lst. It contains the following variants:

File Designation Type

N8074_SDR11.VAA PE 100 pressure pipe Straight pipe

N8074_SDR17.VAA PE 100 pressure pipe Straight pipe

N8074_SDR17_6.VAA PE 100 pressure pipe Straight pipe

N8074_SDR26.VAA PE 100 pressure pipe Straight pipe

N8074_SDR33.VAA PE 100 pressure pipe Straight pipe

N8074_SDR7_4.VAA PE 100 pressure pipe Straight pipe

Isometry and pipe spool drawing

Down-grade symbol
In the Configuration Editor, the unit for the display of the down-grade symbol can now be selected. In addition,
only one setting option for the number of decimal places is now available there.
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In the isometry/pipe spool drawing settings for down-grade symbols (open the Symbols tab), the new text key
%PIPE_SLOPE_CFG_UNIT can be used to display the unit of the down-grade symbol in the isometry accord-
ing to the unit specified in the Configuration Editor.
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Units in the isometry and pipe spool drawing settings
Different units are now also supported in the settings for isometry and pipe spool drawing. This means that in
many cases the mm display is no longer shown in the dialogues, e.g.

The values can be entered in any desired unit and are then automatically converted into the unit of meas-

urement preset in the Configuration Editor. If you point the cursor at the symbol, the preset unit is dis-
played.

The font height of the dimension figure must be specified in mm.
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Generate pipe book
As of HiCAD 2024 SP1, so-called pipe books can be generated for isometries or pipe spool drawings. To do
this, go to Isometry+Pipe Spool Drawing > Edit lists > EditPL >... and choose the new the new Pipe

book function.

A pipe book - also known as a weld book or weld seam book - is a special bill of materials that contains all rel-
evant information about weld seams and parts of a pipeline. This includes part information such as standards
and dimensions, detailed information on the material, the weld seam and the welding process.

Microsoft® Excel is required for creating a pipe book.

An isometry or pipe spool drawing must be available to generate a pipe book. This is necessary because the
item numbers of the welded joints are required for the pipe book and these are only assigned in HiCAD when
the isometry or pipe spool drawing is generated.

After calling up the Pipe book function, the Report Manager is automatically started with a corresponding
quantity list. This quantity list is the basis for the pipe book. You then generate the pipe book itself in the Report

Manager using the Create Excel document (with template or script) function.

The process is described below using the example shown for an isometry.
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Step 1: Create the isometry

Step 2: Generate a quantity list for the pipe book
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Step 3: Create the Excel document

The pipe book itself can be understood as a two-part list. The pipe parts are on the left and the weld seams on
the right. Each weld seam is located between two pipe parts, which is indicated in the table by the opening
wedges between the two areas.

The table is built up section by section, with the pipe parts on the sections following the direction of flow.
Accordingly, parts can occur several times. To make this clearer in the example above, the identical part
search has been switched off so that each pipe part has its own item number. This means that you can find the
T-pieces with item numbers 18, 19, 20 and 21 twice. The example isometry consists of three sections; the
gaps in the column with the weld seam items indicate the start of the next section.

The files listed below, which are all located in the HiCAD sys directory, are relevant for creating the pipe book.

HiCAD_
PipeBook.DE.2901.0.xlsx

The document template for creating the pipe book in Excel.

HiCAD_PipeBook.2901.0.cs A C# script that fills the Excel template with the data from the Report
Manager.

HiCAD_ PipeBook.rm_ set-
tings

The settings for the Report Manager. Here it is specified that the above
Excel template and the above C# script should be used.

rm_ anl_ exportpart_ pipe-
book.hdb

Defines the data that HiCAD transfers to the Report Manager.
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Pipeline Tools

Calculate transition
The NPS nominal diameter is now also displayed in the dialogue for the Calculate transition function.
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Determine volume
Imperial units are now also available for selection in the Determine volume function.

Guideline Editor
As of SP1, the former Guideline Editor displays the coordinates in the unit selected in the Configuration Editor.
In addition, the grid size can be specified here in any unit of length. It is then automatically converted into the
preset unit.
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Major Release 2024 (V 2900)

Component connections with flange parameters
Component connections now also support flange parameters. This makes flanging possible on parts imported
via the STEP interface.

The dialogue for creating and editing component connections has been expanded accordingly.
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Down-grade Editor - more units
The specification of down-grades in the Down-grade Editor can now also be done in Radiant, Gon, mm/m,
in/ft and per mil.
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Isometry and pipe spool drawing

Generate pipe spool drawing from Sheet view
If pipe spool drawings are created in a Sheet area of the active drawing and then a pipe spool drawing is cre-
ated again from this Sheet view, then exactly those parts are taken into account in the new/updated pipe spool
drawing that were also visible in the original Sheet view. This means that in this case you will not be asked to
select the parts for the pipe spool drawing.

If the pipe spool drawing is generated from the Model view, then you must select the parts. Unless you have
deactivated the checkbox Part selection before displaying pipe spool drawing dialogue in the Configuration
Editor at Plant Engineering > Isometry and Pipe Spool Drawing.

Changed default settings during isometry/pipe spool drawing creation

Orientation of 2-D drawing elements

The previous default settings for the orientation of the 2-D drawing elements of an isometry/pipe spool drawing
led to the following message being displayed during a new installation:

As of HiCAD 2024, these default settings are such that the message no longer appears.
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Data record assignment for the connection type

From HiCAD 2024 onwards, a data set assignment is automatically made for all connection types, provided
that the default articles are available in the HELiOS database.

This prevents the following message from appearing:

The message will only appear if an automatic assignment is not possible due to missing default articles.
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Part insertion

Seach with unit

The function Pipe parts now also supports the specification of units when searching for attributes, e.g.

Insert connection pieces

When using the part insertion with the function Pipe parts , the placing of connecting pieces between
straight pipes can now be switched on or off. For this purpose, the Settings area of the Straight pipes tab has
been extended accordingly.
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If the checkbox Insert connecting pieces is active here, the connecting pieces specified in the Plant Engin-
eering Settings for Straight pipes are automatically inserted when straight pipes are inserted.

If no connecting pieces are preselected in the Plant Engineering Settings, this is indicated by the symbol in
the Part insertion dialogue window.

Please note:
Connecting pieces are also inserted if the checkbox in the Plant Engineering settings for straight pipes
is deactivated, but activated for part insertion.

Changed buttons
In the Part insertion dialogue window, the button for part selection has been replaced:
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Part data synchronisation

Indication of missing attributes
If mandatory attributes in the document or article master are missing during part data synchronisation, for
example the document type (DOCUMENT_TYPE) or the order note (BESTELLVERMERK), HiCAD will now
indicate this. You then have the possibility to enter the missing attributes. In the case of the document master,
you can create it - as before - despite missing attributes, but this is not possible with missing article attributes.
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Derived variants with different attributes
If variants are derived on the HELiOS side with the Variant Editor (file selection: with database via doc-
ument/article master) and attributes of the general type - for example, the material - are changed in the pro-
cess, then these attributes are not overwritten with the value from the original variant during a data
synchronisation.

Synchronisation with catalogue - Units and categories
When synchronising part data with the HiCAD catalogue, from HiCAD 2024 it is also possible to select and
transfer units and categories when assigning attributes, e.g.:

The attributes that expect a Unitless number are all Nominal diameter (NENNWEITE) attributes and the attrib-
ute Pressure (DRUCK).

Create pipeline - Assigning of nominal diameters
When creating a new pipeline, you must now choose between the nominal diameters DN (for nominal dia-
meters that correspond approximately to mm) and NPS (for nominal diameters that are applied to inches).
This also applies if the option Assign nominal diameter is not selected. This selection DN or NPS determines
the nominal diameter that will later be included in the search for automatically found search conditions.
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When using the new Part insertion function, the nominal diameters can be found in the search as shown:

Since the nominal diameter type must now be selected when creating a pipeline, the selection of the nominal
diameter output is omitted on the Part insertion tab in the Plant Engineering Settings dialogue window.
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Instead, a selection box for the nominal diameter has been added to the tab Part placing on branching points.

Important:

If you select NPS, the file selected for global presetting must also be adapted to NPS, i.e. you must select a
corresponding settings file. In the PlantParts\BranchTypeSettings directory of your HiCAD installation, for
example, the Default.BranchTypeNPS.xml file is available for NPS nominal diameters.
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Files managed by HELiOS
HiCAD cannot determine where the data originates when accessing files for which a document master exists.
This can lead to problems when dealing with variants.

For example, a variant could be loaded from the hard disk in the Variant Editor, modified and transferred to the
corresponding items in HELiOS with the part data synchronization. In fact, this variant file can be managed by
HELiOS e.g. in the Vault Server. So one has not changed the file to which the document master actually
points.

This means that when the variant is installed, potentially a different geometry is calculated than expected,
because the selected item no longer matches the expression in the VAA file to which the document master
points.

Therefore, when a file is opened via the file system, it is checked whether this file is managed by HELiOS. If
this is the case, the following message appears:

If you click on Yes, the file will be loaded via the document master. This ensures that the file matches the one
in the document master.

This query also appears when opening takes place via the file system
n in the PAA Editor (AnPaaEdit.exe),
n during part data synchronization (PartDataAutoSync.exe), and
n during the configuration of the HELiOS database (DBPlantDataImport.exe).
n in the Variant Editor (Varienteneditor.exe)

Create feature variant - Units
When creating a feature variant, the assigned units are now taken into account and you are informed about the
accepted units.
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PAA Editor - Units and Categories
When creating and editing PAA archives, from HiCAD 2024 units and categories can also be selected and
transferred during attribute assignment, e.g.

The attributes that expect a unitless number are all Nominal diameter attributes and the Pressure attribute.
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Jacob Push-in pipes - Length and Weight
From HiCAD 2024 onwards, Jacob Push-in pipes receive their delivery length as a length attribute. The deliv-
ery length is now also no longer adjusted by the dynamic route change.

In the variant files of these push-in pipes, the attribute Arbitrarily divisible (BELIEBIG_TEILBAR) is set to
0=No.

In addition, the attribute Weight for Jacob push-in pipes is also taken directly from the database and is no
longer interpreted as weight per metre as with other straight pipes.
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Check for invalid nominal diameter matings
While the check for nominal diameter matings is running, the message Check nominal diameter mating (PE) is
now displayed in the HiCAD status bar.

This applies to the functions:

Check for invalid nominal diameter matings (active pipeline) and

Check for invalid nominal diameter matings (entire drawing)

as well as the automatic check when opening and saving Plant Engineering drawings.

If errors are found, a list of parts whose connections have different nominal diameters is also displayed, e.g.:
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New versions of the EN 1092-1 flanges
The loose flanges and plane flanges of the EN 1092-1 standard were not clearly recognisable as such until
now. This has been improved in HiCAD 2024 by a revision and renaming.

Plane flanges

previously from HiCAD 2024

EN1092-1-01-PN10.vaa EN1092-1-01-PN100_SF.vaa

EN1092-1-01-PN100.vaa EN1092-1-01-PN10_SF.vaa

EN1092-1-01-PN16.vaa EN1092-1-01-PN16_SF.vaa

EN1092-1-01-PN25.vaa EN1092-1-01-PN25_SF.vaa

EN1092-1-01-PN2_5.vaa EN1092-1-01-PN2_5_SF.vaa

EN1092-1-01-PN40.vaa EN1092-1-01-PN40_SF.vaa

EN1092-1-01-PN6.vaa EN1092-1-01-PN63_SF.vaa

EN1092-1-01-PN63.vaa EN1092-1-01-PN6_SF.vaa

Looose flanges

previously from HiCAD 2024

EN1092-1-02-32-PN10.vaa EN1092-1-02-32-PN10_LF.vaa

EN1092-1-02-32-PN16.vaa EN1092-1-02-32-PN16_LF.vaa

EN1092-1-02-32-PN25.vaa EN1092-1-02-32-PN25_LF.vaa

EN1092-1-02-32-PN2_5.vaa EN1092-1-02-32-PN2_5_LF.vaa

EN1092-1-02-32-PN40.vaa EN1092-1-02-32-PN40_LF.vaa

EN1092-1-02-32-PN6.vaa EN1092-1-02-32-PN6_LF.vaa

EN1092-1-02-35-PN10.vaa EN1092-1-02-35-PN10_LF.vaa

EN1092-1-02-35-PN16.vaa EN1092-1-02-35-PN16_LF.vaa

EN1092-1-02-35-PN25.vaa EN1092-1-02-35-PN25_LF.vaa

EN1092-1-02-35-PN2_5.vaa EN1092-1-02-35-PN2_5_LF.vaa

EN1092-1-02-35-PN40.vaa EN1092-1-02-35-PN40_LF.vaa

EN1092-1-02-35-PN6.vaa EN1092-1-02-35-PN6_LF.vaa

EN1092-1-02-36-PN10.vaa EN1092-1-02-36-PN10_LF.vaa

EN1092-1-02-36-PN16.vaa EN1092-1-02-36-PN16_LF.vaa

EN1092-1-02-36-PN2_5.vaa EN1092-1-02-36-PN2_5_LF.vaa

EN1092-1-02-36-PN6.vaa EN1092-1-02-36-PN6_LF.vaa

EN1092-1-02-37-PN10.vaa EN1092-1-02-37-PN10_LF.vaa

EN1092-1-02-37-PN16.vaa EN1092-1-02-37-PN16_LF.vaa

EN1092-1-02-37-PN2_5.vaa EN1092-1-02-37-PN2_5_LF.vaa

EN1092-1-02-37-PN6.vaa EN1092-1-02-37-PN6_LF.vaa

EN1092-1-04-34-PN10.vaa EN1092-1-04-34-PN10_LF.vaa

EN1092-1-04-34-PN16.vaa EN1092-1-04-34-PN16_LF.vaa

EN1092-1-04-34-PN25.vaa EN1092-1-04-34-PN25_LF.vaa

EN1092-1-04-34-PN40.vaa EN1092-1-04-34-PN40_LF.vaa
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New masks for part search in Plant Engineering
Due to the differentiation between the nominal diameters DN (for nominal diameters that correspond approx-
imately to mm) and NPS (for nominal diameters that are applied to inches), the HELiOS search masks for the
part search in Plant Engineering have also been adapted accordingly, e.g.

In the right field, which is used to search for the nominal diameter in inches (NPS), an entry in floating point
numbers is now expected, e.g. "2 instead of 2". This affects all search masks for parts in which the attribute
Nominal diameter is available in this form..
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Placeholders in imperial units
When inserting placeholders, units can now be used.
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The following variants are available for this purpose in the PlantParts directory of the HiCAD installation:

n DUMMY_VALVE.VAA (metric units, stored in mm) and

n DUMMY_VALVE_USA.VAA (imperial units, stored in inches).
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Notes on HELiOS Updates
For an update to HELiOS 2021 (Version 2600) from a version older than 2500 a central update of the supplied
HELiOS database is required.

Since conflict may occur during the update process in case of inconsistent data stocks, you should do the fol-
lowing:

n Data backup before updating

Make sure that a data backup was made before carrying out the update of your HELiOS database.
For the backup, either use the HELiOS Database Creator (further information can be found in the Install-
ation Notes) or your SQL Server Application.
In case of any questions, or if you need any help with regard to your customized system architecture , con-
tact the ISD Hotline.

n Log file for update

If any conflicts occur during the update, these will be recorded in the log file HeliosDbUpdate.txt (in the
system path %appdata%\ISD Software und Systeme\HeliosDbUpdate\).
Have this file ready when contacting the ISD Hotline in case of an unsuccessful update, so that they can
help you solve the problem and make a successful update.

n New mask format

Please read all notes on the new mask format introduced with HELiOS 2020 !

n MultiCAD interfaces

If you are working with a multi-CAD interface (e.g. the HELiOS-Inventor interface), please note that before
installing an update of an older version to HELiOS 2020 (Version 2500) or higher, some adjustments may
have to be made before the update.
In this case, please contact the Consulting department of the ISD Group.

News Overview

HELiOSWhat's new? 319 / 370

../Administration/Update/updatedb.htm
#Neuer


HELiOS Desktop

Service Pack 2 2024 (V 2902)

Performance
With the update to Service Pack 2 of HELiOS 2024, further performance improvements have been achieved.

The structure of result lists in the Utilized items context, for example, is now built up to 10 times faster.
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Language selection in Login dialogue
As of HELiOS 2024 Service Pack 2, you can select the user interface language when logging into the HELiOS
Desktop.
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HELiOS Options: Save settings centrally
At the bottom of the HELiOS Options window, you can use the Manage... button to easily distribute individual
settings (not only) of the HELiOS user interface from one system to other users or workstations.

New is the Save settings centrally... menu item, with which you can save the export of the settings dir-
ectly in the central directory for the distribution of settings, which can be set up during the installation of
HELiOS, for example.
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Accept active project / folder
The dialogue windows for selecting a project or folder have been extended to include the option of directly
transferring the project or folder currently active in HELiOS with a single click.
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Structure in the project detail window
The new Structure tab of the project detail window shows you the sub-projects of the active project.
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Convert file

For document masters, you will now find the new function Convert file under Output:

With the help of this function, files saved in HELiOS can be saved in other file formats, even with application-
specific options. A special selection dialogue is offered for this purpose.
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The export dialogue for the documents to a specific target directory is similar to the one you know from the
functions Print (Spooler) or Export.

The old Convert function and its sub-menu that existed in previous HELiOS versions Output have been
removed.

Updated settings files for the conversion are supplied with new installations of the Spooler. Existing settings
files are automatically updated after an update the first time the Spooler is accessed.
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Configuration of file names when printing and converting
In the HELiOS Options on the Print / Convert tab you can find new setting options:

Attribute assignments for the file name generation can be set for

n the output of Neutral formats via the HELiOS Spooler and

n the Conversion of documents
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Generated files names and configuration dialogues for export
Please note further new features and rearrangements in the HELiOS Options:

Under Settings for import and export, you can set the attribute assignment for the generated file name assign-
ment for each of the following export processes individually:
n Files: Export of files, for example via the context menu of a document results list or from a document detail

mask, also when exporting files via the API and when downloading files via the HELiOS Internet Server.

n Files of project: Export of the files of a project via Output > Export files of project...

n Files of folder: Export of the files of a project via Output > Export files of folder...

n Files via drag & drop: The assignment that you can set here then takes effect when exporting via drag &
drop of document masters from HELiOS to the file explorer.

A click on Manage... in one of the selection lists opens the Attribute mapping for generating file names dia-
logue window, allowing you to create new mappings or edit existing ones.

A display of the set central directory for the distribution of settings can also be found at HELiOS Options >
General.
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Export project files: Indices

In the Settings for export dialogue of the Export files of project... function, a new option, Export all
indices of a document, has been added:

If this option is deactivated (default setting), only the newest indices of project files are exported. If the option is
activated, all other indices of a corresponding document are offered for selection/deselection in the export dia-
logue:
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Export folder files: Indices

In the Settings for export dialogue of the Export files of project... function, two new options have been
added:

n If several indices are assigned, only export the highest assigned index: This option is active by default,
meaning that only the highest index of a document assigned to the folder is exported. If the option is deac-
tivated, the following export dialogue offers all indices assigned to the folders of a corresponding document
for selection/deselection.

n Only export documents whose most recent index is also assigned to the respective folder: If an even
higher index exists for a document assigned to the folder, which is not assigned to the folder, the assigned
document with the lower index is still taken into account when calling Export files of folder... will still be
taken into account. If this option is activated, documents in the folder are only included in the export dia-
logue if they are also assigned to the folder in their highest index. If a higher index exists "outside" the
folder, documents with an older index are not taken into account.
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Sheet structure, Model structure and Document reference up-to-dateness
Please note the following changes and enhancements when transferring the HiCAD model structure to
HELiOS:

In previous HiCAD/ HELiOS versions, the sheet structure, i.e. the available sheet areas of an SZA document,
was displayed in the Model structure tab of the document master.

As of HELiOS 2024 Service Pack 2, you will find the separate Sheet structure tab in the document detail mask
for this purpose.

The Model structure tab in turn displays the document structure of HiCAD files (.SZA, .KRA). In other words, it
displays the document masters that were referenced by the corresponding SZA/KRA document.

The new database attribute UI_ReferenceIsOutdated is also available in the result list configuration of the
model structure.
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You can use this attribute to add the Document reference up-to-dateness column to the model structure res-
ult list.
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The following three states that a HiCAD reference can assume are then displayed in the result list:

n Not assigned Marks the display of the top part in the document structure as well as references for which
no version information has been saved.

n Current: The referenced document has not been changed since the document structure was transferred.
The reference is therefore up-to-date (please note that there may be outdated sub-parts for an assembly
despite the reference being up-to-date).

n Old: The referenced document has been changed (and saved) since the document structure was trans-
ferred).
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Output product structure to Report Manager: Project context
Note the following behaviour adjustment when transferring the product structure to the Report Manager via the

Output functions Output to Report Manager... and Output to Report Manager, new window... :

If there is an unambiguous project context for the top article, this is also transferred. If this is not the case, the
currently active project is transferred.
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Product structure: Management of editing locks in the Locking Manager
In previous HELiOS versions, locks were set at user level when editing product structures. The corresponding
sessions could be displayed in the Attribute Editor (Advanced functions > HELiOS Session).

With the update to Service Pack 2 (HELiOS Version 2902), the 1-level assemblies tab has been added to the
Locking Manager tool.

This tab shows the top parts of the product structure that are being processed so that they can be unlocked
there if necessary.

The corresponding button in the attribute editor has been removed.

Permitted characters for user names
Please note that the characters permitted for user names have been adjusted and restricted. Punctuation
marks such as comma, apostrophe, square brackets etc. and special characters such as @ cannot be used in
user names.

A database version update from an older version to HELiOS 2024 Service Pack 2 or higher replaces invalid
characters with spaces (except at the start and end of the character string, where they are simply removed).
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Complete decimal representation of FLOAT attributes in the product structure
By default, HELiOS displays the decimal places configured in the Attribute Editor for FLOAT attributes. This
may result in many zeros being displayed as decimal places.

In result lists, in addition to the display with a fixed number of decimal places, a complete display can also be
selected for FLOAT attributes, which lists all decimal places but has no zeros at the end.

If, in this case, the FLOAT value does not have any decimal places other than 0, the decimal separator is also
omitted from the result list display.

For the display of FLOAT attributes in the product structure, it is also possible to use the complete display
instead of the setting for the decimal places from the Attribute Editor.

To do this, you must edit the system file pv_konfig.dat.

In future HELiOS versions, the technology of the HELiOS product structure will be revised and this manual
step will no longer be necessary.
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Service Pack 1 2024 (V 2901)

Search in sub-projects/-folders
The setting options introduced in HELiOS 2024 for the search behaviour of HELiOS data records have been
extended with Service Pack 1 and have a further impact on search templates and result lists:

If the Find article and/or Find document checkbox has been deactivated in the HELiOS Options at Find >
General > Offer search for sub-projects/-folders for:..., the corresponding buttons for searching in sub-pro-
jects/folders are removed from the header menus of result lists after a restart of the HELiOS Desktop.

Please note:

In "mixed" results lists (for articles and documents), the button is removed as soon as it has been deactivated
for one of the two object types.

If the options for searching in sub-projects/folders have been deactivated, this also affects the search tem-
plates. If the user selects a search template in which the search was originally used in sub-projects / sub-
folders, the search will no longer take place in the sub-projects / sub-folders despite the selection of the search
template.
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In the case of results list templates, the search in sub-projects / sub-folders is only controlled via the With sub-
structure checkbox. The corresponding setting from the search template is irrelevant here.

If the HELiOS option Offer search in sub- projects/- folders for:... is disabled by deactivating the cor-
responding checkboxes, the With sub-structure column is removed from the Manage result list templates
window.

Deactivating the setting has the same effect on results list templates as it does on search templates. New res-
ult list templates are then saved without a sub-structure search. However, if an existing results list template
(which was created with the sub-structure option active) is edited, the option to search With sub-structure
saved in the background is retained.
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Automatically apply workflow of the original object when creating index or deriv-
ation
When using the functions:

n Create derivation (for document master or article master)

n Create derivation, with link (for document master or article master)

n Create index (for document master or article master)

n Create index, with link (article master)

n Create index (with file selection) (document master)

HELiOS offers a workflow selection in the dialogues for creating the new object.

The workflow of the original object is preset.

If there are several workflows in the system for the HELiOS object type, you can also select another one from
the pull-down menu.

If it is desired that the workflow of the original object is always adopted without giving the user a choice, admin-
istrators can set the Database option Apply workflow of last state for revision to No.
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The workflow selection will then restricted for the above functions in such a way that only the workflow of the
original object will be applied.
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Deleting and renaming attribute assignments
Attribute assignments, such as those that can be set for the transfer of data to HELiOS or the export of files
from HELiOS, can also be renamed from Service Pack 1 of HELiOS 2024.

To do this, click on the new Rename configuration file button in the overview window of the cor-
responding attribute assignments for the active File. A corresponding input dialogue for changing the name
opens:

In previous versions, the preset attribute assignment under the name Standard could not be deleted. As of the
current version, this can not only be renamed, but also deleted, provided that at least one other attribute
assignment has been entered in the system. If there is only one attribute mapping in the system, this cannot be
deleted.

Please note:

n The mapping of the Multi-CAD configuration file Synchronization may still not be deleted.

n In the event that users manually empty the list of attribute assignments (e.g. by editing the corresponding
XML files), HELiOS automatically creates the default mapping from the installation state when it is started.
This ensures that all dialogues work.

Different interface, attribute mapping and import/export configurations for dif-
ferent HELiOS users
To ensure that different HELiOS users can use different settings regardless of the Windows user logged in, the
corresponding mechanism in HELiOS has been adapted.

The changes affect the distribution options for specific customisations such as HELiOS masks, attribute map-
pings etc. to different workstations, as well as the export and import of HELiOS Options.

Please note that the corresponding directory structures or file storage locations may have changed as a result.

When updating to HELiOS 2024 SP1 (or higher) from an older version, existing settings files are backed up in
a directory (%appdata%\Before2901Backup) and then migrated to the new structure.

In order for existing settings to be transferred, the workstations must be updated accordingly, or an export of
the settings with HELiOS 2024 SP1 (or newer) must be re-imported.
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HELiOS cross-user data can be stored centrally using the HELiOS.ConfigImport.exe tool. Manual creation of
the directory structure or manual storage of the settings files is therefore not necessary.

Another new feature in this context is that you can set a central directory for the configuration data used across
the board during the (update) installation of HELiOS.
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Major Release 2024 (V 2900)

Improved user interface
In HELiOS 2024, the user interface has been revised and improved in many areas.

This also applies to graphical control elements that correspond to the current state of the art, adjusted pos-
itions of menus or preselected buttons in masks.

When exporting and importing interface settings, areas in which no changes have been made are greyed out
and displayed with an inactive checkbox. In the example, this can be seen in the context menu edits:
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HELiOS Options: Search
Starting with HELiOS 2024, you will find settings for the search of HELiOS data records in a separate sub-
menu item.

New is the option to restrict the search in project and folder sub-structures for documents and articles.
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HELiOS Options: Selectable tabs
In the Display section of the HELiOS Options you will find the new Settings heading Selectable tabs.

Under this heading you can determinefor the five object detail window types Show document, Show article,
Show project, Show folder and Show pipe class, as well as for the five result list contexts of the explorer win-
dow types Project Explorer, Folder Explorer, Product Explorer, Article classification and Document clas-
sification, whether they should be displayed in the HELiOS user interface or not.

The settings available here affect not only the HELiOS Desktop (and any linked applications), but also the user
interface of the HELiOS Internet Server.
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HELiOS Options: Classification
In the HELiOS Options you will find the new sub-menu Classification in the General section.

Here you can control for documents and articles whether the classification of the corresponding object type is
available to the users. If it is deactivated, the call for the Class Explorer, the respective button for class selec-
tion when creating, editing or deriving a document or article, the possibility of class selection in search win-
dows and the context menu function for classification in the HELiOS user interface are hidden for the
respective object.

The former option Show Classification tab in Find document/article dialogue has been removed and
replaced by object-specific sub-menu items.

Improvements and extension of the HELiOS URLs
The functionality of the HELiOS URLs has been revised and improved.

In the process, the procedure in HELiOS Desktop was aligned with that of the HELiOS Internet Server.

In the course of the improvements, the syntax of URLs specifying search criteria was extended:

For example, project and folder assignments can now also be specified. In the case of multiple assignments of
an object, a desired unique context can be specified in a URL, e.g. also by specifying HELiOS attributes such
as the name of an object.

A "nested" specification of substructures can also be taken into account, if this is necessary for the unam-
biguous selection of a project or a folder.

Note that the URL syntax of earlier HELiOS versions is no longer supported by this revision. Any URLs
saved from earlier versions (in documents, bookmarks, etc.) can therefore not be reused and must be manu-
ally replaced with URLs in the currently valid syntax in order for the call to work again.
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Export file
When exporting files, in addition to saving them in an export directory, you have the option to send files directly
from the HELiOS export dialogue by e-mail. If this option is selected, the locally configured e-mail client is star-
ted after the export and the files exported from HELiOS are automatically attached to a new e-mail.

Another new checkbox in the export dialogue also makes it possible to save files directly as a zip archive,
which can be very useful when exporting a large number of files at once.

Please note:

The improvement of the export functionalities is accompanied by an adjustment of the HELiOS user rights,
which you can set in the user management of the EDBSETUP:

The Export function allows users to perform the actions Export file and Send file by E-Mail, as well as to
export a document via drag & drop into the file system.

There is no separate user function for import.
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Export files of projects / Export files of folders

In the context menus of projects and folders you will find the new functions Export files of project or

Export files of folder under Output.

As with the direct export of documents, this way you can export all files assigned to a certain project or folder
from the HELiOS Desktop.

Additional options let you automatically create a parent folder or export the entire structure of a project or
folder.
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Send file by e-mail: As Zip archive

As with exporting files, you can also use the Send file by e-mail function to pack the file(s) to be sent dir-
ectly into a zip archive.

If necessary, you can change the automatically suggested file name by entering it manually.
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HELiOS Options: Attribute assignment and Export settings
In the HELiOS Options at General > Attribute assignments you have the possibility to set attribute assign-
ments for the file name to be generated for document exports.

These can then be selected in the export dialogue.

Which attribute assignment is used by default for file name generation can be set under Attribute assignment
for file name:

The assignment is then used when exporting document masters from HELiOS to the file explorer via drag &
drop, when exporting files via the API and when downloading files via the HELiOS Internet Server.

At HELiOS Options > Import/Export you can also set for Export file, as well as for the new functions Export

files of project and Export files of folder . In each case, or the export settings dialogue should be
executed or skipped for each export process.

Please note:

Due to the changeover, the previously existing concrete attribute assignments of the files
Helios.ShortFileNameConfig.Export.xml and Helios.ShortFileNameConfig.Print.xml have been omitted and
replaced by the new mechanism. For the new standard assignment, the settings have been taken from the
mapping used for printing. Other attribute assignments may have to be reconfigured by the user after the
update.
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Local changes during export, printing and conversion
Before exporting a file, the system checks whether the documents to be exported have local changes. If this is
the case, a warning is issued for the respective document, because in case of export not the locally changed
status would be exported, but the status known to HELiOS.

You can then decide whether to Cancel or to export the document with OK regardless of the local changes.

The same applies to Print (Spooler), Send file by e-mail and Convert.
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Result list - Target date display for projects and articles
Basically, target dates can be assigned for folders, projects, articles and documents.

The virtual attribute VA_ObjectWorkflowTargetDate, through which target dates of folders and documents
were already displayed in result lists before, can now also be used for projects and articles.
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User rights: Move folders
As with the possibility of allowing or preventing the moving of projects for certain users or groups via the user
management of the EDBSETUP, a user right for moving folders can now also be assigned or removed from
the authorisation functions.

Existing HELiOS users automatically receive this right through the database version update. So nothing
changes at this point, except the possibility that this right can be withdrawn from users.

User-defined types: Change of read permission and reference attributes
The read permission for HELiOS objects of user-defined types has been changed to allow all users to read
such objects.

Modification, deletion and creation of these objects is still regulated by the (classical) workflow.

In addition, HEliOS user-defined object types also support reference attributes. For example, you can use ref-
erence attributes (such as organisational affiliations of customers in document master data) to narrow down
the search for customer data.

Initialised attributes
Note the instructions for initialising attributes:

Improving adjustments have been made in the hierarchical order in which initialised attributes are overwritten
by further steps if necessary.

Initialisations from attribute assignments or workflow steps can be overwritten by subsequent steps. Only the
attributes that are automatically changed by attribute assignments or the workflow will be updated. Further ini-
tialisations made by by the user remain unchanged.
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Workflow selection for article index
As with indexing of individual articles or documents, it is also possible to make a workflow selection for articles

when choosing Create index, with link .

The prerequisite for a Workflow selection at the bottom of the window is that the logged-in user has the
appropriate permissions.

In addition, the setting Apply workflow of last state for revision at HELiOS Options > Database must be set
to No.
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New HiCAD Viewer format
The integrated HiCAD Viewer is a tool that can be used to quickly and clearly evaluate HiCAD files also in the
HELiOS Desktop interface.

Please note when using the HiCAD Viewer in HELiOS from Version 2024 (2900.1):

n When installing HiCAD with HELiOS, the Active X component of the HiCAD Viewer is installed auto-
matically. This enables the preview of HiCAD files in HELiOS.

n On workstations on which only the HELiOS Desktop is installed in standalone mode, the HiCAD Viewer
must be installed separately from HELiOS 2024 and updated if necessary. Otherwise, the preview of
HiCAD files cannot be displayed in HELiOS.

n HELiOS 2024 has also changed the HEL_PREVIEW.INI settings file for the Viewer, which enables the con-
figuration of the graphics windows in the HELiOS Desktop.

n For update installations of older HELiOS versions, the original INI file is still used and may need to be
adjusted manually based on the new syntax, for example when using additional viewers.
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n The above information also applies if only HELiOS is updated when using an older HiCAD version with
HELiOS.

What's new? 357 / 370

News Overview



Italian and Polish remote maintenance

The support tool TeamViewer, which can be accessed from the HELiOS Desktop via > Remote Main-
tenance , is also available in Italian and Polish on HELiOS 2024.

Using the new Report Manager with HDE reports
Within the HDE reports you can specify which RMS file (old Report Manager) should be used. From HELiOS
2024 you can also use the new RM_SETTINGS files and thereby start the new Report Manager (from 2023).
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HELiOS in HiCAD

Service Pack 2 2024 (V 2902)

Model/Document structure and Sheet structure
Please note the following changes and enhancements in the transfer:

In previous HiCAD/ HELiOS versions, the Sheet structure, i.e. the available sheet areas of an SZA document,
was displayed in the Model structure tab of the document master. As of HELiOS 2024 SP2, you will find the
separate Sheet structure tab in the document detail mask for this purpose.

The Model structure tab in turn displays the document structure of HiCAD files (.SZA, .KRA). In other words, it
displays the document masters that were referenced by the corresponding SZA/KRA document.
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By saving the model/document structure of SZA/KRA files, the document where-used list (in the Use tab of the
document master mask) can also be used.

Document reference up-to-dateness
The new database attribute UI_ReferenceIsOutdated is now available in the result list configuration of the
Model structure.
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You can use this to add the Document reference up-to-dateness column to the Model structure result list.

The following three states that a reference can assume are then displayed in the result list:

n NOT ASSIGNED: Marks the display of the header in the document structure as well as references for
which no version information has been saved.

n Current: The referenced document has not been changed since the document structure was transferred.
The reference is therefore up-to-date. (Please note that there may be outdated sub-parts for an assembly
despite the reference being up-to-date).

n Old: The referenced document has been changed (and saved) in the meantime since the document struc-
ture was transferred).
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Project and Folder selection in the Catalogue Editor
The menu of the HiCAD Catalogue Editor has been extended: Projects and Folders can now be activated via
HELiOS in the menu bar.

If a project or folder is active, the project/folder can be deactivated via the menu, the project/folder content can
be displayed and another project/folder can be activated.

The Catalogue Editor title bar shows which projects and folders are currently active.
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Service Pack 1 2024 (V 2901)

Workflow selection
In earlier HiCAD versions, a dialogue for workflow selection appeared first when calling up new Drawing func-

tions, e.g. New drawing with database, with new article master .

As you can now find a pull-down workflow selection at the bottom of an input window, this unnecessary inter-
mediate step has been removed.

The prerequisite for a selection option is, of course, that more than one workflow exists in the system for the
corresponding object type.

HiCAD 3-D annotation with HELiOS data
As of HiCAD 2024 SP1, HELiOS data is saved in annotations with the drawing. This data is then used when
working without HELiOS. This also applies if a different sheet is printed via the Plot Manager (from HiCAD
2024 SP1) than the sheet that was active when the drawing was saved. Previously, the HELiOS data was miss-
ing in the annotation tags in this case.

Please note that this change does not affect existing drawings. These must first be saved again.
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Major Release 2024 (V 2900)

Performance
By reducing HELiOS queries when loading drawings, a significant performance increase in the
HiCAD/HELiOS interaction could be achieved.

Article master display by double-click
Up to now, double-clicking on a part in the drawing or in the ICN called up the Part attributes dialogue window.
As of HiCAD 2024, the article master can now be displayed alternatively when using HELiOS. This can be set
in the Configuration Editor at System settings > HELiOS .

If the checkbox is active and the clicked part does not have an article master, the Part attributes dialogue win-
dow is automatically displayed.
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HELiOS MS Office Interface

Major Release 2024 (V 2900)

Send file by e-mail
Both via the context menu of document result lists in HELiOS and from document detail windows, you have the

option of sending corresponding files via the function Send file by e-mail ... to the standard e-mail pro-
gramme in your local system.

The range of settings and functions has been improved and simplified in HELiOS 2024.
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HELiOS Vault Server

Major Release 2024 (V 2900)

Server Monitor: HELiOS Automation Service
The HELiOS Server Monitor has been extended with the menu item HELiOS Automation Service by the pos-
sibility to monitor the running of the server service Helios.ErpService.exe.

This controls ERP interfaces and other tasks.

What's new? 367 / 370
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Legal notes

© 2024 ISD ® Software und Systeme GmbH. All rights reserved.

This User Guide and the software described herein are provided in conjunction with a license and may only be used or copied in accord-
ance with the terms of the license. The contents of this User Guide solely serve the purpose of information; it may be modified without prior
notice and may not be regarded as binding for the ISD Software und Systeme GmbH. The ISD Software und Systeme GmbH does not
assume any responsibility for the correctness or accuracy of the information provided in this document. No part of this document may be
reproduced, saved to databases or transferred in any other form without prior written permission by the ISD Software und Systeme GmbH,
unless expressly allowed by virtue of the license agreement.

All mentioned products are trademarks or registered trademarks of their respective manufacturers and producers.
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Your local contact

We attach great importance to the direct contact with our
customers and partners, because only a lively dialogue and
constant exchange with practice ensure application- ori-
ented software development.

Feel free to contact us! Whether at our headquarter in Dort-
mund or at one of our branches and subsidiaries in your
vicinity - we will be happy to answer all your questions about
our products and services. We are looking forward to hear-
ing from you!

Headquarter Dortmund

ISD Software und Systeme GmbH

Hauert 4

D-44227 Dortmund

Phone +49 231 9793-0

info@isdgroup.com

ISD locations worldwide at www.isdgroup.com
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